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INTRODUCTION 

 
This document is for Consultant and State Employees responsible for working on Capital 
Projects.  This manual covers the preparation, review, and delivery of capital project documents 
across the whole project timeline from project initiation to project completion.  This manual also 
covers design phase scheduling.   
 
Questions or inquiries regarding the subject matter can be forwarded to the following contacts:  
 
William Pratt P.E. 
Transportation Principal Engineer 
AEC Applications  
HUwilliam.pratt@ct.gov 
860.594.3320 
 
Bruce Bourgoin P.E. 
Transportation Supervising Engineer 
AEC Applications 
HUbruce.bourgoin@ct.gov 
860.594.2760 
 
Mathew Calkins P.E. 
Transportation Engineer 
AEC Applications  
mathew.calkins@ct.gov 
860.594.2988 
 
             

 

Revision History 
 
Digital Project Development Manual Revision History 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:Uwilliam.pratt@ct.gov
mailto:bruce.bourgoin@ct.gov
mailto:mathew.calkins@ct.gov
http://www.ct.gov/dot/lib/dot/documents/aec/digital_project_development_manual_revision_history.pdf
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DEFINITIONS  
ACD – The attribute applied to a revision requested by the Processing unit to an ADP discipline 
subset.   
 
ACD2 – The attribute applied to a revision requested by the Processing unit to an ACD discipline 
subset.   
 
ADP – The attribute applied to an Addendum discipline subset. 
 
Bluebeam – PDF software similar to Adobe Acrobat.  Bluebeam software will be required to 
package and markup all Shop Drawing Submittals. 
 
CIM – Civil Integrated Management 
 
CSI – Construction Special provisions Institute  
 
DCD – The attribute applied to a revision requested by the Processing unit to an FDP discipline 
subset.    
 
DCD2 – The attribute applied to a revision requested by the Processing unit to a DCD discipline 
subset.    
 
Discipline Subset – A multi-page PDF document that includes all the contract plan sheets for a 
discipline.  Example would be all the structures sheets would be packaged in (1) multi-page PDF 
document.   
 
DCO – The attribute applied to a design initiated change order discipline subset. 
 
DPD – Digital Project Development Manual. 
 
EED – Electronic Engineering Data 
 
Engineer of Record – The engineer’s digital signature that is applied to the discipline subsets.  
For CTDOT staff this would be the Principal Engineer.  
 
FDP –The attribute applied to a final design plans discipline subset. 
 
FIO – The attribute applied to a “for information only” discipline subset.   
 
FPL – The attribute applied to an advertised FDP discipline subset 
 
Project Manager – Lead designer on the project.  For CTDOT staff this would be the TE 3 or 
Supervisor of the lead discipline or consultant liaison TE3 or Supervisor.     
  
Projectwise - CTDOT is currently using Bentley’s Projectwise as a data management software for 
digital projects and asset document storage.  Projectwise allows the CTDOT, and authorized 
business partners to access its data anywhere internet access is available. 
 
Set File – Is a consolidated viewer file that is created using Bluebeam.  When this file is opened 
all of the contract plans, FDP, Addendum, Change Orders, are sorted by their page labels and the 
correct order.  
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 Prerequisites and Policies Section 1

The following details various requirements and policies that need to be followed when working 
on a Capital projects for the Connecticut Department of Transportation (CTDOT).   
Software Requirements 

1. Document Management Software – CTDOT uses Bentley’s Projectwise for our document 
management solution.   See Section 2 for more information. 

2. PDF Software – CTDOT has standardized on Bluebeam for our PDF software and shall be 
the only PDF software supported by the Connecticut Department of Transportation for 
the processes set forth in this manual.    

a. Bluebeam Revu was used in the production of all figures and procedures in this 
manual.  A license of Bluebeam Revu version 12 or higher must be purchased to 
perform all the procedures in this manual.    

b. A CTDOT Bluebeam profile has been created that includes a standard set of 
tools in the tool chest.  This profile can be found in Appendix A of this manual.  

Digital Signatures Requirements 
1. All contract plans, working drawings, and applicable engineering reports submitted to 

the Department shall be digitally signed by a CT licensed Engineer or CT licensed 
Architect in accordance with this manual.   

2. Digital contract plans, in the following stages: Final Design Plans (FDP), Design 
Completion Data (DCD), Addenda, Addenda Completion Data (ACD), Design Initiated 
Change Order (DCO), and Working Drawing (WDP) and all engineering reports shall be 
digitally signed in conformance with this manual. 

a. Digital signatures must meet the requirements of Adobe’s Certified Document 
Services (CDS) or Adobe Approved Trusted List (AATL).   

b. CDS, and CDS vendor information is provided at the following 
website: Uhttp://www.adobe.com/security/partners_cds.htmlUH 

c. AATL and AATL vendor information is provided at the following website: 
https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html  

d. Trial CDS/AATL Signatures will not be accepted by the Department, a signature 
must be purchased from one of the CDS/AATL Vendors.  

3. Bluebeam Revu or Extreme is required for all digital signature processes. After contract 
plans have been advertised, the digital signature is not allowed to be removed.   

CAD Standards 
1. Standard Computer Aided Design (CAD) Applications shall conform to those listed here 

CTDOT CAD Standards Website 
2. This manual is designed to be used with the latest CTDOT Digital Design Environment. 

Policies 
1. The Consulting Engineer acknowledges and agrees that Contract Plans submitted using 

the [Digital Submission Procedure set forth in this Manual] has the same force and 
effect for the purposes of the Consulting Engineer’s agreement with the State as a 
signature and seal of a Connecticut Licensed Professional Engineer or Architect as set 
forth in § 20-300-10 of the Regulations of Connecticut State Agencies or § 20-293 of the 
Connecticut General Statutes, as applicable. Nothing in this DPD serves as an 
authorization for, or endorsement of, the use of this [Digital Submission Procedure] 
generally by the Consulting Engineer, its subcontractor(s), or any Connecticut Licensed 
Professional Engineer or Architect with respect to other work it performs for the State 
or work it performs for other clients. 

2. When on call consultants are used for CTDOT projects, the title sheet shall be digitally 
signed by CTDOT following the procedure in Section 5.6.1 of this manual.     

3. When a document reaches a final status a “Final Status” shall be placed on the 
document.  This will lock for editing and ensure document retention.  

http://www.adobe.com/security/partners_cds.html
https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html
http://www.ct.gov/dot/cwp/view.asp?a=3886&Q=483668&PM=1
http://www.ct.gov/dot/cwp/view.asp?a=3886&Q=483668&PM=1
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 CTDOT Document Management Section 2

System 

CTDOT is currently using Bentley’s ProjectWise as a data management software for CTDOT 
Capital Projects and CTDOT Assets.  Projectwise has the ability to store documents and 
associated business data in one centralized location and allows the CTDOT, and its authorized 
business partners access its data anywhere internet access is available.  Projectwise access is 
available to all CTDOT employees, consultant engineers, contractors, municipalities, utility 
companies, or any other supporting agencies that work on Capital Projects or Assets for CTDOT.     
 
The following form can be filled out to gain access to the CTDOT’s Projectwise Site:  ProjectWise 
New User Form   
 
Consultant firms, contractors, municipalities, utility companies, and other supporting agencies 
are usually given (2) user names that can be used by the whole firm/group.  More than one 
person can use the user name at a time.  It is the firm’s responsibility to manage the user name 
and password.   
 
The following links allow the user to change their password or reset the password if it is 
forgotten or lost: 

Change Projectwise Password 
Forgot or Lost Projectwise Password 

2.1 ProjectWise  
There are two ways to access CTDOT’s Projectwise site:  Either Projectwise Thin Client (Web 
Version) or Projectwise Explorer Client (thick client – installed software).  
 

Projectwise Thin Client 
Thin client is a web based version of Projectwise, which does not require any software 
installation.  All that is required to access Projectwise over the web is a user name and password 
supplied by CTDOT.   Thin client allows access to the CTDOT dataset anywhere internet access is 
available.  To use Thin Client, follow this document for the initial setup.  This only needs to be 
done once:   Thin Client First Time Set Up   
 
After the above settings document has been followed, use this link to access Projectwise Thin 
Client:  https://ctdot.projectwiseonline.com  
 

Projectwise Thick Client 
The thick client conversely requires the installation of the Projectwise client software. In 
addition to performing all the functions of thin client; thick client has the addition functionality: 
 

- Delta file transfer – Improves speed of downloads 
- Managed workspaces – Eliminates the need to install the CTDOT DDE 
- Attributing multiple documents at once 

 
Users can get Projectwise thick client for free if they have an active license of Microstation.  
Download Projectwise Explorer Client from Bentley using your select ID.  Once Projectwise is 
installed on your computer use this document to connect to the datasource:  
 

Connecting to Datasource Using Thick Client 

http://www.ct.gov/dot/lib/dot/documents/aec/ProjectWise_New_User_Form.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/ProjectWise_New_User_Form.pdf
https://extranet.projectwiseonline.com/Shared%20Documents/Change%20Password.aspx
https://extranet.projectwiseonline.com/Shared%20Documents/Forgot%20Password.aspx
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_thin_client_first_time_set_up.pdf
https://ctdot.projectwiseonline.com/
https://www.bentley.com/
http://www.ct.gov/dot/lib/dot/documents/aec/Connecting_to_Datasource_using_Thick_Client.pdf
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Projectwise Apps 
Users can also get to CTDOT’s Projectwise datasource using the various applications.  These 
applications require a URL to connect to a Projectwise datasource.  The table below lists the 
server URL for each application:   
 

Applications  URL 

Projectwise  ctdot-ws.projectwiseonline.com/pwmobileaccess 
 

WorkSite  
Projectwise Edge 

https://Ctdot-ws.projectwiseonline.com/ws 
 

 

Access in Projectwise 
Access to content in Projectwise is set at the folder level based on the group a user is in.  The 
following details, at a high level, the access for the various groups.  Section 2.3 of this document 
provides more information for the folders mentioned below:  

 CTDOT Employees - Access to all projects and all asset content. 

 Consultants  and CE & I Firms 
o Active Projects – Can only access projects that the firm is working on.  
o Legacy Projects – Access to all the legacy projects. 
o Assets – Access for asset content if firm is pre-qualified to work on that asset 

based on CTDOT’s pre-qualified consultant lists.   

 Contractors  
o No Access to Projectwise 

 Municipalities 
o Active Projects – Can only access projects in their town. 
o Legacy Projects – Access to all the legacy projects. 
o Assets – No access to asset content. 

 Utility Companies  
o Active Projects – Can only access projects that a firm is working on. 
o Legacy Projects – Access to all the legacy projects. 
o Assets – No access to asset content. 

 Other Supporting Agencies 
o Active Projects – Can only access projects that an agency is working on. 
o Legacy Projects – Access to all the legacy projects. 
o Assets – No access to asset content. 
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2.2 Projectwise Project Container for an Active Capital 
Project 

Projectwise is setup to automatically create a project container for any project that is added to 
the Obligation Plan.  This automatic process runs on a nightly basis.  CTDOT employees will have 
access to all projects, but access for consultants, municipalities or other agencies must be 
requested by the Consultant Liaison Engineer.  The Consultant Liaison Engineer can request 
access for these groups by emailing: Julie.Annino@ct.gov. 

2.3 Projectwise Project Folder Structure and Required 
Documents for Capital Projects 

This section details the Projectwise project folder structure and the required project documents 
that must be submitted for each project.   Section 3 of this manual details the processes for each 
contract document. The figure below shows the folder structure for a Capital Project:  If the 
project container does not look like the following, contact DOT.AECapplications@ct.gov 

 

Figure 1 - Capital Project Folder Structure 

mailto:Julie.Annino@ct.gov;DOT.AECApplications@ct.gov?subject=Projectwise%20Access
mailto:DOT.AECapplications@ct.gov
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Note:  In the case where two or more projects are combined or advertised as (1) project, all 
contract documents for these projects will be submitted into the lowest numbered project in 
Projectwise.   

Projectwise Folder Structure and List of Project Documentation 

100_Contract Plans (PDF) – This folder contains only final Contract Plans, which includes the following:  
There shall not be any working documents uploaded into this folder. 

 Final plans 

 Addendum plans  

 Design Initiated Change Order plans 

 As-Built plans 

 Electronic Engineering Data (EED) 

110_Contract Documents (PDF) – This folder shall only contain the following final documents.  There 
shall not be any working documents uploaded into this folder. 

 Signed Contract 

 Environmental Permit Applications/Approvals 

 Pre-Bid Questions and Answers 

 Contract Special Provisions – Final, Addendum, and Change Order special provisions   

 State and Federal Minimum Wage Rates and Classifications. 

 SOM (Source of Materials) 

 Insurance documents 

 Pre-Award DBE Review – Specific Contractor 

 Bonds  

120_Contractor Submittals (PDF) – This folder contains the following: 

 Working drawings 

 Shop drawings 

 Product data submittals 

 RFCs 

121_Contractor RFIs– This folder contains the following: 

 RFIs 

122 Contractor Closeout Documents – This folder contains contractor closeout documents.  

 Operation and Maintenance Manuals 

 Warranties 

130_Engineering Reports – This folder contains all the final engineering reports that are to be made 
available for the Contractor.  There shall not be any working documents uploaded into these folders.   

 Hydraulic  
o Hydraulic Report and Hydraulic Report Data 
o Scour Report and Scour Report Data 
o Floodway Report and Floodway Report Data 
o Final Drainage Reports and Final Drainage Report Data 
o USGS Bridge and Channel Assessment Reports 
o Miscellaneous Technical Data, Studies, Investigations or Reports 

 Environmental Compliance  
o Task 110 
o Task 210 
o Task 310 
o Underground Storage Tank System Closure Reports 

 Bridge 
o Load Rating 

 Geotechnical 
o Geotechnical Report Project files - including test boring, laboratory testing data file, and 

computations 
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Projectwise Folder Structure and List of Project Documentation 

131_Engineering Reports Confidential –This folder is only seen by a select number of people.  

 Bid Analysis 

140_Project_Administration_Documents– This folder is for permanent final project administration 
documents.  Final project administration documents can be defined as deliverables such as agreements, 
milestone documents, regulatory documents, design phase schedules, emails or letters that made 
decisions on a project, etc.  There shall not be any draft documents uploaded into this folder.    

 Agreements – Utility, Railroad, Municipal, etc.  

 Categorical Exclusion 

 Certification Acceptance Checklist 

 Commitment list 

 Consultant Selection Documents – Scope of Services, Notice to Proceed, etc. 
 Construction Incidental Cost Establishment Report 

 DBE/SBE Approval with percentage, participation level 

 Design Approval 

 Design Phase Microsoft Project Schedule 

 Emails and Letters that were used in making and documenting key project decisions, as defined 
by the individual business units.  Engineering judgement shall be used to determine what to 
keep and if the email or letter belongs in this folder or the 142 Project Administration 
Correspondence folder. 

 Environmental Impact Study – EIS 

 Final Design Report 

 Finding of No Significant Impact - FONSI 

 Lighting Agreement 

 Record of Decision – ROD 

 Rehabilitation Study Report 

 Risk Management Documents 
 RPM – Request for Project Memorandum  

 Sidewalk Maintenance Agreement 

 Standalone Transportation Management Plan Document, taken from the final design report 
 Stewardship Agreement 

 Structure Type Study 
 Waiver to Obligate Funds 

141_Project Administration Confidential – This folder shall be used for documents that only CTDOT 
should have access to.   

 Consultant Payroll information 

142_Project Administration Correspondence – This folder is for all final project correspondence 
documents.  This is defined as any request memos, response memos, emails and letters that were not 
used to make a project decision, etc. and does not include any documents that are defined in the 
140_Project Administration folder.  This folder shall not include any working/draft documents.   

 Emails and letters associated with a project that were not used to make key project decisions, 
but the individual business units elect to retain for a period of time.  Engineering judgement 
shall be used to determine what to keep and if the email or letter belongs in the 140 Project 
Administration or this folder.  

 Meeting Minutes 

 Request Memos – Survey Request, Design Reviews, Support unit design.    

 Response Memos – Response to the Request Memos 

150_Quantity Calculations – This folder is where all the final quantity calculations for contract items 
shall be stored. 

151_Final Design Calculations – This folder is where all the final design calculations shall be stored. 

160_Project Photos – This folder is where all project photos shall be stored.  Both engineering and 
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Projectwise Folder Structure and List of Project Documentation 

construction photos shall be stored in this folder.    

170_ROW Files - This folder is where the final property maps shall be stored until they are uploaded 
into the IRMS.    

210_Construction Folders – See Construction Documentation for more information 

 01 – Project Documents 
o Semi and Monthly Payment Estimates 
o Construction Orders with Backup 
o Copies of Cost-Plus Sheets with backup 
o All Delivery Tickets, Bituminous Concrete, Processed Aggregate Base, Concrete, etc. 
o Material Certifications, etc. (All Laboratory Reports) 
o Nuclear Density Test and Data Sheets (CON-125, 133) 
o Pile Driving Logs (CON-87) 
o Environmental Correspondence, Logs, etc. 
o Utility Forms (CON-40 and 41) 
o Contractor Payrolls 
o EEO/AA Reports (30-60-90s) 
o Labor Wage Checks (CON-131) 
o Hazardous Waste Manifests 
o Stores Requisitions and Transfer Vouchers 
o Purchase Orders and Requisitions 
o Correspondence 
o Consultants Billings with Backup 
o Computer Disks - properly labeled 
o Any Other Related Records 
o Town Correspondence File - Includes: 
o General Material 
o Request for and response to matters concerning highway, bridge, signing, lighting, etc. 

by town officials 
o Written commitments to first officials and/or elected, appointed state, federal officials 
o Mapping Prepared by district or filed with district 

 02 - Internal Documents 
o Consultant Ratings 
o Other Sensitive Documents 

 03 – Measurements and Payments 
o Field Books (all) Volumes 1,2,3,& 4s 

220_FHWA – This folder is used by the FHWA for their purposes 
 

230_Contract Administration – This folder is used by the CTDOT Contracts unit. 
 
 

240_Contract Development – This folder contains the paper plan order form and the location where the 
Designer uploads the following supplemental contract documents: 

 All contract special provisions and Notice to Contractors (NTC), in word format, both final and 
addendum special provisions 

 Estimator Proposal Estimate  

 Calendar Day Estimate 

241_Contract Development Confidential – This folder contains the final engineers estimate and 
calendar day estimate developed by the cost estimating unit. 

 Final Engineers Estimate 

 Final Calendar Day Estimate 

310_Milestone_Submissions – The designer shall submit all milestone submission documents into this 
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folder.  This includes plans, special provisions, reports, estimates, etc. This folder has sub-folders for 
30%, 60%, 90%, and 100% submissions 

320_Permit_Development – This folder can be used to store documents for the development of 
permits.  Note: At FDP, the permit applications and approvals must be uploaded into the 240 Contract 
Documents folder.   The processing unit then adds the permits and applications to the contract and 
uploads the contract into the 110 Contract Documents folder.  

 Permits Needs Determination Form (PNDF) 

 Wetland Flagging Coordination  

 Natural Diversity Database (NDDB) Coordination  

 CTDEEP Fisheries Correspondence   

 LEAN Meeting Minutes 

 Project Manager Meeting (PMM) Minutes  

 Permit Review Comments 

 Responses to Permit Review Comments 

330_Design_Data – This area is used for working on documents such as letters, memos, etc. and 
working on CAD files.  Under this folder there are discipline specific sub-folders that provide each 
discipline an area prepare their design documents.  The DOT Confidential subfolder shall be used to 
work on draft confidential documents.  

500_Survey 

 01_Central_Surveys – This folder is where the approved survey files will be stored for use by 
design.   

 02_District_Surveys – This folder is used by the district survey units.  The files stored in this 
folder are considered working files.     

 03_Consultant_Survey – This folder is used to store consultant survey information.  

 04_Survey Transfer – This folder is used by District Survey units to transfer their completed 
survey files to Central Surveys.  Central Surveys will review the files in this folder and then when 
they are found acceptable, the files will be transferred into the 01_Central Survey folder for use 
by design.  

600_Project Initiation Documents – This folder is where any project initiation documents can be stored.  
This would include any plans developed by the Project Concepts unit or any other documents created in 
the project concepts phase.   
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2.4 Asset Areas in Projectwise 
Projectwise is also being used to store all asset related documentation and asset information.  
The following details the assets and documents are being stored for that asset: 

 02.0 – Assets – Bridges 
o Inspection Reports 
o Fracture Critical Reports 
o Maintenance Memos 
o Load Ratings not performed for a Capital Project 

 02.1 – Assets – Bridges (under 20’ Town owned) 
o Inspection Reports 

 02.2 – Assets – Signal Intersections 
o Signal Plans – Active and Legacy 

 02.3 – Assets – Sign Structures 
o Inspection Reports 

 02.4 – Assets – Towns 
o Office State Traffic Administration (OSTA) documents 
o Bridge Safety Town Letters 

 02.5 – Assets – Buildings 
o Building Inspection Reports 

 02.6 – Assets Radio Towers 
o Inspection Reports 

 02.7 – Asset – Railroad Crossing Signals 
o Inventory document that provides detail for the crossing. 
o Photos 

2.5 Setting Documents to Final Status in Projectwise 
Once a document has reached it final status, where no more editing is required and it is ready 
for permanent storage a final status will be applied to the document as shown below: 

1. Right click on the file and select Change State>Set Final Status.   

 

Figure 2 - Set Final Status 

This will lock the file so no one can delete it.  If a user needs to remove the final status contact 
DOT.AECApplications@ct.gov  

mailto:DOT.AECApplications@ct.gov
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 Digital Project Processes  Section 3

3.1 Processes by Project Phase 
The following shows the processes included in this manual separated by project phase.  Also 
included in this table is a link to the process map that corresponds to each document/process:    

Project Initiation Phase 
Document/Process Requirements 

PPI Form  Link for Video of Process: PPI Video or Document Workflow.   

 The PPI form shall be uploaded into this folder in Projectwise  
04.00 - Engineering Libraries\PPI Request  
in accordance with Section 6 of this manual.    

Project Schedule  Project Schedule should be set up in accordance with Section 11 

Preliminary Design Phase 

Preliminary 
Contract Plans 

 Plans shall be grouped in accordance with Section 4.1 

 Plans shall be formatted in accordance with Section 4.2 
 

Preliminary 
Contract Special 

Provisions 

 Contract Special Provisions shall be prepared in accordance with Section 4.5 

Cost Estimate  Cost Estimates shall be prepared in accordance with Section 4.6 

Preliminary Design 
(30%) Review 

 Design Reviews shall be accomplished in accordance with Section 10 

Project Schedule  Project Schedule should be set up in accordance with Section 11 

Permit 
Applications/ 
Documents 

 Shall be uploaded and formatted in accordance with Section 4.7 

Rehabilitation 
Study Reports 

 Shall be uploaded and formatted in accordance with Section 4.9 

Structure Type 
Studies 

 Shall be uploaded and formatted in accordance with Section 4.9 

Categorical 
Exclusion 

 Shall be uploaded and formatted in accordance with Section 4.10 

Design Exception  Shall be uploaded and formatted in accordance with Section 4.10 

Design Approval 
Letter 

 Shall be uploaded and formatted in accordance with Section 4.10 

Project 
Correspondence 

 Shall be uploaded and formatted in accordance with Section 4.10 

 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/ppi.mp4
http://www.ct.gov/dot/lib/dot/documents/aec/ppi_requests.pdf
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Final Design Phase 
Document/Process Requirements 

Contract Plans  Plans shall be grouped in accordance with Section 4.1 

 Plans shall be formatted in accordance with Section 4.2 

Contract Special 
Provisions 

 Special Provisions shall be prepared in accordance with Section 4.5 

Engineering 
Reports 

 Engineering Reports shall be prepared in accordance with Section 4.9 

Project Schedule  Project Schedule should be set up in accordance with Section 11 

Cost Estimate  Preliminary Cost Estimates shall be prepared in accordance with Section 4.6 

Permit 
Applications/ 

Approvals 

 Shall be uploaded and formatted in accordance with Section 4.7 

Design Calculations  Design Calculations shall be submitted in accordance with Section 4.13 

Semi Final (60%) 
and Final Design 
(90%) Reviews 

 Design Reviews shall be accomplished in accordance with Section 10 

Quantity 
Calculations 

 Quantity Calculations shall be submitted in accordance with Section 4.6 

Final Design Report  Shall be uploaded and formatted in accordance with Section 4.10 

Final Design 
Statement 

 Shall be uploaded and formatted in accordance with Section 4.10 

Sidewalk 
Maintenance 
Agreement 

 Shall be uploaded and formatted in accordance with Section 4.10 

Lighting Agreement  Shall be uploaded and formatted in accordance with Section 4.10 

DBE/SBE Goals  Shall be uploaded and formatted in accordance with Section 4.10 

Commitment List  Shall be uploaded and formatted in accordance with Section 4.10 

Waivers  Shall be uploaded and formatted in accordance with Section 4.10 

Standalone 
Transportation 

Management Plan 

 Shall be uploaded and formatted in accordance with Section 4.10 

Project 
Correspondence 

 Shall be uploaded and formatted in accordance with Section 4.10 
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Contract Processing Phase 
Document/Process Requirements 

FDP 

Contract Plans  Plans shall be grouped in accordance with Section 4.1 

 Plans shall be formatted in accordance with Section 4.2 

 Plans shall be checked by the PDF checker in accordance with Section 6.2 

Contract Special Provisions  Special Provisions shall be prepared in accordance with Section 4.5 

Proposal Estimate  Preliminary Cost Estimates shall be prepared in accordance with Section 
4.6 

Federal Estimate  Preliminary Cost Estimates shall be prepared in accordance with Section 
4.6 

Calendar Day Estimate  Calendar Day Estimate shall be prepared in accordance with Section 4.6 

Permit Applications/ 
Approvals 

 Shall be uploaded and formatted in accordance with Section 4.7 

Ordering Paper Copies of 
Contract Documents 

 Paper copies of contract documents can be ordered in accordance with 
Section 3.2.11 

DCD 

Contract Plans  Plans shall be grouped in accordance with Section 4.1 

 Plans shall be formatted in accordance with Section 4.2 

 Plans shall be checked by the PDF checker in accordance with Section 6.2 

Contract Special Provisions  Special Provisions shall be prepared in accordance with Section 4.5 

Proposal Estimate  Preliminary Cost Estimates shall be prepared in accordance with Section 
4.6 

Federal Estimate  Preliminary Cost Estimates shall be prepared in accordance with Section 
4.6 

Calendar Day Estimate  Preliminary Cost Estimates shall be prepared in accordance with Section 
4.6 

Permit Applications/ 
Approvals 

 Shall be uploaded and formatted in accordance with Section 4.7 

Addendum 

Contract Plans  Plans shall be prepared in accordance with Section 7.1  

Contract Special Provisions  Special Provisions shall be prepared in accordance with Section 7.1.5 

Award Phase 
Signed Contract  Signed Contract will be uploaded into Projectwise in accordance with 

section xx. 
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Construction Phase 
Document/Process Requirements 

Contractor 
Submittals 

 Contractor submittals shall be uploaded in accordance with Section 9 

Contract Plans  Plans shall be prepared in accordance with Section 7.2  

Contract Special 
Provisions 

 Special Provisions shall be prepared in accordance with Section 7.2.5 

DCO Memo  DCO memo shall be prepared in accordance with Section 7.2.6  

Plan As-Builts  Plan As-Builts shall be accomplished in accordance with Section 8 

Project 
Correspondence 

 Shall be uploaded and formatted in accordance with Section 4.10 
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3.2 Digital Project Process Maps 
This section provides high level process maps for the procedures detailed in this manual. 

3.2.1 PPI Form  

Click Here for Formatting and Submittal Requirements 
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3.2.2 Digital Reviews 

Click here to go to the Digital Review Section 
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3.2.3 FDP Contract Plan Processing 

Click Here for Formatting and Submittal Requirements 
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3.2.4 Addenda Plans 

Click Here for Formatting and Submittal Requirements 

 
X  
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3.2.5 Design Initiated Change Order (DCO) Plans 

Click Here for Formatting and Submittal Requirements 
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3.2.6 Contractor Submittals 
See section 9 for detailed instructions.  Process maps for Shop Drawings, Working Drawings, 
Product Data Sheets, and RFIs are in development.  

3.2.7 Paper Plan Order Form 
The Paper Plan Order Form was created to allow each unit in the Department to order contract 
plans and special provisions for DOT Projects.  This form is located in each project in Projectwise 
and each unit in the Department that needs paper copies of contract plans and special 
provisions is required to update this form for their paper needs.  This form is then used by the 
Department’s Engineering Records unit to make the prints and send them out.  
  
Any Addendum or Change Order that is submitted for a project will be printed and sent out 
using the information indicated on the form.  Addendums will be printed and sent out 
automatically.  When a Change Order is submitted, the designer must notify Engineering records 
that a Change Order has been submitted and that paper copies of the Change Order need to 
printed and sent to the applicable units indicated on the Paper Plan Order Form.   
 
This following shows the procedure for how the Paper Plan Order Form is filled out and the 
prints are made.  Contact Information for Engineering Records: Print Shop: 860-594-3086 Plan 
and Specification Printing 

Step Project Stage Group Action 
1 FDP Processing After the contract plans and special provisions have been 

submitted for FDP an email is sent to each unit in the 
Department that requires paper copies of contract plans and 
special provisions.   

2 FDP Units Open the Paper Plan Order Form from Projectwise and fill out 
the form for their unit’s needs.  Save the form and check the 
form back into Projectwise. 

3 DCD Processing At DCD, lock the form by placing it in the Processing state. 

4 Advertise Contracts Notify Engineering Records that the project is going to be 
advertised and they can print the required paper copies 
indicated on the Paper Plan Order Form. 

5 Advertise Engineering 
Records 

Print the required paper copies indicated on the Paper Plan 
Order Form. 

6 All 
Addendums 

Contracts Notify Engineering Records that an Addendum is going to be 
advertised and they can print the required paper copies 
indicated on the Paper Plan Order Form for this Addendum.  
Make sure to tell Engineering Records which subsets are 
included in the Addendum. 

7 All 
Addendums  

Engineering 
Records 

Print the required paper copies indicated on the Paper Plan 
Order Form for the Addendum.  Make sure to print all the 
subset that were affected by the Addendum including the 02-
Revisions subset. 

8 All Change 
Orders 

Lead Designer Notify Engineering Records that a Change Order has been 
submitted and they can print the required paper copies 
indicated on the Paper Plan Order Form.  Make sure to tell 
Engineering Records which subsets are included in the Change 
Order.  If a unit is not listed on the Paper Plan Order Form, 
give Engineer Records those units’ contact information so 
those units’ can receive a copy of the Change Order.  

9 All Change 
Orders 

Engineering 
Records 

Print the required paper copies indicated on the Paper Plan 
Order Form for the Change Order and for any other units’ 
requested by the Lead Designer. Make sure to print all the 
subsets that were affected by the Change Order including the 
02-Revisions subset.   
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 Document Preparation and Section 4

Format 

4.1 Contract Plan Grouping 
Contract plans shall be grouped, by discipline into individual multiple page PDF files called 
discipline subsets.  The project manager is tasked with determining the discipline subset 
numbering and grouping and whether to use a single volume or multiple volumes for the 
project.   The number of sheets in a discipline subset shall contain a maximum of 150 sheets.  
The following details each of these options: 
 
Single volume digital contracts are used when each discipline or consulting firm designing the 
project is responsible for 3 subsets or less.  The following is an example of a single volume 
project.   

Note:  The first and second subsets shall always be 01-General and 02-Revisions.  The 03 
subset does not always need to be 03-Highways, the 04 does not always need to be 04-
Structure, etc.  FIO subsets shall be numbered at the end of the project before the 
standard subsets.   The Standards subsets shall not be numbered.   

 
Multiple volumes are used if the project has 1 or more of the following characteristics: 

a. The majority of the discipline/firm designers are responsible for more than 3 
subsets each.  This allows the individual designers to number their subsets 
independently of the other disciplines. 

b. There are multiple sites on the project.  Splitting these sites up into volumes will 
provide better organization of the project.   

c. Combining multiple projects into one project.  
The larger the project is, typically the more subsets will be required and their labels will be more 
specific.   The subsets shall be split up by volume and each volume shall be controlled by its 
assigned designer.   For example, all the subsets designed by the highway designer shall be in 
the same volume (02) and each subset shall have a unique subset number. 

Note:  The first and second subsets when using multiple volumes shall always be 01.01-
General and 01.02-Revisions.  The 01.03 subset does not always need to be 01.03-
Highways, the 01.04 does not always need to be 01.04-Structure, etc.  FIO subsets shall 
be numbered at the end of the project before the standard subsets.   The Standards 
subsets shall not be numbered.   

Combining Projects 
In the event 2 or more projects are combined into one project, the following shall be done: 

 Each project shall be given its own volume. 

 The lowest project shall always be volume 1.   

 Each project shall have its own title sheet, which reference each other with a note.   

 There shall only be (1) Revisions subset.  This subset shall be in volume 1 and named 
01.02 – Revisions. 

 The Revisions subset shall be the responsibility of the project manager on the projects.   

 Each project shall have its own detailed estimate sheets.   

 There shall only be (1) set of Highway Standards and (1) set of Traffic Standards when 
the projects are combined.   

 There shall not be any duplicate special provisions after the projects are combined.  

 There shall only be (1) calendar day chart. 
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The next two figures show examples of the single volume and multiple volume options.   

Single Volume Option 
 

Label 

(Discipline Subset) 

File contents 

(but not limited to) 

01-General 
Title Sheet 

Detail Estimate Sheet 
 

02-Revisions 

Index of Revisions Sheets  

03-Highways 

Index of Plans 

Survey Data 

Alignments 

ROW 

Typ Sections 

Misc Details 

Intersect Grading 

Boring Logs 

Highway Plans 

Breakout Drainage 

Highway Profile 

Highway X-

Sections 

Landscape Plan 

Wetland Mitigation 

04-Structure 

Index of Drawings 

All Structure Sheets  

Note: Multiple subsets may be required for 

multiple Sites 

Ex: 04_Structure_Br.No.1266 

05-Traffic 

Index of Drawings 

Signing 

Pavement Markings 

MPT 

Traffic Signal Plans 

Etc. 

06-Environmental 
Index of Drawings 

All Environmental Compliance Sheets required 

07-Utiltiy Utility Design plans.  For example 07_AT & T, 
07_CL & P, 07_MDC, etc.   

08-CL&P FIO** CL & P For Information Only plans 

09-AT&T FIO** AT & T For Information Only plans 

 CTDOT Highway STD CTDOT Highway Design Standard Index and 
Sheets required 

CTDOT Traffic STD CTDOT Traffic Engineering Standard Index and 
Sheets required 

Figure 3 Typical Highway Project Discipline Subset Contents 

* If a discipline has to be broken up into more than one subset, keep the label the same with the 
addition of “1” at the end of the first subset, “2” at the end of the second subset, etc.  
** For Information only discipline subset shall be submitted as individual pdf files based on the 
entity providing the information only.   
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Multiple Volume Option 
  

Label 

(Discipline Subset) 

File contents 

(but not limited to) 

Designer/ 

Firm 

01.01-General Title Sheet, Detail Estimate Sheet Lead 

01.02-Revisions Index of Revision Sheets Lead 

01.03-Wtlnd Re-establish Wetland Reestablishment plans Designer 1 

01.04-Stg Acc. Staging and Access Plans Designer 1 

02.01-Typ Sections Typical Sections Designer 2 

02.02-Alignments Alignment Geometry Designer 2 

02.03-Plan Plans Designer 2 

02.04-Profiles Profiles Designer 2 

02.05-ROW Brk Right of Way Breakout Designer 2 

02.06-Drain Drainage Plans Designer 2 

03.01-Retaining  Wall 1 Retaining wall details Designer 3 

03.02-Retaining Wall 2 Retaining wall details Designer 3 

03.03-Bridge 00456 Bridge_456 Designer 3 

03.04-Bridge 01983 Bridge_1983 Designer 3 

03.05-Bridge 01984 Bridge_1984 Designer 3 

04.01-Stage 1 Stage Construction Details 1 Designer 4 

04.02-Stage 2 Stage Construction Details 2 Designer 4 

04.03-Stage 3 Stage Construction Details 3 Designer 4 

05.01-SPM Signing and Pavement Marking Site 1 Designer 5 

05.02-SPM Signing and Pavement Marking Site 2 Designer 5 

05.03-SPM Signing and Pavement Marking Site 3 Designer 5 

06.01-IMS IMS Plans and Details Site1,2,3 Designer 6 

07.01-Env 1 Environmental Details Site 1 Designer 7 

07.02-Env 2 Environmental Details Site 2 Designer 7 

07.03-Env 3 Environmental Details Site 3 Designer 7 

08.01-”Utiltiy Utility Design plans.  For example 07_AT & T, 07_CL 
& P, 07_MDC, etc.   

Designer 8 

09.01-CL&P FIO CL & P For Information Only plans Designer 8 

09.02-AT&T FIO AT & T For Information Only plans Designer 8 

CTDOT Highway STD *CTDOT Highway Design Standard Index and Sheets 
required 

Designer 1 

CTDOT Traffic STD  CTDOT Traffic Engineering Standard Index and 
Sheets required 

Designer 5 

Figure 4 – Multiple Design Firms CTDOT Project Subsets 
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4.2 Contract Plan Format 
Digital contract plans (preliminary, semi-final, FDP, ADP, DCO, etc.) shall be formatted in 
accordance with the following: 

1. Contract Plans shall be in submitted to CTDOT in PDF format 
2.  PDF Plans must be sized either 36” x 24” for projects created before June 2007 or sized 

34” x 22” for projects created after June 2007 
3. PDF plans shall be measurable to scale in the PDF 
4. PDF plans shall be able to be printed to paper and scaled appropriately 
5. Text must be searchable 
6. All levels must have the ability to be displayed on or off, unless approved otherwise.   
7. All information on the digital contract PDF plans shall have been created from 

MicroStation or an approved alternate.  The only information that shall be added to the 
plans using a PDF editing software are as follows: 

 Page labels (see Section 4.14.2) 

 Sheet numbers (see Section 4.14.2) 

 Watermarks and flatten comments(see Section 5.4)  

 Any digital signature fields (see Section 5.5) 

 Digital Signature (see Section 5.6)       
8. Discipline subsets shall be published directly from a CAD application. Scanned images or 

raster image formats will not be accepted with the exception of For Information Only 
sheets, these can be scanned.    See Publishing CAD Files  for more instructions on how 
to publish from Microstation.    

9. Each discipline subset shall contain bookmarks; one for each page. 
10. The first page of each subset shall be a subset cover sheet, this includes FIO subsets.  

This cover sheet shall contain both; an index of drawings contained within the subset 
that includes both drawing numbers and drawing titles and the form field place 
holder(s) which receives the digital signatures.  The following cell has a table for the 
index of drawings and the digital signature cell place holder BDR_Discipline_Cover 
Sheet cell.  This table must include the subset name and number displayed as a heading 
in the table as shown in the figure below.   

 

Figure 5 Discipline Subset Bookmarks, Index of Drawings, and Signature fields 

 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/cad_selectseries/publishing_microstation.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/bdr_discipline_cover_sheet.zip
http://www.ct.gov/dot/lib/dot/documents/aec/bdr_discipline_cover_sheet.zip
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11. The first page of the subset 01_General shall be the CTDOT digital project title sheet 
which includes an index of the subsets contained within the project, sheet count totals 
for all subsets, a list of drawings for the 01_General Subset, and an area(s) reserved for 
applying the digital signature(s) (see section Section 5.5).   

Link to digital title sheet: Digital Title Sheet  
Consultants will need to delete the CTDOT signature blocks on the title sheet and place 
a digital signature placeholder as detailed in section Section 5.5 CTDOT engineers can 
find the digital title sheet in the seed files on our W: drive.   

12. The 01-General subset shall include all detailed estimate sheets.   
13. The 02_Revisions subset must be included in each digital project and there shall only be 

(1) revisions subset.    
14. Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions”, See 

Section 7.3. These revision sheets are used for tracking all sheet changes due to 
addenda and design initiated change order (DCO) with respect to the entire project. 
These sheets are originally blank and unsigned, and shall be managed and updated as 
needed by the Project Manager. The CTDOT Revision Contract Sheets can be obtained 
here: 

  CTDOT Designed Projects - 02-Revisions Subset 
  Consultant Designed Projects - 02-Revisions_CE_Subset  

15. Plans For Information Only (FIO) shall be submitted digitally, in individual subsets based 
on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc.  These 
subsets do not require a digital signature, but each sheet in the subset shall be labeled; 
“For Information Only”. The subset numbers shall be selected by the lead designer so 
that the FIO subsets are last.  Each sheet shall be numbered correctly, see Section 
4.14.2.    Upload and attribute in accordance with Section 6.1.  

16. Utility drawings shall be submitted in accordance with the following:   

 Utility plans For Information Only (FIO) shall be submitted in a utility subset 
based on the utility company, AT&T subset, CL&P subset, etc.  These subsets do 
not require a digital signature, but each sheet shall be labeled; “For Information 
Only”.  FIO utility subsets shall be numbered so that they are the last subsets. 
Example Labels; 10_CL&P_FIO, 11_AT&T_FIO.  These subsets must have page 
labels assigned,  see Section 4.14.2 

 Utility company designed plans that include work being done by the State’s 
Contractor shall be submitted in a utility subset based on the utility company, 
AT&T subset, CL&P subset, etc.  These subsets do not require a digital signature.  
Example Labels; 10_CL&P, 11_AT&T.  These subsets must have page labels 
assigned,  see Section 4.14.2 

 Utility plans that are designed by a Consultant firm that include work being 
done by the States Contractor shall be submitted in a utility subset based on the 
utility company, AT&T subset, CL&P subset, etc., and shall be digitally signed in 
accordance with this manual. Example Labels; 10_CL&P, 11_AT&T.  These 
subsets must have page labels assigned,  see Section 4.14.2 

17. CTDOT Standard sheets shall also be delivered digitally.  See Section 4.4 for how to 
prepare and submit CTDOT Standard Sheets.  

18. Footers, displaying the sheet number, shall be placed on each page of each PDF subset. 
See Section 4.14.2, “Sheet Numbering”  

19. As-built information shall be digitally applied to the contract subsets by District 
Personnel after the job is complete using Bluebeam.  See Section 8.   

20. Preliminary Contract Plans shall be submitted to CTDOT in accordance with this section, 
but do not need to be digitally signed.  These review documents shall be uploaded into 
the 310_Milestone Submission folders in Projectwise in accordance with Section 6.1. 

 

http://www.ct.gov/dot/lib/dot/documents/aec/ct_cgr_cps_proj_numb_titlesheet.zip
http://www.ct.gov/dot/lib/dot/documents/aec/02-revisions_ctdot.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/02-revisions_ce.pdf
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21. A Bluebeam set file shall be created at FDP and updated for any addendums or change 
orders in accordance with Section 4.15.2. 

22. Contract Plan subsets, FDP, DCD, DCD2, ADP, and DCO, must be checked by the 
Discipline Subset PDF Checker in accordance with Section 6.2. 

4.3   CTDOT For Information Only Sheets 
 
Plans provided For Information Only (FIO) shall be submitted digitally, in individual subsets 
based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc.  These 
subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For 
Information Only”.  The first sheet of each FIO subset shall be a subset cover sheet.  These 
sheets shall be placed on a border and numbered in accordance with section 4.14.2.   
 
The subset numbers shall be selected by the Project Manager so that the FIO subsets are last.  
See Section 6.1 for uploading and attributing FIO Plans. Information only sheets may be 
scanned, but must conform to the following:  

 Minimum Size 22”x34” 

 Minimum dpi = 300.   
 
This link shows an optional procedure that can be used to create a For Information Only subset 
that uses Bluebeam:  Preparing a For Information Only Subset 

4.4 CTDOT Standard Plan Sheets 
Standard sheets shall also be delivered digitally into Projectwise. The following shows how to 
obtain the latest version of the CTDOT Standard Sheets and how to prepare them for a digital 
project. 

1. Download the latest standards from the following link for the project:  CTDOT Standard 
Drawings Website 

2. Upload the standard subset into Projectwise in accordance with Section 6.1.     
3. Next open up the standards from Projectwise by double clicking on it.  Once it opens 

click on the index sheet. 

 

Figure 6 - Preparing the Standard Subsets 

 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/preparing_fio_sheets.pdf
http://www.ct.gov/dot/cwp/view.asp?a=2303&q=410884
http://www.ct.gov/dot/cwp/view.asp?a=2303&q=410884
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4. Then enter the project number and check the standards to be included in the project.   

 

Figure 7 - Enter Project Number and Check Boxes 

5. Delete the standards that are not included in the project as shown below: 

 

Figure 8 - Deleting Drawings from Standard Set 

6. Next digitally sign all index sheets in accordance with Section 5.6.4. 
7. Then upload the standards into the 100_Contract Plans folder in Projectwise in 

accordance with Section 6.1 of this manual.  
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4.5 Contract Special provisions 
1. Digital Contract Special provisions shall be submitted in MS Word format and in 

accordance with the Departments policies and procedures for Contract Development.   
CSI special provisions shall be submitted in pdf format.  

2. Preliminary special provisions and CSI special provisions shall be combined into (1) pdf 
document and then uploaded to the applicable folder under the 310_Review 
Documents folder under the project in Projectwise.  

3. FDP and Addendum special provisions and CSI special provisions shall be submitted to 
CTDOT in accordance with the following: 

 For projects where a consultant is the Project Manager on the project, the 
Specification and CSI special provisions in WORD format shall be submitted in 
(1) zipped folder. 

 For projects where a CTDOT design unit is the Project Manager on the project, 
the Specification and CSI special provisions in WORD format shall be submitted 
in individual zipped folders per discipline. 

 Addendum special provisions shall be submitted in WORD Format in a zipped 
folder.  Each page of the specification section shall be marked in the bottom 
right corner of the footer with “Addendum No. Y”, where “Y” equals the 
addendum number.  Also a line shall be placed on the right side indicating 
where language was changed in the specification.   

 Special provisions shall be submitted in a zipped folder for the following 
submissions:  FDP, revised FDP special provisions, Addendum special provisions, 
and revised addendum special provisions.  Revised FDP and revised addendum 
submissions shall only include the revised special provisions. 

 FDP, revised FDP special provisions, Addendum special provisions, and revised 
addendum special provisions shall be uploaded into the 240 Contract 
Development folder under the project in Projectwise in accordance with Section 
6.1 and attributed in accordance with Projectwise Attribute Table of this 
manual. 

4. Design Initiated Change Order special provisions shall be prepared and submitted in 
accordance with the following: 

 On each sheet of the revised specification, “C#” and the date shall be placed in 
the bottom right corner of the footer.   An example would be “Rev. C1 - 
mm/dd/yy”. 

 For projects where a consultant is the Project Manager on the project, the 
Specification and CSI special provisions in WORD format do not need to be 
uploaded into Projectwise. 

 For projects where a CTDOT design unit is the Project Manager on the project, 
the DCO Specification and DCO CSI special provisions in WORD format shall be 
submitted in individual zipped folders per discipline. 

 The project manager shall combine all the DCO specifications into (1) multi-page 
PDF document. 

 The consultant or state design Project Manager shall upload the Design Initiated 
Change Orders special provisions pdf file into the 110_Contract Documents 
folder under the project in Projectwise in accordance with Section 6.1of this 
manual and attributed in accordance with Projectwise Attribute Table of this 
manual.  

 
 
 
 
 

http://www.ct.gov/dot/cwp/view.asp?a=3886&q=459664
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
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4.6 Estimates and Quantity Calculations 
Estimates 
Cost Estimates shall be prepared in accordance with the procedures detailed on this website: 
Cost Estimating 
 
Preliminary cost estimates shall be uploaded into the 310_Milestone Submissions under the 
applicable project in accordance with Section 6.1 of this manual. 
 
Final Proposal and Federal Estimates shall be uploaded into the 240_Contract Development 
folder under the applicable project in accordance with Section 6.1 of this manual. 
 
Calendar Day estimates shall be uploaded into the 240_Contract Development folder under the 
applicable project in accordance with Section 6.1 of this manual. 
Quantity Calculations 
Quantity Calculations shall be formatted and submitted in accordance with the following: 

 Shall be native PDF whenever possible. 

 Scanned pages shall be readable and have a minimum resolution of 200 dpi.    

 Pages in the PDF can be any size.  8.5” x 11” is recommended. 

 Shall be uploaded into the 150 – Quantity Calculations folder under the project in 
Projectwise in accordance with Section 6.1 and attributed in accordance with 
Projectwise Attribute Table of this manual.  The final status shall also be applied as 
shown in section 2.5.   

4.7 Environmental Permits 
Environmental permit applications, permit approvals, and other permit documents shall be 
uploaded into Projectwise and formatted in accordance with the following: 
Permit Need Determination Form (PNDF) and Other Permit Documents 

 Shall be native PDF whenever possible. 

 The PNDF shall be uploaded into the 320_Permit Development Folder under the project 
in Projectwise in accordance with Section 6.1 and attributed in accordance with 
Projectwise Attribute Table. 

Environmental Permit Applications: 

 Shall be native PDF whenever possible. 

 Scanned pages in the application must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

 All pages, except plans sheets, shall be sized 8.5” x 11”.  Plan sheets can be sized up to 
34” x 22”.  

 Before FDP, each permit application shall be in an individual multi-page PDF file.  Each 
permit shall be shall be then uploaded into the 320_Permit Development Folder under 
the project in Projectwise in accordance with Section 6.1 and attributed in accordance 
with the  Projectwise Attribute Table.   

 At FDP, the individual multi-page PDF files shall be uploaded into the 240_Contract 
Development folder under the project in Projectwise in accordance with Section 6.1 and 
attributed in accordance with the Projectwise Attribute Table .   

Environmental Permit Approval 

 Shall be native PDF whenever possible. 

 Scanned pages in the permit must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

 Shall be sized 8.5” x 11”. 

 Before FDP, each permit approval shall be in an individual multi-page PDF file.  Each 
permit shall be shall be then uploaded into the 320_Permit Development Folder under 

http://www.ct.gov/dot/cwp/view.asp?a=3194&q=484094
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
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the project in Projectwise in accordance with Section 6.1 and attributed in accordance 
with Projectwise Attribute Table.   

 At FDP, the individual multi-page PDF files be uploaded into the 240_Contract 
Development folder under the project in Projectwise in accordance with Section 6.1 and 
attributed in accordance with Projectwise Attribute Table .   

4.8 Contractor Submittals  
See Section 9 for format, submittal and review requirements for Contractor Submittals: Working 
Drawings, Shop Drawings, Product Data, RFI, and RFC.  

4.9 Engineering Reports 
Hydraulic, Scour, Floodway, and Final Drainage reports: Shall be formatted in accordance with 
the following: 

 Shall be native PDF whenever possible. 

 Scanned sheets in the reports must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

 All sheets except plans sheets shall be sized 8.5” x 11”.  Plan sheets can be sized up to 
34” x 22”.  

 Shall be digitally signed and watermarked in accordance with Section 5 of this manual. 

 Any data files that must accompany the PDF report shall be uploaded into Projectwise in 
a zipped folder.   

 The reports and zipped folder for any data files shall be submitted into the 
130_Engineering Reports folder under the applicable project in accordance with Section 
6.1 of this manual.  The final status shall also be applied as shown in section 2.5.   

 Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in 
Projectwise.  

Task 110, Task 220, Underground Storage Tank System Closure Reports: Shall be formatted in 
accordance with the following.  The content of the report shall be in accordance with the Scope 
defined by the Division of Environmental Compliance: 

 Shall be native PDF whenever possible. 

 Scanned sheets in the reports must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

 All sheets except plans sheets shall be sized 8.5” x 11”.  Plan sheets can be sized up to 
34” x 22”.  

 Shall be digitally signed in accordance with Section 5 of this manual. 

 These reports shall be submitted into the 130_Engineering Reports folder under the 
applicable project in accordance with Section 6.1 of this manual.  The final status shall 
also be applied as shown in section 2.5.   

 Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in 
Projectwise.  

Rehabilitation Study Reports and Type Study Reports:  Shall be created and formatted in 
accordance with the Bridge Manual: 

 Final reports shall be uploaded into the 140_Project Administration folder in 
Projectwise.   The final status shall also be applied as shown in section 2.5.   

 Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in 
Projectwise.   

Bridge Load Ratings:  Shall be created and formatted in accordance with the Bridge Load Rating 
Manual:  

 Final load ratings shall be digitally signed in accordance with Section 5 of this manual. 

 Final reports shall be uploaded into the 130_Engineering Reports folder in Projectwise.   
The final status shall also be applied as shown in section 2.5.   

http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
http://www.ct.gov/dot/lib/dot/documents/dpublications/bridge/bdm.pdf
http://www.ct.gov/dot/lib/dot/documents/dbridgedesign/conndot_lr_manual.pdf
http://www.ct.gov/dot/lib/dot/documents/dbridgedesign/conndot_lr_manual.pdf
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 Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in 
Projectwise.   

Geotechnical Reports: 

 Shall be native PDF whenever possible. 

 Scanned sheets in the reports must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

 All sheets except plans sheets shall be sized 8.5” x 11”.  Plan sheets can be sized up to 
34” x 22”.  

 These reports shall be submitted into the 130_Engineering Reports folder under the 
applicable project in accordance with Section 6.1 of this manual.  The final status shall 
also be applied as shown in section 2.5.   

 Preliminary reports shall be uploaded into the 310_Milestone Submissions folder in 
Projectwise.  

4.10 Project Administration and Project Correspondence 
Documents 

Project Administration Documents 
Final project administration documents shall be stored in the 140_Project Administration folder 
under the project in Projectwise in accordance with the following: 

 Shall be in PDF Format. 

 Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125 
dpi. 

 The document must be uploaded into Projectwise in accordance with Section 6.1 and 
attributed in accordance with Projectwise Attribute Table of this manual.   The final 
status shall also be applied as shown in section 2.5.   

Note: The discipline attribute must match the author of the document.  For example, if the 
Highway design unit sends out a memo for a design review, the discipline attribute on this 
document shall be HW.   

 Draft project administration documents can also be created and worked on in 
Projectwise.  These file shall be located under the user’s discipline 330_Design_Data 
folder under the project in Projectwise.  

Project Correspondence Documents 
Project correspondence documents shall be stored in the 142_Project Administration 
Correspondence folder under the project in Projectwise in accordance with the following:    

 Shall be in PDF Format. 

 Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125 
dpi. 

 The document must be uploaded into Projectwise in accordance with Section 6.1 and 
attributed in accordance with Projectwise Attribute Table of this manual.  The final 
status shall also be applied as shown in section 2.5.   

Note: The discipline attribute must match the author of the document.  For example, if the 
Highway design unit sends out a memo for a design review, the discipline attribute on this 
document shall be HW.   
 
This folder is for all final project correspondence documents.  This is defined as any request 
memos, response memos, emails, letters, etc. and does not include any documents that are 
defined in the 140_Project Administration folder.  This folder shall not include any working/draft 
documents.  The final status shall also be applied as shown in section 2.5.   

 Emails – The sender of the email is required to store a PDF of the email message in 
Projectwise.   

 Letters 

http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
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 Meeting Minutes 

 Request Memos – Survey Request, Design Reviews, Support unit design.    

 Response Memos – Response to the Request Memos 

4.11 GIS Project Location Documents 
Project location for all projects shall be submitted to CTDOT.  See Section 12 for the format and 
submission requirements. 

4.12 ROW (Rights of Way) Documents 
Property Maps and Parcel Polygon files for acquired property shall be submitted to CTDOT. See 
Section 13 for the format and submission requirements. 

4.13 Design Calculations 
Design Calculations for all structural elements on a project shall be formatted and submitted in 
accordance with the following: 

 Shall be native PDF format whenever possible.   

 Scanned pages shall be readable and have a minimum resolution of 125 dpi.    

 Pages in the PDF can be any size.  8.5” x 11” page size is recommended. 

 Shall be uploaded into the 151 – Final Design Calculations folder under the project in 
Projectwise in accordance with Section 6.1 and attributed in accordance with 
Projectwise Attribute Table of this manual.  The final status shall also be applied as 
shown in section 2.5.   

4.14 Contract Plan Drawing and Sheet Numbering 

4.14.1 Drawing Number 
The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited 
to; section details, section cuts, and detail callouts. Drawing numbers in digital contracts shall 
consist of the discipline designator followed by a hyphen and the sheet number.  Examples of 
discipline designators are HWY, PRO, IND, XSC, S, TR, A, E, etc.   
 
The first sheet in a discipline subset shall have “01” in the drawing number as shown below: 

 

Figure 9 Contract Drawing Numbering 

4.14.2 Final Plan Page Labels and Sheet Numbers 
Page labels and sheet numbers are applied to the discipline subset after the contract plans are 
published to PDF. 
 
Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the 
number pages and header and footer tools within Bluebeam.  Page labels and sheet numbers 
shall be applied to all submissions of contract plans. 
 

http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
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The first sheet in every subset shall start out at 01.  For example the first sheet in the 05-Traffic 
subset shall be 05.01.  

 

Figure 10 - Drawing and Sheet Numbering 

The page label and sheet number place holder shall be determined by the total estimated sheet 
count. For less than 100 sheets two place holders is adequate. For greater than or equal to 100 
sheets three place holders are necessary.  For subsets less than 10 sheets, two placeholders 
shall be used i.e. 01.01 thru 01.04 for a four sheet subset. 
The page labels and sheet numbers must be placed correctly because it is used to correctly 
assemble the contract plans into a properly ordered consolidated set that District Construction 
takes advantage of during construction of the project.  
 
Single Volume Projects: 
The page labels and sheet numbers, for single volume projects shall be a concatenation of the 
discipline subset number, a decimal point, and the sheet number. For example; the page labels 
and sheet numbers for subset “4” would be as follows; less than 100 sheets 04.01, 04.02, 04.03, 
etc or Greater than 100 sheets 04.001, 04.002, 04.003 etc.  
The Project Manager should determine the total number of subsets and give each discipline 
their corresponding subset number, see Section 4.1. 
 
 
Multi Volume Projects: 
For a multi volume project the page labels and sheet numbers shall be a concatenation of the 
volume number, a decimal point, the discipline subset number, a decimal point, and finally the 
sheet number. Example: Volume 2, Subset 5; 02.05.01, 02.05.02, 02.05.03.  
 
Volume numbers shall be used on large projects. They are effective because the Project 
Manager only has to deliver to the other engineers their perspective volume numbers, allowing 
them to manage their subset numbers independently of the other discipline volumes and subset 
counts, see Section 4.1. 
 
Subset numbers shall start at 01 for all volumes. 
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BLUEBEAM - Applying Page Labels and Sheet Numbers  
To apply page labels and sheet numbers in Bluebeam follow the figures below: 

1. First page labels must be applied to the discipline subset.  Go to the thumbnail pane as 
shown below, right click on a thumbnail and select Number Pages: 

 

Figure 11 - Adding Page Labels 

For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at 
once.  In the case where there are 10 or more sheets in the subset the following will have to be 
done twice in order to get the correct number of place holders.   
  

2. Select the correct style, insert correct prefix for the sheets being numbered, and apply 
to the correct pages.  For example, if the 04 subset has 99 sheets the prefix shall be 
“04.0” for sheets 1-9 and “04.” For sheet 10 through 99. 

 

 

Figure 12- Page Labeling 
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3. Now the pages will be labeled: 

 

Figure 13 - Labeled Pages 

4. Next we will apply the sheet numbers.  From Bluebeam select the Document tab and 
then “Header & Footer” 

 

Figure 14 - Header Footer Tool 

5. Place the sheet numbers, as shown below:  Note the margins may have to be adjusted 
as necessary.  After you select the font, set the margins, and type in <<PageLabel>> as 
shown below.  Then click save for save settings.  The next time you are going to apply 
sheet numbers to a subset, you can simply select the saved settings.  Then click OK. 
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Figure 15 - Insert Sheet Numbers 
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4.14.3 Addendum and Design Initiated Change 
Order Page Labeling and Sheet Numbers 

Page labels and sheet numbers for an Addendum need to have “.A##” at the end and Change 
Orders need to have “.C##” at the end (see Section 7 for addendum and change order sheet 
numbering requirements). 
 
To apply page labels and sheet numbers in Bluebeam follow the figures below: 

1. First page labels must be applied to each sheet in the addendum or change order.  This 
can only be done one sheet at a time.   

2. Go to the thumbnail pane as shown below and then double click on the page label.  
Then type in the correct page label for the sheet. 

 

Figure 16 - Adding Page Labels 
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3. After all page labels have been applied, the sheet numbers can be applied.  From 
Bluebeam select the Document tab and then “Header & Footer” 

 

Figure 17 - Header Footer Tool 

4. Select your sheet numbers saved settings from before and click OK.  Note the margins 
and size may have to be adjusted as necessary.   

 

Figure 18 - Applying Addendum or DCO Sheet Numbers 
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4.15 Consolidating Contract Plan Discipline Subsets  
The consolidation of the contract plan discipline subsets is accomplished using the Set feature in 
Bluebeam version 11 or newer.  This feature creates a single viewer file called a “Set File” that 
allows users to take multiple digitally signed files, sort them by their sheet numbers, and view 
them in order without actually combining the files.   
 
The project manager shall create a Set file for the project at FDP that contains all the discipline 
subsets, DO NOT include the highway and traffic standard subsets.  When an Addendum or 
Change Order is required for the project, the set file shall be updated by the project manager to 
include the Addendum or Change Order subsets. 
 
The following shows when and how a set file will be created and updated throughout the life of 
a project.  
 
See Appendix C for general use of a set file. 

4.15.1 When a Set File is Created and Updated 
Set File Creation  

1. The lead designer shall create a set file of all the discipline subsets at FDP, see Section 

4.15.2 

Set File Updates 
2. If any FDP subsets need to be revised during the DCD process, the set file shall be 

updated to remove the FDP subsets that were changed and add the DCD subsets.   

3. If any Addendum subsets are required for the project, these Addendum subsets shall be 

added to the set file.   

4. If any Design Imitated Change Order subsets are required for the project, these Design 

Imitated Change Order subsets shall be added to the set file.  

See section 4.15.3 for updating the set file. 
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4.15.2 Creating a Set File 
After all the discipline subsets have been submitted into Projectwise for FDP the lead designer 
shall create the project’s set file in accordance with the following:   

1. Launch Bluebeam from the desktop icon on your computer.  

2. Next Click on the Set Icon and select New Set as shown below: 

 

Figure 19 - Creating a Set File 
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3. Then click Add and then Projectwise and OK as shown below: 

 

Figure 20 - Adding Files to the Set File 

4. Next browse out to your project’s 100 Contract Plans folder and select all plans except 

the standard subsets.  Then click Open:  After you click Open it may take a minute for 

Bluebeam to load all the files into the set, please be patient.   

 

Figure 21 - Adding Files to the Set File 
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5. Next Click on Relative Paths and make sure the options are selected as shown below: 

 

Figure 22 - Set File Options 

6. Next click on Advanced and select and unselect the options as shown below: 

 

Figure 23 - Configuring the Set File 

 
 
 
 
 
 
 
 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 7/2017 48 Version 4.02 
     

7. Next click Save, this may take a while depending on how big the project is, please be 

patient.  When the box pops up choose Projectwise and click OK: 

 

Figure 24 - Saving the Set File 
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8. Select the Advanced Wizard, and then on the Select target folder browse out to your 

project’s 100_Contract_Plans folder.  Then click next until you get to the attributes 

page.  Attribute the Set File as shown below: 

 

Figure 25 - Attributing the Set File 

 
9. Click OK after the set file has been saved into Projectwise: 

 

Figure 26 - Creating a Set File 
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10. Now the set file has been created for use of the Set File see Appendix C: 

 

Figure 27 - Set File 
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4.15.3 Updating a Set File 
The following will show how to update a set file. 

4.15.3.1 Adding a File to the Set File 
1. Double click on the set file from Projectwise and open as shown below:  This may take a 

while depending on how big the project is, please be patient. 

 

Figure 28 - Opening a Set File 
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2. Next click on the Set icon and click Add as shown below: 

 

Figure 29 - Modifying a Set File 

3. Next browse out to your project and select the files to add to the set and click Open.  

This may take a minute to add the additional file to the set so please be patient.  After it 

finishes click OK.   

 

Figure 30 - Adding Files to the Set File 
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4. Now the file will be added to the set, scroll down and you will see it.  

 

Figure 31 - Set File 
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4.15.3.2 Deleting a File from the Set 
1. Double click on the set file from Projectwise and open as shown below:  This may take a 

while depending on how big the project is, please be patient. 

 

Figure 32 - Opening a Set File 
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2. Next click on the Set Icon.  Then select the file to remove from the set and click delete: 

 

Figure 33 - Deleting a File from the Set File 
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 Digital Signatures for Contract Section 5

and Other Engineering Documents 

The follow contract documents must be digitally signed when submitted to the Department in 
accordance with the following section: 

 Contract Plans – FDP, Addendum, Change Orders 

 Engineering Reports 
o Hydraulic Report 
o Scour Report 
o Floodway Report 
o Final Drainage Reports 
o Bridge Inspection Reports 
o Bridge Load Ratings 
o Task 110 
o Task 220 
o Underground Storage Tank System Closure Reports 

 Working Drawings for Permanent and Temporary Structures – Plans and Calculations 
 
This manual refers to digital signatures in two ways: certifying signatures, and signing signatures. 
The Engineer of Record or document signer will always digitally sign using a visible certifying 
signature.  If multiple signatures are required per document, the second signer or sub-engineers 
shall always digitally sign using a visible signing signature after the primary signer or engineer 
has applied his certifying signature.  Certifying signatures allow controlled changes, to the now 
certified document.  These controlled changes include; allowing PDF digital comments, and the 
application of additional signatures.  Signing signatures should always be accompanied by a note 
listing the sheets the signer is responsible for within a subset.   
 
In order to digitally secure a PDF document the signer(s) applies a digital signature(s) to only the 
first sheet of the document, regardless of the number of pages the document contains. This 
digital signature secures the entire document.  
 
A graphic image of the signer’s signature must be created, and shall be used for the following 
purposes:    

 It shall be attached to the digital signature and displayed when the digital signature is 
applied.  

 It shall be placed as a watermark on all contract plan sheets a particular engineer of 
record is responsible for (digitally signing for).   

 It shall be placed on the first sheet by the preparer and checker of an engineering 
report. 

 The watermark shall be placed on all contract plan sheets and all plan sheets contained 
in a working drawing submittal. 

 
A digital ID must be purchased in order to apply a digital signature.  Digital ID’s must meet the 
special provisions of Adobe’s Certified Document Services (CDS).  The necessary hardware and 
software needed to apply the required digital signatures may be purchased from the vendor list 
provided at the following website: HUhttp://www.adobe.com/security/partners_cds.html UH, 
additional information on Adobe’s CDS is also available at this website. 
 
Before digitally signing any document Bluebeam must be set up as detailed in Appendix A.  
 
 

http://www.adobe.com/security/partners_cds.html
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5.1 Graphic Image of Signature 

5.1.1 Contract Plans 
The following figures display an example of both a state designer and a consultant designer’s 
digital signatures, and their accompanying graphic image(s) of their signature(s). See Section 5.2. 
for instructions on how to create a graphic image.    
 
The consultant engineer’s graphic image must contain his companies name and address; his 
signature, his Professional Engineers stamp, or his Professional Architecture Stamp. The state 
employee’s graphic image must contain only his signature. See Below. 
 

      

Figure 34 - Graphic Image of Signature 

In addition to a digital signature being placed on the first sheet of any contract plan, working 
drawing plans, and working drawing calculations, CTDOT also requires that all subsequent pages 
be watermarked with a copy of the engineer of records graphic signature before they are 
digitally signed. Watermarks containing these signatures are applied using Bluebeam and are 
always placed in the border of contract plans and working drawings for permanent structures. 
This is to prove validation of a digital document if printed. 
 

         
 

        

Figure 35 – Watermarks 

 

 

1st page of Subset 

Watermark of State Design Graphic 
Signature 

Watermark of Consultant Designers  
Graphic Signature 
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5.1.2 Engineering Reports 
Hydraulic, Scour, Floodway, and Final Drainage Reports 
The following shows the watermarks that need to be placed on the first sheet of a Hydraulic, 
Scour, Floodway, or Final Drainage Report by the Preparer and the Checker and the digital 
signature of the Approved Hydraulic Engineer.  The digital signature must include the graphic 
image of the signer’s PE stamp and signature as shown below, Section 5.2. for instructions on 
how to create a graphic image.  These reports shall be digitally signed in accordance with 
Section 5.6.7   
 

 

Figure 36 - Engineering Reports 
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Bridge Inspection Reports 
The following shows how Bridge Inspection reports are to be digitally signed in the bottom right 
hand corner of the report. The digital signature must include the graphic image of the signer’s 
PE stamp and signature as shown below, Section 5.2. for instructions on how to create a graphic 
image.  These reports shall be digitally signed in accordance with Section 5.6.7   

 

Figure 37 - Bridge Inspection Reports 
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Bridge Load Ratings 
The following shows how Bridge Load Ratings are to be digitally signed. The load ratings shall be 
digitally signed in accordance with Section 5.6.1  
 

 

Figure 38 - Bridge Load Ratings 

 
Environmental Compliance Reports 
The digital signature for the Task 110, Task 220, and Underground Storage Tank System Closure 
Reports must include a graphic image of the Professional engineer’s signature or a graphic 
image of the signer’s signature where applicable, see section 5.2. for instructions on how to 
create a graphic image. These reports shall be digitally signed in accordance with section 5.6.7   
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5.1.3 Working Drawings 
Working Drawings for Permanent and Temporary Structures 
The following shows the digital signature and Professional Engineering watermark requirements 
for the engineer who prepares the working drawing submittal.   These types of submittals shall 
be digitally signed in accordance with section 5.6.6   Note:   Working Drawing for Temporary 
Structures only require that the first sheet in the submittal be digitally signed, watermarks are 
not necessary.  See section 5.2 for instructions on how to create a graphic image. 
 
Working Drawing Plans 
The first plan sheet in the submittal shall have a digital signature and a watermark placed on it 
as shown below. All others sheets will only have the watermark.  A place in the border of the 
plan sheets shall have a spot for this watermark.  
 

 

Figure 39 - Working Drawing for Permanent Structures 
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Working Drawing Calculations 
The first sheet of the calculations shall have a digital signature as shown below: 

 

Figure 40 - Working Drawing for Permanent Structures 

5.1.4 Other Documents 
Documents that do not require to be signed by a Professional Engineer shall have a graphic 
image of the signer’s signature attached to their digital signature. See section 5.2. for 
instructions on how to create a graphic image. 
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5.2 Creating Graphic Image of Signature: 

5.2.1 In House CTDOT or Non-Professional 

Engineering Signature: 
The graphic signature will be used by CTDOT employees and signers that are not signing as a 
Professional Engineer.   
 
CTDOT graphic signatures shall be created as follows: 
 

1. Signer must sign a blank piece of paper. 
2. Scan this signature. 
3. Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.  
4. Save the images, in PDF to an area on your PC. 

 

Figure 41 (Example of CTDOT Graphic Image of Signature – Used with Digital Signature and as a Watermark) 

5.2.2 For Consultant Staff PE Stamp: 
Consultant Engineers shall create two different graphic signature images: one that shall 
accompany their digital signatures and a different one that shall be placed as a watermark on all 
the plan sheets the engineer is signing for.  
 
This section shows an example of a Professional Engineer preparing their graphic image of their 
signature; Architect’s shall follow this section when they are preparing their digital signature.   
Graphic Appearance Attached to Digital Signature 
The graphic signature that accompanies the digital signature only needs to include the 
designer’s signature and P.E. Stamp. , and shall be created as follows:   
 

1. Stamp and Sign a blank piece of paper. 
2. Scan this signature. 
3. Crop the image to approximately 250 pixels wide by 250 pixels high. 
4. Save the image, in PDF to an area on your PC or server, where you can easily access it 

for later use in the signature set-up procedure.  

 

Figure 42 ((Example of Consultant Engineer Graphic image of Signature – Applied to 1
st

 page only with digital signature) 
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Graphic Appearance used as a Watermark  
In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a 
watermark shall also include the designer’s company name and address, and shall be created as 
follows:   
 

1. On blank paper – Print company name and address. 
2. Place P.E. stamp next to company name and address. 
3. Sign P.E. Stamp.  
4. Scan the image created in steps 1 thru 3 above.   
5. Crop the image to approximately 500 pixels wide by 250 pixels high. 
6. Save the image, in PDF to an area on your PC or server, where you can easily access it 

for later use in the watermarking procedure.   
 

 

Figure 43 (Example of Consultant Engineer Graphic image of Signature – applied to all pages as a watermark) 

Once the graphic images have been properly created and saved, the digital signature 
appearance preferences must be set as follows: 

5.3 Setting Digital Signature Appearance Preferences: 
 
Once the graphic signatures are created the digital signature appearance settings must be 
defined as follows: 
Bluebeam Digital Appearance 

1. Make sure your CDS USB token is inserted into the computer then in Bluebeam go to the 
Document tab and select Signatures>Digital ID’s: 

 

Figure 44 - Digital Appearance 
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2.  Next click on your ID and click Manage Appearances: 

 

Figure 45 - Manage Appearances 

3. Next follow the figure below: 

 

Figure 46 - Setting the Digital Appearance 

4. Now the digital appearance will be saved and can be used to digitally sign. 
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5.4 Watermarking Plans with Graphic Image of 
Signature 

The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a 
copy of their graphic signature as a watermark on each sheet of each discipline subset, or 
working drawing submittal(Plans and Calculations) that they are responsible for.  For 
Engineering Reports the preparer and checker of the report shall place a copy of their graphic 
signature as a watermark only on the cover of the report.   
 
Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and Consultant 
Designed) 
There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2.  The 
following shows an example of a CTDOT signature, but the procedure is the same for a 
consultant when they are placing their PE stamp in the border or on the first sheet of an 
engineering report. 
 
Watermarking Workflow: 
Option 1 

1. The watermark in Bluebeam is placed using the stamp function.  First go to the Markup 
tab and select Stamp and then choose your stamp.  If your Principal’s or PE stamp is not 
in the list follow Appendix A.  If your stamp is in the list go to step 2. 

 
2. Next place the stamp in the border on the first sheet.   

 

Figure 47 - Placing Watermark 
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3. Next right click on the stamp and select “Apply to all pages”.  If you are watermarking an 
engineering report you do not need to apply to all pages.   

 

Figure 48 - Placing Watermark on All Pages 

If more than one group has to watermark this subset, browse to the pages the other group is 
responsible for and delete the watermark.  Then they can come in a place their watermark on 
these sheets.   
Flatten Markups 

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF 
document.  Go to Document>Flatten Markups.  Use the default settings and click OK.   

Option 2 
1. Go to the Document tab and Pages>Apply Stamp. 

 

Figure 49 - Applying Stamps 
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2. Select stamp, input scale and coordinates as necessary, and page range as shown below. 

 

Figure 50 - Applying Stamps 

Flatten Markups 
3. After the watermarks have been placed on the subset, the watermarks must be 

“flattened” to the PDF document.  Go to Document>Flatten Markups.  Use the default 
settings and click OK.   

 
 

5.5 Digital Signature Fields  
Contract Plans 
Digital signature fields are form fields created using Bluebeam, and are used to house the digital 
signatures. Digital Signature form fields shall be placed within the form field place holders. The 
form field place holders are cells that are placed in the MicroStation file on the title sheet and 
the subset cover sheets and on any Addendum or Change Order Subset.  The figure below 
shows a CTDOT designed project with the form field place holders (circled) on the title sheet and 
the discipline subset cover sheet.    
 

 

Figure 51 - Digital Signature Fields 
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The figure below shows a consultant designed project’s title sheet and discipline subset cover 
sheet with their form field place holders.     

 

Figure 52 - Consultant Watermarks 

Place holders determine the location and size of the digital signature form field.  
 
Form field place holding cell library: CT_Digital_Sigs.zip  
 
The digital signature place holder and form fields shall be created on the first page of each 
discipline subset for each required digital signature. 
 
Note:  All signature form fields need to be created for both certifying and signing signatures 
before any digital signatures is applied to the document. 
 
Contractor Submittals 
Contractor submittals will not be required to have a digital signature place holder.   
 
Engineering Reports 
Engineering reports will not be required to have a digital signature place holder.   

5.5.1 Bluebeam - Creating Digital Signature Form 
Fields 

The following example shows how to place the (3) digital signature form fields on the 01-
General title sheet of a CTDOT designed project.  For a discipline subset or a consultant designed 
01-General title sheet, only one digital signature form field needs to be placed.    
 

1. Go to the Document tab and select Signatures>Add Signature Field. 

 

Figure 53 - Adding Signature Fields 

 

http://www.ct.gov/dot/lib/dot/documents/aec/ct_digital_sigs.zip
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2. Next place three signature fields in the appropriate location and hit save as shown 
below: 

 

Figure 54 - Placing Signature Fields 

5.6 Applying Digital Signatures 
This section describes how to apply digital signatures for contract plans, engineering reports, 
working drawing plans, and working drawing calculations.   
 
Contract Plans 
Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic 
Standard drawing subsets have unique requirements as described in the following sections.   
 
CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded 
into projectwise because the Principal Engineer will be looking in projectwise to digitally sign 
documents.   
 
Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of 
record, using a single visible certifying signature, applied to the signature form field located on 
the first page of each subset. 
 
Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of 
Record who is responsible for the most sheets in the subsets.  This engineer will apply a visible 
certifying signature in the top most form field. The next Engineer of Record shall apply their 
signing signatures in the subsequent form fields. This Engineer shall also include a reason, when 
applying their digital signatures, listing the pages they are responsible for.  
 
Digital signatures must be applied to digital signature form fields, previously.  See Section 5.5  
 
Engineering Reports 
Engineering Reports shall be digitally signed, by the Engineer of Record using a certifying.  See 
Section 5.7 for instructions on how to apply a certifying signature to an engineering report. 
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5.6.1 Applying Digital Signatures to 01_General 
Subset (FDP and Addendum Subsets) 

 
CTDOT DESIGNED PROJECTS: 
The following procedure applies to both the 01_General subset at FDP and any 01_General_A# 
subset.   
 
The project title sheet of the 01_General subset shall first be digitally signed by the lead 
discipline’s Principal Engineer, using a certifying signature.  The Principal Engineer should make 
sure that all three digital signature form fields (blue boxes in the signature block) are placed 
before signing, as these forms cannot be added after the document is digitally certified.  After 
processing has approved the 01_general subset for Advertising, the Manager, and the 
Transportation Engineering Administrator shall digitally sign the same sheet directly below the 
principal’s signature, using a signing signature while the plans are in the Manager and Engineer 
Admin. Sign state.   
 
Processing shall notify the lead designer when the 01-General subset is placed in the Manager 
and Engineer Admin. Sign state.  The lead designer shall then coordinate the digital signing by 
the Manager and Engineering Administrator of the 01_General subset.  When both signatures 
are applied to the plans, the lead designer shall then notify processing that the 01-General 
subset has been signed.     
 
 
See Section 5.7 Applying Digital Signature Workflows 
Note: When digitally signing the 01_General subset all signers shall leave the reason code 
blank. 
The following image shows a typical project title sheet from the 01_General subset that is 
digitally signed: 

 
 

Figure 55 - Title Sheet Digital Signatures 
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CONSULTANT DESIGNED PROJECTS: 
The project title sheet of the 01_General subset shall be digitally signed by the lead consultant, 
using a certifying signature.  
 
See Section 5.7 Applying Digital Signature Workflows 
 

 

Figure 56 - Consultant Designed Title Sheet 

 
When more than one consultant works on a CTDOT digital project the project manager (prime 
consultant) shall apply a visible certifying signature to the first page of the 01_General subset.  
By applying this signature the prime consultant is accepting responsibility for the entire set of 
digital contract plans.  However the individual subsets shall be signed by the corresponding 
firms.    
Note: When applying certifying or signing signatures leave the reason code blank.  
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5.6.2 Applying a Digital Signatures to 02_Revisions 
Subset  

 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a CTDOT signature, but the workflows are the same.   
 
This subset does not need to be signed at FDP.  This subset must be signed when the sheet 
is filled out for an Addendum or design initiated change order, whichever comes first.   
 
The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally signed 
by the lead designer, using a certifying signature.   
 
1. The lead designer shall apply a certifying signature as described in section 5.7 Applying 

Digital Signature Workflows with the following EXCEPTION; the option “No Changes 
Allowed” must be selected to eliminate unauthorized changes after certifying the 
document. See the figure below: 

 

 

Figure 57 Certifying Dialog Box for 02_Revisions.pdf 
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5.6.3 All Other Discipline Subsets - Single 
Signature  

 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a consultant signature, but the workflow is the same.   
 
Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the 
responsible design engineer. As shown below. 
 
See section 5.7 Applying Digital Signature Workflows 

 

 

Figure 58 CTDOT Certified Plan Subset 

5.6.4 Standard Drawing Subsets – Single Signature  
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a consultant signature, but the workflow is the same.   
 
Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need 
to be digitally signed with a visible certifying signature, by the responsible design engineer that 
submits the subset to Projectwise.  For example, in the case where the Traffic unit is submitting 
a Highway standards subset, the Traffic Principal Engineer is responsible for digitally signing the 
index sheets, not the Highway Principal Engineer.   
See section 5.7 Applying Digital Signature Workflows 
 

5.6.5 All Other Discipline Subsets – Multi-
Signatures  

 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a consultant signature, but the workflow is the same for 
CTDOT designed projects.    
 
Multiple signatures per a single subset are required where two or more disciplines/firms are 
responsible for one subset. 
 
The lead designer that is responsible for most of the pages within a discipline subset shall 
digitally sign the subset using a certifying signature, and leave the reason code blank.  See 
Section 5.7 Applying Digital Signature Workflows 
Once certified by the subset lead, the remaining designers(s) shall digitally sign the same subset 
using a signing signature, and complete the reason code with a note stating which pages, 
contained in this subset, that they are responsible for.  See table 2-1 below: 
See Section 5.7 Applying Digital Signature Workflows 
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Table 1 Reason Codes for Prime and Sub Consultants 
Designer Certify or 

Sign 
Responsible 

Sheet 
Numbers 

Reason Code 

Lead Designer Certify   

Sub-Designer 1 Sign 03.78 Thru 
03.88 

I am Signing for Sheet Nos. 03.78 thru 
03.88 

Sub-Designer 2 – 
etc. 

Sign 03.88 Thru 
03.98 

I am Signing for Sheet Nos. 03.88 thru 
03.98 

5.6.6 Working Drawings 
Working drawing submittals shall be digitally certified in accordance with section 5.7 Visible 
Digital Signature using a Certifying signature, of this manual.   

5.6.7 Engineering Reports 
Engineering Reports shall be digitally signed, by the applicable person using a certifying.  See 
section 5.7 for instructions on how to apply a certifying signature to an engineering report.  If a 
report needs to be digitally signed by more than one person, the first person must apply a 
certifying signature as shown in section 5.7 and any subsequent signature will be a signing 
signature as shown in section 5.7. 

5.6.1 Bridge Load Ratings 
Load Ratings shall be digitally signed, by the applicable person using a certifying signature with 
the No Changes Allowed option selected as shown below: 

 

 

Figure 59 Certifying Load Ratings 
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5.7 Applying Digital Signature Workflows  
 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a CTDOT signature where the document is located in 
Projectwise, but the workflows are the same.      
 

Certifying Signature: 
1. Left click on the signature field and then update the settings as shown below.  Examples 

below are for a CTDOT designed project’s title sheet and the first sheet of an 
Engineering Report: 
 

Discipline Subsets 

 

Figure 60 - Certifying Discipline Subsets 

Engineering Reports  or Documents that Require (1) Digital Signature 

 

Figure 61 - Certifying Engineering Reports 
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2. Next for document in located in Projectwise click Projectwise V8i as shown below and 
then click OK.  If the document is located on your computer click My Computer list 
below: 

 

Figure 62 - Certifying Signature 

 
3. Then select yes to overwrite existing file as shown below for projectwise or if the 

document is located on your computer overwrite the existing file or save to a new 
location: 

 

Figure 63 - Certifying Signature 

 
4. If using Projectwise check the document back into Projectwise.   
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Digital Signing Signature: 
Once the prime engineer applies his certifying signature the additional signing signatures can be 
applied by the sub-consultants as follows:  
 

1. Left click on the signature field and then update the settings as shown below: 
 

 

Figure 64 - Signing Signaure Bluebeam 

 
2. Next for document in located in Projectwise click Projectwise V8i as shown below and 

then click OK.  If the document is located on your computer click My Computer list 
below: 

 

Figure 65 - Open from Projectwise 
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3. Then select yes to overwrite existing file as shown below for projectwise or if the 

document is located on your computer overwrite the existing file or save to a new 
location: 

 

Figure 66 - Overwriting a File 

4. If using Projectwise check the document back into Projectwise.   
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 Submitting Documents to CTDOT Section 6

This section details the procedures for submitting documents to Projectwise.    

6.1 FDP Submittal to Processing – Under Development 
The files required to be submitted to Processing must be added to the set file stored in the 
240_Contract Development folder as shown below.  The set file creates a link to the document 
so documents can be stored in separate folders, but show up together.  When files are added to 
a set file they are not moved, a link is created.    
 
If there is not a set file in the240_Contract Development folder in Projectwise contact 
DOT.AECapplications@ct.gov 
 

1. Open the Set file by double clicking on it. 
2. Then browse out the folder where the documents are stored. 
3. Then drag and drop the document(s) into the set file window as shown below: 

 

Figure 67 - Adding Files to the Set File 

 
 
 
 
 
 

mailto:DOT.AECapplications@ct.gov
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6.2 Uploading Documents 

6.2.1  ProjectWise (Thin Client) 
The following shows how to upload Contract plans into the 100 Contract Plan folder in 
Projectwise, but this procedure can be followed for uploading documents into any folder in 
Projectwise.   

1. Once logged into Projectwise browse out to project and folder you need to upload into.  
Then go to View>Interfaces and select the “CTDOT_Doc_Code” Interface.  

 

Figure 68 - Selecting the Interface 
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2. Next select Document>Upload as shown below: 
 

 

Figure 69 - Uploading Document into Projectwise (Thin Client) 

3. Next browse out to the document you want to upload.   

 

Figure 70 - Uploading a File to Projectwise 
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4. After the file uploads, right click on the file and select Properties: 

 

Figure 71 - Select Properties 

5. Then assign the applicable attributes from the tables in Projectwise Attribute Table:  If 
you cannot assign attributes, the interface was not selected as detailed in step 1 or this 
section.   

 

Figure 72 - Thin Client Attributes 

http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
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6.2.2 Uploading Documents – Projectwise (Thick 
Client) 

The following shows how to upload Contract plans into the 100 Contract Plan folder in 
Projectwise, but this procedure can be followed for uploading documents into any folder in 
Projectwise.   
 

1. Select the Interface  “CTDOT_Doc_Code”  as shown below, if the interface box is not 
shown go to View>Toolbars and select interface. 

2. Drag and Drop files into the correct folder in the Project. 

 

Figure 73 - Uploading Into Projectwise (Thick Client) 
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3. Select the “Advanced Wizard” 
4. Click “Next” until you reach the figure below: 
5. Then assign the applicable attributes from the tables in Projectwise Attribute Table:  If 

you cannot assign attributes, the interface was not selected as detailed in step 1 or this 
section.   

 

 

Figure 74 - Attributing (Thick Client) 

6. On the Document Properties page nothing needs to be edited.   
7. On the create document page click next and the document will be uploaded into 

Projectwise.   
8. Once the document is uploaded the user may need to click F5 (refresh) to see the file 

name update.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
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6.3 PDF Checker – Contract Plans 
The Discipline Subset PDF Checker software was developed to check that Contract Plan 
Discipline Subsets are formatted and delivered to CTDOT correctly.  This checker replaces the 
old requirements of attaching the discipline subset checklist to each subset and stamping each 
subset with the green QA/QC stamp.  These two things are no longer required.  
 
This checker is an add-on to Projectwise Thick Client and can only be run using Projectwise Thick 
Client.  See Section 6.2.2 for the typical workflows for using the PDF Checker.  This section 
provides details for Projectwise Thin Client users.   
 
The following details what is checked with this software: 

(1) CAD Requirements have been completed correctly: 
a. Page Size (see Section 4.2) 
b. Searchable Text (see Section 4.2) 
c. Levels (see Section 4.2) 

(2) PDF post processing steps have been completed correctly: 
a. Page labels (see Section 4.14.2) 
b. Sheet numbers (see Section 4.14.2) 
c. Watermarks and flatten comments(see Section 5.4)  
d. Any digital signature fields (see Section 5.5) 
e. Digital Signature (see Section 5.6)       

(3) The subset was uploaded and attributed correctly in Projectwise. 
 
After the PDF checker is run, an Excel report is created detailing what is incorrect on each 
subset.  Things that are incorrect will show up red and include a note on what is incorrect.  Also 
an attribute in Projectwise call Format Compliance will be set to PASS or FAIL when a document 
is run through the checker: 

 

Figure 75 - Format Compliance Attribute 

 
The PDF checker must be ran on all discipline subsets that are submitted to CTDOT, which 
includes the following submittal types:  FDP, DCD, DCD2, ADP, ACD, or DCO submittals.   
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6.3.1 Installing the PDF Checker 

This is step is for consultants only, DOT staff already have the checker installed.  
1. Download the PDF checker executable from this link:  Discipline Subset PDF Checker 
2. Close Projectwise if it is open. 
3. Run the executable. 

6.3.2 Typical Workflow for using the PDF Checker 
CTDOT Designed Projects  
The following details the typical workflow for a CTDOT designed project. 

1. Each discipline prepares their subset(s) and uploads their unsigned subsets into 
Projectwise in accordance with this manual. 

2. Then the PDF Checker is run on the unsigned subset(s).   By running the checker on the 
unsigned subsets, any errors can be found before the Principal digitally signs.  Note:  An 
error will be returned that a signature was not found and the Projectwise attribute will 
show FAIL.  

3. If there are any other errors, other than the signature error, they shall be fixed.  If the 
only error in the report is the signature error, then the plans can be digitally signed by 
the principal.   

4. After the plans are digitally signed, run the PDF Checker again on the subset(s) to check 
the digital signature was applied correctly.  If there are no errors then the check is 
complete.  If there are any errors they shall be fixed and the PDF Checker rerun.     

5. The project lead should check in Projectwise that all subsets have PASS in the Format 
Compliance attribute column. 

6. The Processing unit will be looking for the Format Compliance attribute column to be 
set to PASS before they process the subset.  

 
Consultant Designed Projects 
The following details the typical workflow for a Consultant designed project: 

1. Each consultant prepares their subset(s) and uploads their subsets into Projectwise in 
accordance with this manual. 

2. Then the PDF Checker is run on the subset(s).  If the consultant or sub-consultant does 
not have Projectwise Thick Client, contact your CTDOT Consultant Liaison or the lead 
consultant on the project to run the PDF Checker on those discipline subsets.   Any error 
shall be fixed and the checker rerun until the report does not have any red errors. 

3. The CTDOT Consultant Liaison or the lead consultant should check in Projectwise that all 
subsets have PASS in the Format Compliance attribute column.    

4. The Processing unit will be looking for the Format Compliance attribute column to be 
set to PASS before they process the subset.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/discipline_subset_pdf_checker.zip
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6.3.3 Using the PDF Checker 
This software has the capability to check one subset at a time or multiple subsets.   The 
following shows how to check multiple discipline subsets, but the procedure is the same for 
checking one subset.  

1. Log into Projectwise. 
2. Browse out to your project and open the 100_Contract_Plans folder. 
3. Select a discipline subset(s) or all the subsets, right click and select DMSconform>PDF 

Check.  Hold control or shift to select multiple subsets.  

 

Figure 76 - Selecting the Subsets and Running the Checker 

4. Click OK on the dialog box shown below: 

 

Figure 77 - PDF Checker 
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5. After the PDF Checker runs click Yes Report on the dialog box shown below.  Note:  The 
PDF Checker may take a few minutes to process depending on the size of the files it is 
checking.  

 

Figure 78 - PDF Checker Report 

 
6. In the report, errors will show up in red and if you hover over a red piece of text it will 

show the details of what is incorrect.  If any false errors show up in the report, please 
notify DOT.AECApplications@ct.gov with the project and document(s) you are having 
issues with.  Example of false errors could be the page labels were applied to the subset 
but the report details they were not.   

   

 

Figure 79 - PDF Checker Report 

The Format Compliance attribute will also be set when the checker is run.  It will return a PASS 
or FAIL value as shown below: 

 

Figure 80 - Format Compliance Attribute 

7. If there are no errors in the report and all document have PASS in the Format 
Compliance attribute, this process is complete.  If there are errors, the errors shall be 
fixed and the checker rerun.   

mailto:DOT.AECApplications@ct.gov
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 Contract Plan and Special Section 7

Provision Revisions (Addenda and Design 

Initiated Change Order) 

7.1 Addenda 
Contract plans that are revised or added due to addenda shall be submitted in digitally signed 
PDF discipline subsets containing only the changed sheets.  The sheets being revised or deleted 
shall not be included in the Addenda submittal. The first sheet of each addendum subsets shall 
be digitally signed in a digital signature place holder, that is placed in Microstation as described 
in Section 5 of this manual. Addendum subsets DO NOT need an index of drawings sheet.   Once 
digitally signed, the addendum subsets shall be submitted to CTDOT using Projectwise, as 
described in Section 6 of this manual. 
 
Addenda sheets from different subsets cannot be combined and submitted as one subset, they 
must be submitted per their respected subsets.   
 
The discipline Addenda subsets shall be attributed as follows, when uploaded into Projectwise 
(See Section 6): The addenda subset shall have the same Projectwise label as the original final 
plan subset with the addition of (_A##) added to the end, where the ## equals the addenda 
number.  The sub-category attribute shall be ADP and ACD if the ADP plans are revised. See 
example below: 

 
PROJECTWISE LABEL ATTRIBUTE 
 

Original Discipline Subset:  04-Traffic 
  
Addenda Discipline Subset:  04-Traffic_A01 
2nd Addenda    04-Traffic_A02 
6th Addenda    04-Traffic_A06 

 
The contract sheets (previously submitted final plans or earlier addenda plans), being revised by 
addenda shall UNOT be modified except; the Engineer of Record shall place an addenda stamp on 
the affected sheets.  This addenda stamp crosses out the entire sheet with a red X and adds the 
following note; "THIS SHEET REPLACED BY ADDENDUM NO."Y"; where "Y" equals the addendum 
number. This stamp is placed over digital signatures therefore; removal of the signatures is not 
required prior to placing the addenda stamp.  For this process see Section 7.4.   
 
WARNING – When placing the stamps, removing the digital signature is not allowed.   
   
The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the 
project manager for all addenda, and submitted as described in Section 7.3.1.  A new subset 
must be updated for each addendum.   
 
A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for (Consultants) 
shall be placed on all added or revised sheets.  See Section 5.2 
 
Paper copies for all Addendums will be requested by the Department’s Contracts unit and sent 
to all applicable units following Section 3.2.12. 
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7.1.1 Revised Plans - Addenda 
Microstation Processes 
A note shall be placed, directly above the bottom right hand corner of the title block, on the 
replacement sheets stating “ADDENDUM NO. “Y”, where “Y” equals the addenda number.   This 
note is a level in Microstation that needs to be turned on and edited.  
 
For revised sheets the drawing numbers shall not be modified.  
 
The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be 
placed within this clouded area.  A like numbered triangle shall be placed in the revision block of 
the changed sheet, accompanied by a description of the revision itself. The revision number is 
specific to a particular sheet, and increases in consecutive order per revision and per addenda. If 
a sheet is changed for the first time under addenda five the revision number is 1 NOT 5. If it is 
changed again under addenda 7 the revision number becomes 2. 
 
Note: If there are a lot of changes to a sheet and it is not possible to cloud all the changes in a 
clear manner, do not void out the existing sheet and create a new sheet.  In these instances, 
the designer shall place a cloud just inside the border of the revised addendum sheet. 
 
Note:  When preparing an Addendum that will change quantities on a project that includes a 
"Detailed Estimate Sheet", never revise the "Detailed Estimate Sheet."  A "Detailed Estimate 
Sheet" is never included in an addendum.  Also, the "Quantities" box shown on the General 
Plan sheet for any structure is never to be revised. 
 
Bluebeam Processes 
Sheet numbers for revised plans shall be as follows: 
Original Final Plan Sheet; 
 
 Original:  02.25 
 Addenda 1:  02.25.A1 
Previous Addenda Sheet; 
  

Original:  02.25.A2  
Addenda 4:  02.25.A4 

 
If a sheet requires further revisions by a subsequent addendum, the addendum shall be 
prepared, as detailed above. The previously revised sheet shall now be stamped using Bluebeam 
after addendum approval, see Section 7.4.   
 

7.1.2 New Sheets - Addenda 
Microstation Processes 
Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one 
of two ways, as follows:  
  

1. If the new sheet does not have to be placed in a specific location within the discipline 
subset, the new sheet shall be placed last, and numbered sequentially from the last 
sheet of the discipline subset.  The total number of sheets noted on the project plans 
and discipline subsets stays the same.  A note shall be placed on the new sheet stating, 
"NEW SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals the addendum number.  
This note shall be located directly above the right hand corner of the title block.   This 
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note is a level in Microstation that needs to be turned on and edited.  The revision block 
on the added sheet, shall not be filled out. 

 
2. If the designer determines that the new sheet must go in a specific location within the 

discipline subset, the new sheet number shall be the number of the previous sheet 
followed by (-1.A#), where # is the Addendum Number.  For example, if the new sheet 
must be placed in a discipline subset right after sheet 02.57, the new sheet shall be 
numbered 02.57-1.A1, if an additional sheet needs to be added, in this case it would be 
02.57-2.A1.  The total number of sheets noted on the project plans stays the same.  A 
note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM 
NO."Y", where "Y" equals the addendum number.  This note shall be located directly 
above the right hand corner of the title block.  This note is a level in Microstation that 
needs to be turned on and edited.   

 
When adding a new sheet a new drawing number is also required. As with the sheet 
number the drawing number of the new sheet shall be the drawing number of the 
previous sheet plus a decimal and the sheet count.  For example, if the new drawing 
must be placed in the project plans right after drawing number S-5, the drawing number 
shall be S-5-1. 

 
Bluebeam Processes 
Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows: 

 
Original Final Plan Sheet; 
 
 Original:  04.31 
 Addenda 3:  04.31-1.A3 
 
Previous Addenda - Added Sheet; 
 
 Original:  03.24.A1 
 Addenda 4:  03.24-1.A4 
 
Previous Addenda - Revised Sheet; 
 

Original:  05.14-1.A1 
 Addenda 2:  05.14-1.A2 
 
Previous Addenda - Added Sheet; 
 

Original:  05.14-1.A1 
 Addenda 2:  05.14-2.A2 
 
If adding sheets to the end of a subset, the new sheet number shall be a continuation of the 
previous sheet number plus .A#, where # equals the addenda number. 
 
Original Final Plan Sheet; 
 
 Original Last Sheet:  04.31 
 Addenda 3:   04.32.A3 
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7.1.3 Adding New Subset – Addenda 
The new subset shall be submitted by an Addendum and be  prepared the same way as an FDP 
discipline subset, with the addition of an A# in the sheet numbers and a note shall be placed, 
directly above the right hand corner of the title block, on the sheets stating “ NEW SHEET 
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number.  This note is a level in 
Microstation that needs to be turned on and edited.  The label attribute on the new subset shall 
contain an “_A##”.   The first sheet of a new subset to the contract will be a subset cover sheet 
and contain an index of drawings.     

7.1.4 Voiding Sheets 
 
Sheets submitted within final design plan subsets and addenda subsets shall UNOT be deleted; 
but shall voided by the engineer of record with an addenda stamp, using Bluebeam. This 
addenda stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED 
BY ADDENDUM NO.”Y"; where "Y" equals the addendum number.  See Section 7.4   

7.1.5 Addenda Special provisions 
Contract Special provisions that are revised or added due to addenda shall be submitted digitally 
in accordance with Section 4.5 

7.1.6 Addendum CTDOT Standard Drawing Subsets 
The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance 
with the following. 
 
The Addendum for a standard subset shall only include the added sheets, do not include all the 
standards for the project.  Follow Section 4.4 to prepare the standard subset, only include the 
added sheets and check off only those sheets on the index sheets.  
 
When uploading to Projectwise, add an “A##” to the end of the label attribute.   
 
Update the 02-Revision subset to record this change.  

7.2 Design Initiated Change Order (DCO) 
 
Design Initiated Change Orders (DCO) are change order requests in which the designer alters the 
original contract by: 

 A revision to an existing plan sheet(s) or specification(s) 

 The addition of a new plan sheet(s) or specification(s) 

 The deletion of an existing plan sheet(s) or specification(s) 
 
The creation and management of DCO’s shall be as specified in this section. 
 
Contract plans changed or added due to DCO’s shall be submitted in a digitally signed PDF 
discipline subset(s) containing only the added or changed sheets. The sheets being revised or 
deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset 
shall be digitally signed in a digital signature place holder, that is placed in Microstation as 
described in Section 5 of this manual, DO NOT ADD a cover sheet. Once digitally signed the DCO 
subset(s) shall be submitted, to the CTDOT, using Projectwise as described in Section 6 of this 
manual. 
 
DCO sheets from different subsets cannot be combined and submitted as one subset.  
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The discipline DCO subsets shall be coded as follows, when uploaded into Projectwise (See 
Section 6): The DCO subset shall have the same Label Attribute as the original final plan subset 
with the addition of (_C###) added to the end, where the ### equals the DCO number.  The sub-
category attribute shall be DCO (Design Initiated Change Order) See Examples below: 

      
 
 
PROJECTWISE LABEL ATTRIBUTE 

Original Discipline Subset:  04-Traffic 
 
DCO Discipline Subset:   04-Traffic_C01 
6th DCO    04-Traffic_C06 

 
Original Addenda Subset:  04-Traffic_A03 
  
DCO Discipline Subset:   04-Traffic_C01 
3rd DCO      04-Traffic_C03 
 
    

The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being 
revised by DCO shall UNOT be modified except; the Engineer of record shall place a DCO stamp on 
the revised sheets using Adobe Acrobat.  This digital DCO stamp crosses out the entire sheet 
with a red X and adds the following note; "THIS SHEET REPLACED BY DESIGN INITATED CHANGE 
ORDER NO."Y" –mm/dd/yy; where "Y" equals the Design Initiated Change Order number. This 
stamp is placed over digital signatures therefore; removal of the signatures is not required prior 
to placing stamp.  For this process see Section 7.4  
 
WARNING – When placing the stamps, removing the digital signature is not allowed.   
 
The Index of Revisions Sheet(s) located in the 02-Revisions subset shall be updated by the 
project manager for all DCO, and submitted as described in Section 7.3.2.    
 
A watermark of the signer’s signature, signature only for (CTDOT), or PE Stamp for (Consultants) 
shall be placed on all DCO sheets.  See Section 6.2 
 
Paper copies for all change orders will be requested and sent to all applicable units’ following 
Section 3.2.12.   
 

7.2.1 Revised Sheets – DCO 
Microstation Processes 
A note shall be placed, directly above the right hand corner of the title block, on the 
replacement sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” 
equals the Design Initiated Change Order number.  This note is a level in Microstation that needs 
to be turned on and edited.   
 
The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be 
placed within this clouded area.  A like numbered triangle shall be placed in the revision block of 
the changed sheet, accompanied by a description of the revision itself.  The revision number is 
specific to a particular sheet, and increases in consecutive order per revision and per change to 
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the sheet. If a sheet is changed for the first time under addenda #5 then change for DCO #1 
revision number is 2 NOT 1. If it is changed again under DCO 2 the revision number becomes 3. 
 
Details shown on the original PDF, but no longer required, shall not be deleted on the revised 
PDF, but shall be crossed out.  Any details to be deleted shall be crossed out with an “X” on the 
revised sheet.   Engineering judgment must be used to produce clear and concise information 
for the contractor. 
 
If the number of changes to the sheet cannot be clouded in a clear and concise manner, the 
existing sheet should be voided in accordance with Section 7.2.4 and a new DCO sheet created 
in accordance with Section 7.2.2 
 
 
 
Bluebeam Processes 
Sheet numbers for revised plans shall be as follows: 
 
Original Final Plan Sheet; 
 
 Original:  02.25 
 DCO 1:  02.25.C1 
 
 
Previous Addenda Sheet; 
  

Original:  02.25.A2  
DCO 4:  02.25.C4 
 

 
Previous DCO Sheet; 
  

Original:  02.25.C2  
DCO 4:  02.25.C4 
 
 

Drawing numbers shall not be modified on revised sheets.  
 
Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp 
(Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section 
5 of this document.  

7.2.2 New Sheets – DCO 
Microstation Processes 
Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one 
of two ways, as follows:  
 

1. If the new sheet does not have to be placed in a specific location within a discipline 
subset, the new sheet shall be numbered sequentially from the last sheet of the 
discipline subset.  The total number of sheets noted on the project plans and discipline 
subsets stays the same.  A note shall be placed on the new sheet stating, “NEW SHEET 
ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” where “mm/dd/yy” 
equals the month, day and year the change order request was submitted.  This note 
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shall be located directly above the title block.  This note is a level in Microstation that 
needs to be turned on and edited.   
 

2. If the designer determines that the new sheet belongs in a specific location within a 
discipline subset, the new sheet number shall be the number of the sheet it most closely 
relates to followed by (-1.C#).  For example, if the new drawing should reside in the 03-
Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet 
shall be numbered 03.57-1.C#.   
 
The total number of sheets noted on the project plans stays the same.  A note shall be 
placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE 
ORDER NO. Y – mm/dd/yy” where “mm/dd/yy” equals the month, day and year the 
change order request was submitted.  This note shall be located directly above the 
bottom right hand corner of the title block.  This note is a level in Microstation that 
needs to be turned on and edited.   

 
When adding a new sheet a new drawing number is also required. The drawing number 
of the new sheet shall be the drawing number of the sheet it most closely relates to 
followed by (-#).  For example, if the new drawing must be placed in the project plans 
right after drawing number HWY-10, the drawing number shall be HWY-10-1. 

 
Bluebeam Processes 
Added sheet numbers, to a specific location, shall be as follows: 
 
Original Final Plan Sheet; 
 Original:  04.31 
 DCO 3:  04.31-1.C3 
 
Previous Addenda – Added Sheet; 
 Original:  03.24.A1   

DCO 4:  03.24-1.C4  
 

Previous DCO – Revised Sheet; 
Original:  02.45.C1 

 DCO 2:  02.45.C2  
Previous Addenda - Added Sheet; 

Original:  05.14-1A1   
 DCO 2:  05.14-2.C2  
 
Previous DCO – Added Sheet; 

Original:  02.45-1.C1  
DCO 2:   02.45-2.C2 

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the 
previous sheet number plus C#., where # equals the Design Initiated Change Order Request 
number. 
 
Original Final Sheet 
  
 Original Last Sheet: 04.35 
 DCO 4:   04.36.C4 
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7.2.3 New Subset – DCO 
The new subset shall be submitted by DCO and be prepared the same way as an FDP discipline 
subset, with the addition of an C# in the sheet numbers and a note shall be placed, directly 
above the right hand corner of the title block, on the replacement sheets stating “NEW SHEET 
ADDED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” equals the Design 
Initiated Change Order number.  This note is a level in Microstation that needs to be turned on 
and edited.  The label attribute shall contain “_C##”.  The first sheet of a new subset to the 
contract will be a subset cover sheet and contain an index of drawings.    

7.2.4 Voided Sheets 
Sheets submitted within final design plan subsets, addenda subsets, or design initiated change 
order subsets shall UNOT be deleted; but shall be voided by the engineer of record, with a DCO 
stamp using Adobe Acrobat or Bluebeam. This DCO stamp crosses out the entire sheet with a 
red X and adds the following note; "VOIDED BY DESIGN INTIATED CHANGE ORDER NO. Y – 
mm/dd/yy; where "Y" equals the Design Initiated Change Order number.  See Section 7.4  

7.2.5 DCO Special provisions  
Special provisions shall be created in accordance with the Departments policies and procedures 
for Contract Development.  The Engineer shall also combine all special provisions into (1) PDF 
document and upload that into the 110_Contract Special provisions (PDF) folder in Projectwise 
following Section 4.5 

7.2.6 DCO Memorandum from Designer to 
Construction 

A DCO Memorandum from the Designer to Construction shall be prepared for all change orders 
and include the following.  This memorandum shall not include any digitally signed DCO plans 
and/or DCO specifications.   The digitally signed DCO plans shall be uploaded into the 
100_Contract Plans folder in Projectwise and the DCO Specs. shall be uploaded into the 
110_Contract folder in Projectwise : 

 A detailed description and justifications of the changes requested. 

 Identify the funding source if known. 

 A listing of each new, revised, replaced and/or voided plan sheet(s). 

 A listing of each new, revised, replaced and/or voided special provision(s). 

 A list of the changes in the estimated quantities for the project (increase, decrease). The 
list should also include any item that is new to the project or any item that is deleted as 
a result of the revised work. Item numbers of items already in the project should be 
provided. Item numbers for items that are not currently in the contract should be 
provided if known.  

 The estimated increase in cost or credit associated with the change order request. 
 

The DCO Memorandum shall be submitted into Projectwise in accordance with Section 4.10 

7.2.7 DCO CTDOT Standard Sheet Subsets 
The designer shall prepare a DCO to a CTDOT Standard Drawing subset in accordance with the 
following. 
 
The DCO for a standard subset shall only include the added sheets, do not include all the 
standards for the project.  Follow Section 4.4 to prepare the standard subset, only include the 
added sheets and check off only those sheets on the index sheets.  
 

http://www.ct.gov/dot/cwp/view.asp?a=3886&q=459664
http://www.ct.gov/dot/cwp/view.asp?a=3886&q=459664
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When uploading to Projectwise add an “C##” to the end of the label attribute.   
 
Update the 02-Revision Subset to record this change.  

7.3 02-Revisions Subset 
The project manager is responsible for managing this subset.  The subset can be downloaded 
from these links: 

CTDOT Designed Projects - 02-Revisions Subset 
  Consultant Designed Projects -  02-Revisions_CE_Subset  
Each project has a 02-Revisions subset and this subset only contains the, “Index of Revisions 
Sheet(s)”.  These revision sheets are used for tracking all sheet changes due to addenda (ADP) 
and Design Initiated Change Order (DCO) with respect to the entire project.  The 02-Revisions 
subset starts out as an un-signed blank place holder in the project.  The figure below is an 
example of a blank 02-Revisions subset: 

 

Figure 81 - Blank 02-Revisions Subsets 

ADDENDA: 
When the project requires an Addendum, the Project Manager must record these changes on a 
NEW 02-Revisions_A## subset, where A## equals the Addendum ##.  New 02-Revisions subsets 
shall contain all previous Addendum information.  For example, Addendum 4 shall include all 
changes made from Addendums 1, 2, 3 and 4.   
 
Note: A New 02-Revisions subset is required for each addendum because there are times when 
multiple addendums are being submitted to processing for the same project.  An example of this 
is if Addendum 1 and Addendum 2 are submitted to processing at the same time, two 
addendum revision sheets must be submitted. 
 
DESIGN INITIATED CHANGE ORDER: 
When a project requires a Design Initiated Change Order (DCO), the following process shall be 
followed: 

http://www.ct.gov/dot/lib/dot/documents/aec/02-revisions_ctdot.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/02-revisions_ce.pdf
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For each DCO, the Project Manager shall AMMEND the 02-Revisions subset.  The 02-Revision 
subset shall always contain all previous Addendum information and the new DCO information.  
For example, when DCO #1 is prepared, the 02-Revisions subset shall include all Addendum 
information as well as the changes made for DCO #1. 
 
The following figures are an example of the “Index of Revisions Sheet(s)” completed up to 
Addendum #3:  

 

Figure 82 - Index of Revisions Sheet 

Detail A from figure 1 shows the information typed in for a change to the contract plans.  The 
project designer inputs the Addendum or DCO number, the sheet number, the date, a 
description of the change, the person who made the change, and checks the appropriate box 
for: new sheet added, revised sheet or deleted sheet.  

 

Figure 83 - Detail A 

Detail B from figure 1 shows the title block information.   
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Figure 84 - Detail B 

7.3.1 02_Revisions Subset Workflow - Addenda 
Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project 
Manager as follows: 

1. The user will export/download the latest 02-Revisions subset out of Projectwise to their 
local computer.   

2. With your digital signature USB key inserted within the USB, right click on the Signature 
Box and select Clear Signature as shown below, this is the first Addendum this step can 
be skipped since the subset will not have a signature on it:  

 
Figure 85 Clearing the Digital Signature 

 

3. Enter the information into form fields as described in Section 7.3.4.  

4. Add note “ADDENDUM NO. Y” in the bottom right hand corner of the sheet above the 
title block, where Y = the Addendum number.   

5. Add new revision sheet each time previous sheet becomes full.  Add note “NEW SHEET 
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number.  Follow section 
7.3.3 of this document.   

6. When finished sign using a certifying signature as shown in Section 5.6.2 

7. Upload the document into Projectwise. 

8. Attribute the subset:  Main Category = CON, Sub-Category = ADP, Label = 02-
Revisions_A## 

9. Make the document description 02-Revisions_A##. 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 7/2017 101 Version 4.02 
     

7.3.2 02_Revisions Subset Workflow - DCO 
The following workflow shall be used by the Project Manager for recording DCOs to the 02-
Revisions subset.  In this workflow the user edits the subset in Projectwise, they do not have to 
export the document out and submit a new subset: 

1. Check out the 02-Revisions subset from Projectwise. 

2. With your digital signature USB key inserted within the USB, right click on the Signature 
Box and select Clear Signature as shown below, this is the first Addendum this step can 
be skipped since the subset will not have a signature on it:  

 
Figure 86 Clearing the Digital Signature 

 

3. Enter the information into form fields as described in section 7.3.4.  

4. Edit the note above the title block with “DESIGN INITIATED CHANGE ORDER NO. Y - 
mm/dd/yy” 

5. If a new revisions sheet is added, add the note above the title block with “NEW SHEET 
ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” 

6. Resign the 02-Revision subset in accordance with Section 5.6.2 

7. In step 7 “Check In” the document into Projectwise 

7.3.3 Adding a New Revisions Sheet to the 
02_Revisions Subset 

1. Download a new “Index of Revisions sheet” from Section 7.3. 
2. Insert the new sheet into the existing 02-Revisions subset pdf.  Update the title block 

information and update the sheet accordingly.   

7.3.4 Filling Out Revision Index Sheet 
To fill out a form field simply click on the box and begin typing. The first column is the 
Addendum or Design Initiated Change Order. The second column is the revised or new sheet 
number. The third column is the date, followed by a brief description that is similar to the 
description on the actual sheet being revised. Finally click in the appropriate check box per row 
to describe the action taken, new sheet, revised sheet, or sheet deleted.  Note:  The Engineer is 
not required to input changes numerically by Sheet No.  If another changed sheet is added to an 
Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of 
Revisions Subset”.    
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Figure 87 Modifying the “Index of Revisions Subset” 

7.4 Placing Stamps on Affected Sheets – Revised, or 

Deleted Sheets 
A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that 
are affected by Addenda or Design Initiated Change Order. The stamp shall be placed using 
Bluebeam’s Stamp tools and can be found in the tool chest under the miscellaneous stamps or 
in Markup>Stamps as shown below:    
 

 

Figure 88 - Addendum and Change Order Stamp 

If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User 
Profile as shown in Appendix A.  If you do not have the stamp in the Markups>Stamp area, see 
Appendix A – Bluebeam Stamps   
 
WARNING – When placing the stamps, removing the digital signature is not allowed.   
XTable 4-1 below lists the notes that shall be used for addenda, construction order requests, and 
as built notes. These notes should be used in conjunction with the cross-out stamp.  
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The following shows how to apply the stamp to the sheet that needs to be crossed out for an 
Addendum or Change Order.   

1. Select the stamp from the Tool chest or Markup>Stamps and place it: 

 

Figure 89 - Addendum and Change Order Stamp 

2. After the stamp is placed a box will pop up.  Enter the applicable note from table 4-1 
below in all caps as shown below: 

 

Figure 90 - Enter Note for Addendum and Change Order Stamp 

Table 7-1 Modifications to Existing Sheets by Addendum, Construction Orders and As-Builts 

Addendum Notes Description of Use 

THIS SHEET REPLACED BY ADDENDUM NO. Y The revised sheet is considered to replace, in 
total, the original sheet. 

VOIDED BY ADDENDUM NO. Y Sheet is voided by Addendum. 

  

Design Initiated Change Order Notes Description of Use  

THIS SHEET REPLACED BY DESIGN INITIATED 
CHANGE ORDER NO. Y – mm/dd/yy 

Used for revisions to existing sheets. Changes 
must be noted only on the revised sheet.     

VOIDED BY DESIGN INITIATED CHANGE 

ORDER NO. Y – mm/dd/yy 

Use this for voiding of existing sheets. 
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3. The following shows a completed stamp. 

 

Figure 91 Typical Sheet Replaced by Addendum 1 

 

 

Figure 92 Typical Sheet Replaced by DCO 

 
 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 7/2017 105 Version 4.02 
     

 As-Built Comments - Final Plans Section 8

As stated in the CTDOT’s Construction Manual chapter 1-313 “Final Revisions of Plans and Cross 
Sections”, it is the responsibility of either the Contracting Engineers (Consultant Inspectors) or 
State Forces (Office of Construction) to perform final as-built revisions of Contract Plans.  As-
Built revisions shall be recorded in accordance with Chapter 1-313 of the Construction Manual, 
amended as follows: 

Final as-built revisions will be applied to the digitally signed PDF plans as a digital 
comment, using Adobe or Bluebeam’s commenting tools. Digital comments are placed 
over the top of the digital signature and its security, therefore, the original content of 
the PDF plans can never be altered. Because as-built comments are digital and placed 
over the top of the plans they are easily recognizable, searchable, and may be turned off 
if necessary. 

As-built comments shall be applied to the latest sheet, whether it’s the original, 
addenda, or construction order plans, located in ProjectWise within the project’s 
100_Contract Plans folder.  

If additional As-Built information has been created, (information that cannot be placed 
on the digitally signed contract plans), these sheets shall be combined by subset number 
and uploaded into the 100_Contract Plans folder in Projectwise.  

CAD drawings may be updated, at the discretion of each design office, to reflect any 
addenda, change orders, and as-built revisions for use in the future; however the 
original digitally signed as-built PDF plans shall not be replaced and shall be the PDF set 
for permanent records.  

8.1 As-Built Revisions (Digital Comments) Workflow 
Two methods for applying as-built revisions to the digital PDF plans are provided in the following 
sections; 5.1.1 and 5.1.2.  
 
The first method, Section 5.1.1 Post Construction, district staff shall record as-built revisions on 
their record set (paper copies) during construction. Once construction is completed these 
revisions shall then be applied as comments to the digital PDF per the workflow in section 8.1.1. 
 
The second method, using Section 5.1.2 Active As-Built, district staff shall record as-built 
revisions on their record set (paper copies), and shall apply them as comment to the final set of 
digital PDF plans on an intermittent bases, during construction. By using this method as-built 
information becomes available to all parties that have access to ProjectWise during the 
construction process, improving communication and transparency.  
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8.1.1 Post Construction As-Built 
 

As-Built Workflow 

 
Step Personnel  Task 

1 Chief Inspector Notify the Contracting Engineer or Designated District Staff that 
As-Builts can be applied to the Contract Plans. 

2 Contracting Engineer 
or District Staff 

Apply As-Built revisions to the Contract Plans in accordance 
with Section 8.3 

3 Contracting Engineer 
or District Staff 

Notify all applicable personnel list in the Section 8.4.2 that the 
As-Builts have been completed for this project. 

 

8.2 As-Built Markup of Contract Plans 

All as-built information will be placed using a few basic Bluebeam commenting tools.  These 
tools include text tools, line and arrow tools, and stamp tools (all other tools will still be 
available under the main toolbar).  These tools will be in the right-hand panel under “CTDOT As 
Built Tools” tool box when the CTDOT As-Builts Profile is selected (see CTDOT Bluebeam Profile): 

 

Figure 93 - As-Built Commenting Tools 
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8.3 Applying As-Built Comments to Contract Plans 

8.3.1 Before Using Bluebeam for As-Builts 
All CTDOT users are required to complete the steps in Appendix A prior to applying as-built 
revisions. By completing these steps as-built revisions will be standardized across the all 
CTDOT users.   These steps only need to be completed the first time using Bluebeam or when 
the user logs into a new computer. 

 Perform the initial login steps for Bluebeam.  Initial Log Into Bluebeam 

 Download the CTDOT Bluebeam profile.  Download CTDOT Bluebeam Profile 

 The user must have a ProjectWise login/password.  Contact Julie Annino if you do 

not have a Projectwise Username and Password. 

8.3.2 Opening the Contract Plans from Projectwise 
The contract plans are located in the 100_Contract_Plans folder of the project in Projectwise, as 
shown below: 

 

Figure 94 - Location of the Contract Plans in Projectwise 
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1. Login into Projectwise, then browse to the 100_Contract_Plans folder of the project you 

are working on.   

2. To open a document with Bluebeam right click on the document, and select “Open 

With” as shown below: 

 

Figure 95 - Open With Bluebeam 

3. Select the Bluebeam icon and check “Always use this program” and select OK.  The 

document will now be checked out of Projectwise and open with Bluebeam: 

 

Figure 96 - Open with Bluebeam 

Note:  Since we checked “Always use this program”, the next time you open a pdf in 
ProjectWise all you need to do is double click on the file. 
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4. After the As-Builts are applied to the contract plans click save in Bluebeam and then 

select “Check In” when a projectwise dialog box pops up.  If the document is not 

checked back into Projectwise the As-Builts will not be uploaded to Projectwise.   

8.3.3 Applying Digital As-Built Stamps 

8.3.3.1 Construction Started & Completed Dates 
The construction started and complete date stamps must be applied to the PDF title sheet, 
located in the 01_General subset, as stated below: 
   

1. Select the ”ConstructionStartedandCompletedDates”: stamp from the  “CTDOT As Built 

Tools” tool box and place it at a conspicuous location on the title sheet: 

 

Figure 97 - Construction Started and Completed Date Stamp 

2. Enter Start and end and click OK as shown below: 

 

Figure 98 - Entering the Dates for the Stamp 
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Below is an example of the placed stamp: 

 

Figure 99 - Placed Stamp 
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8.3.3.2 This Sheet Not Corrected Stamp 
This stamp must be placed on all PDF sheets that do not contain as-built revisions. Detail 
Estimate Sheets must never be revised; therefore, they always receive this stamp. 
 

1.  To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet, select 

that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand 

corner of the sheet, by clicking once. 

If the majority of the sheets do not contain as-built revisions it is easier to apply this note to 
every sheet included in plan set, including the as-built revised sheets, and then go back and 
remove it from the sheets that were corrected.  
 

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that 

stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner 

of the first sheet in the plan set: 

 

Figure 100 - Placing the "This Sheet Not Corrected Stamp" 
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2. Right click on the stamp that was placed and select “Apply to All Pages”: 

 

Figure 101 - Placing the Stamp on All Pages 

This will place the “THIS SHEET NOT CORRECTED” stamp on every plan sheet within the 
pdf set.   
 

NOTE:  You must go back and replace this note on the sheets that contain as-built revisions 
with the appropriate stamp.  
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8.3.3.3 This Sheet Corrected 
 
This stamp must be applied to all PDF sheets that contain as-built revisions.  
 

1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select that 

stamp from the CTDOT As-Built Tools tool box and place it in the lower right-hand 

corner of the sheet, by clicking once. 

If the majority of the sheets contain as-built revisions it is easier to apply this note to every 
sheet included in plan set, including sheets that do not contain as-built revisions, and then go 
back and replace it, with the appropriate stamp, on the sheets that were not corrected.  
 
 

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that stamp 

from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the 

first sheet in the plan set: 

2. NOTE:  You must go back and replace this note on the sheets that do not contain as-
built revisions with the “THIS SHEET NOT CORRECTED” stamp.  

 

8.3.4 Applying Digital As-Built Notes 
To place an as-built revision, simply select any of the provided tools located within the as-built 
tool box shown below and apply it to the document that is being as-built.   
 
 

 

Figure 102 - As-Built Tools 
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In the following example, the Line tool was used to cross out the existing text and the Text Box 
tool was used to add text:  

 

Figure 103 - As-Built Note Example 

 
 
 
Additional tools are available by selecting Markup: 

 

Figure 104 - Other Markup Tools 

These tools include: 

 

           A    B     C     D    E     F     G           H       I      J      K    L    M     N    O     P     Q     R 

List of Commenting Tools: 

A. Text – commonly used tool for as-builts 

B. Typewriter – Do Not Use for As-Builts – cannot edit text 

C. Note - Do Not Use for As-Builts – will not print 

D. Flag  

E. Pen 

F. Highlight 

G. Eraser - Do Not Use for As-Builts – cannot edit graphics 

H. Line– commonly used tool for as-builts 

I. Arrow– commonly used tool for as-builts 

J. Arc 

K. Polyline 

L. Callout– commonly used tool for as-builts 

M. Dimension  
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N. Box 

O. Circle 

P. Polygon 

Q. Cloud – Do Not Use for As-Builts - this may be confused with change orders or 
addendums 

R. Picture – Pictures can be inserted into a document or attached.  It is 
reccommended that pictures be attached  as not to obstruct any part of the pdf. 

Do not add a note to a comment by double clicking on the comment.  For example, if a line 
was placed the user could double click on the line and add notes to it: 

 

Figure 105 - Incorect Way to Add Text 

 If notes are added this way they do not print.  

8.3.4.1 Digital As-Built Stamps and Notes Using 
ADOBE 

The following stamp files need to be downloaded to the user’s computer and placed in this 
folder:  
C:\Documents and Settings\User\Application Data\Adobe\Acrobat\8.0\Stamps\.  This could be 
either C:\ or D:\ Drive depending on your computer. With the “User” folder being the current 
user’s login Username.  If Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous 
sentence, if version 10  is used replace with 10.   
Stamp Files 
As-Built stamps.pdf  
Construction started and completed dates.pdf 
 
These stamps are to be placed following Section 8.3 above. 
 
As-Built notes shall be placed on the plans in accordance with Section 8.3 using the Adobe 
commenting tools in the following format: 

1. Text Font shall be Cambria 16, and the color Red. 

2. All line work shall be line width 2 and the color Red. 

 

 

 

 

 

http://www.ct.gov/dot/lib/dot/documents/aec/as-builtstamps.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/constructionstartedandcompleteddates.pdf
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8.3.5 Additional As-Built Information  
Additional As-Built Information that cannot be applied to the contract plans can be uploaded to 
Projectwise for future use.  This information shall be uploaded to Projectwise in accordance with 
the following: 

 Combine the additional As-Built information into (1) PDF for each discipline subset.  
For example if the 03-Highway and the 04-Structures set had additional As-Built 
information, 2 separate PDFs would need to be uploaded to Projectwise.   

 After the additional As-Built information is combined into their respective files they 
will need to be uploaded and attributed into Projectwise in accordance with the 
following: 

a. Log into Projectwise Explorer. 
b. Make sure the Interface “CTDOT_Doc_Code” is selected. 
c. Drag and drop the PDF into the 100 Contract Plans folder in Projectwise. 
d. Select the advanced wizard. 
e. Click next until you get to the attributes page shown below and assign the 

following attributes: 

 Discipline = CT 

 Main Category = CON 

 Sub-Category = ASB 

 Label = Subset No. and name, for example for the 03-Highway set 
type 03-Highways. 

 Description = Additional As-Built information for…. 

 

Figure 106 - Additional As-Built Information 

f. Then click next until the document uploads.   
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8.3.6 Setting Documents to Final Status in 
Projectwise 

After the As-Builts are completed it is ready for permanent storage a final status will be applied 
to the document as shown below: 
 
Select all the files or one at a time and then right click and select Change State>Set Final Status.   

 

Figure 107 - Set Final Status 

This will lock the file so no one can delete it.  If a user needs to remove the final status contact 
DOT.AECApplications@ct.gov  
 

8.4 Notifications 

8.4.1 Notifying Department Personnel 
After the as-built information has been completed, the person responsible for the as-built 
revisions shall notify the appropriate Department personnel (via e-mail): 

 Lead Designer 

 Chief Inspector 

 Central Surveys 

 ROW 

 Central Construction 

 Bridge Maintenance (if a structure is on the project)  

 Mathew Calkins and Julie Annino – AEC Applications  Email Mathew Calkins 
and Julie Annino 

 

 

 

mailto:DOT.AECApplications@ct.gov
mailto:mathew.calkins@ct.gov;%20julie.annino@ct.gov?subject=As-Builts%20Completed
mailto:mathew.calkins@ct.gov;%20julie.annino@ct.gov?subject=As-Builts%20Completed
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 Contractor Submittals Section 9

9.1 Introduction 
This section provides information about the Bentley Portal and Projectwise Deliverables 
Management (PWDM).  These two Bentley products allow: (1) The contractor to deliver 
submittals to CTDOT for review and (2) Allow CTDOT to transmit documents to the contractor.  
These products provide Ball in Court functionality as well as automatic email notifications that 
remind users when a submittal review is due or if a submittal review is overdue.    
 
The following gives an overview of the parts of this system: 
 
Bentley Portal – The Bentley portal is a project web page that can be connected to a project 
folder in CTDOT’s Projectwise system.   CTDOT can then invite a contractor to connect to our 
project portal allowing them to submit files.   
 
Projectwise Deliverables Management (PWDM) – This is a Projectwise plug-in that installed on 
a user’s computer that creates a deliverables area in Projectwise.   When the plug-in is installed 
and a project is connected to the Bentley Portal, the following area can be found under the 
project folder in Projectwise: 
 

 

Figure 108 – Projectwise Deliverables Management 

 
 
 
 
 
 
 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 7/2017 119 Version 4.02 
     

Bentley CONNECTION Client – Software installed on a user’s computer that connects the 
Bentley portal to Projectwise.  Users have to log into the CONNECTION Client using a Bentley ID.  
If you do not have a Bentley ID contact Samantha.Scharpf@ct.gov    The CONNECTION Client can 
be found on the computer as shown below. 

 

Figure 109 - CONNECTION Client 

If a user does not log into the CONNECTION Client they will not see the Deliverables 
Management area under the project in Projectwise and/or will get the error shown below.  To 
fix this issue, log into the CONNECTION Client using your Bentley ID.    

 

Figure 110 - CONNECTION Client Error 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:Samantha.Scharpf@ct.gov
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9.2 Project Setup and Management 
Using the Bentley Portal and PWDM to manage submittals from the contractor requires some 
setup and administration.  AEC Applications will be responsible for the project setup and 
management throughout the project.  The following details the project setup process and what 
needs to be managed.   
Project Setup – Steps Performed by AEC Applications 

 Project created on the Bentley Portal 

 Project in Projectwise is connected to the corresponding project on the Bentley Portal. 

 Project team must be added to the project and there user permissions are assigned.   

 Document Classifications are created.  These classifications determine documents are 

stored in Projectwise.  The contractor is required to pick a classification when submitting 

to CTDOT.  Projects are setup with the following default classifications, but this can be 

adjusted per project: 

o Project Documents 

o Change Orders 

o Materials Testing 

o Miscellaneous Correspondence 

o RFCs 

o Schedules 

o Subcontractor Approval Requests 

o A Classification for each item number on the project. 

 Purposed are created.  These are things like For Approval, Traffic Items, Bridge Items, 

Highway Items, etc.  These are used by the Distribution Matrix to determine where 

submittals are sent and assigned.  

 Distribution Matrix is created.  This is used in conjunction with the purposes to make it 

easier for the contractor to send in documents to the correct reviewers.  An example of 

this is when a the contractor selects a purpose of Traffic Items, the Distribution matrix 

can be set up to forward that submittal to the Traffic Engineer without the contractor 

having to know or pick the correct person.  

Project Management – Steps Performed by AEC Applications 

 Manage project participates 

 Manage classifications 

 Manage the purposes 

 Manage Distribution Matrix 
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9.3 Shop Drawing Review 
This section details how the Designer will review a shop drawing submittal. 

1. Make sure you are logged into the CONNECTION Client as detailed in the Introduction of 

this document.   

2. Then open the email from noreply@ct.gov. 

 

Figure 111 - Email Notification 

3. Next in the email, click on the Projectwise link to go to the submittal package. 

 

Figure 112 - Submittal Email 
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4. Once in Projectwise click on the submittal package to open: 

 

Figure 113 - Submittal Package 

5. Next acknowledge the submittal.   

 

Figure 114 - Acknowledge a Submittal 
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6. After the submittal is acknowledged the files in the submittal documents will be 

uploaded into to Projectwise in a sub-folder under the 120_Contractor Submittals folder 

based on what classification was picked by the Contractor.   If the submittal needs to be 

forwarded to another user for review, follow section 9.5.  

 

If the submittal does not need to be sent to another user, the files can be reviewed.  To 

review the documents, go to the My Response tab in the submittal and right click on 

one of the documents in the submittal and select Go to Folder for Review: 

 

Figure 115 - Reviewing Documents in a Submittal 
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7. The files will be uploaded into an item subfolder under the 120_Contractor Submittals 

folder in Projectwise.  To review these drawings: 

a. Check Out a drawing from Projectwise. 

b. Then markup and stamp with the appropriate stamp: No Exceptions Noted, 

Exceptions as Noted or Revise and Resubmit.  The stamps are included in the 

CTDOT Bluebeam profile.  If you do not have the Bluebeam profile, the following 

link is for this profile.  Download the file and then double click on it to import 

the settings into Bluebeam:  CTDOT Contractor Submittal Review Stamps  

c. Save the file in Bluebeam and check it back into Projectwise  

 

Figure 116 - Shop Drawing Example 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/CTDOT_ShopWorking_Drawing_Review_Tools.zip
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8. After all the drawings have been stamped, the Engineer shall respond to the submittal.  

To respond to the submittal, left click on one of the documents in the submittal, then in 

the Deliverables Management tab and click on the Subject as shown below: 

 

Figure 117 - Responding to a Submittal 
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9. Next, after the submittal package opens up, go to the My Response tab.  Then click on 

each document one at a time and do the following steps: 

a. Select the response that matches the stamp that was placed on the sheet. 

b. Type a comment if necessary.  This is not a requirement. 

c. Re-attach the stamped file.  To do this browse out to 120 Contractor Submittal 

folder and select the appropriate file.  Each document in the submittal must be 

reattached before the response is sent.   

 

Figure 118 - Responding to a Submittal 

 
Note:  If the submittal was forwarded to another user for review, that person’s response would 
show up in the comment section.  The person responsible for responding back to the contractor 
shall review the additional reviewer’s comments and make sure they have attached the correct 
stamped drawings before sending the response back to the contractor.  
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10. After all the documents have been responded to and the stamped documents have 

been attached to the submittal, the response can be sent.  To do this click on Send 

Response.   

 

Figure 119 - Responding to a Submittal 

11. Then click on Send Response. 

 

Figure 120 - Responding to a Submittal 
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9.4 Working Drawing Review 
This section details how CTDOT will respond to a working drawing submittal. 

1. Make sure you are logged into the CONNECTION Client as detailed in the Introduction of 

this document.   

2. District Construction will receive and email from noreply@ct.gov when a new submittal 

has been received.  The first step is to open the email.   

 
Figure 121 - Email Notification 

3. Next in the email, click on the Projectwise link to go to the submittal package.  Do not 

click on the other  

 

Figure 122 - Submittal Email 

 
 
 
 
 
 
 
 
 
 
 

mailto:noreply@ct.gov


 Connecticut Department of Transportation – Digital Project Development Manual

Issued 7/2017 129 Version 4.02 
     

4. Once in Projectwise click on the submittal package to open: 

 

Figure 123 - Submittal Package 

5. Next acknowledge the submittal.   

 

Figure 124 - Acknowledge a Submittal 

6. After the submittal is acknowledged the files in the submittal documents will be 

uploaded into to Projectwise.   If the submittal needs to be reviewed by a Designer, 

follow section 9.5 to forward the submittal to the appropriate person.  If the submittal 

only needs to be reviewed by District Construction follow section 9.4.2. 
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9.4.1 Working Drawing – Designer Review 
1. The Designer will receive an email stating their review is required for a working drawing 

submittal.  Click on the link in the email to view the submittal. 

2. Next open the submittal envelope and go to the My Response tab.  Then right click on 

one of the documents to review. 

 

Figure 125 - Reviewing Documents 
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3. The files will be uploaded into an item subfolder under the 120_Contractor Submittals 

folder in Projectwise.  The example shown below has 2 documents for the 36’ Steel Span 

Pole.  To review these documents: 

a. Check Out the document from Projectwise 

b. Then markup and stamp with the Designer Response stamp: Reviewed, No 

Comments or Reviewed with Comments.  This stamp is included in the CTDOT 

Bluebeam profile.  If you do not have the Bluebeam profile, the following link is 

for this profile.  Download the file and then double click on it to import the 

settings into Bluebeam:  CTDOT Contractor Submittal Review Stamps 

c. Save the file in Bluebeam and check it back into Projectwise  

 

Figure 126 - Responses to Submittals 

4. The designer will then create a response memo using this document as a template:  

http://www.ct.gov/dot/lib/dot/documents/aec/workingdrawing.pdf   This response 

memo shall then be uploaded into the same subfolder under the 120_Contractor 

Submittals as the submittal     

5. Then go back to the submittal area in Projectwise and open the submittal.   

6. Then go to the My Response tab and assign the applicable Response from the dropdown 

and attach the response memo that was stored in the 120_Contractor Submittal Area. 

7. Then click Send Response.  This will send the response back to District Construction.  

 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/CTDOT_ShopWorking_Drawing_Review_Tools.zip
http://www.ct.gov/dot/lib/dot/documents/aec/workingdrawing.pdf
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9.4.2 Working Drawing – Processing a Designer 
Reviewed Submittal 

12. After the designer has reviewed the submittal, District Construction will receive and 

email stating the addition reviewers have responded.  Click on the Projectwise link in 

this email to view the response: 

 

Figure 127 - Designer's Response 

13. Once in Projectwise click on the link to open the submittal: 

 

Figure 128 - Designer's Comments 
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14. The designer’s comments will be located under the My response tab and show up when 

a document is selected.   

 

Figure 129 - Designer's Comments 
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15. To respond to the contractor, District Construction is required to do the following 

things: 

a. Review the designer’s comments.  These comments can be located on the 

submittal documents and in the response memo. 

b. Stamp each document with the Action Stamp. 

c. Create a response document to send back to the contractor. 

d. Respond back to the contractor sending them the stamped documents and the 

response letter created by the District.   

The following will go through those steps. 

16. District Construction shall stamp the drawings No Exceptions Noted, Exceptions As 

Noted, or Revise and Resubmit on all the documents in a Working drawings submittal.  

To do this go to the my response tab in the submittal and right click on one of the 

documents in the submittal and select Go to Folder for Review: 

 

Figure 130 - Reviewing Documents in a Submittal 
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17. The files will be uploaded into an item subfolder under the 120_Contractor Submittals 

folder in Projectwise.  The example shown below has 2 documents for the 36’ Steel Span 

Pole.  To review these documents: 

d. Check Out the document from Projectwise 

e. Then markup and stamp with the District Response stamp: No Exceptions 

Noted, Exceptions as Noted or Revise and Resubmit.  This stamp is included in 

the CTDOT Bluebeam profile.  If you do not have the Bluebeam profile, the 

following link is for this profile.  Download the file and then double click on it to 

import the settings into Bluebeam:  CTDOT Contractor Submittal Review Stamps 

f. Save the file in Bluebeam and check it back into Projectwise  

 

Figure 131 - Responses to Submittals 

18. Next District Construction shall create a response letter to send back to the contractor.  
This letter shall be created and processed using existing business processes.  After the 
letter is approved to send back to the contractor, upload it into the same subfolder 
under the 120_Contractor Submittals folder that the submittal documents are stored in.  
The response letter must be stored in Projectwise in order for it to be attached to the 
response back to the contractor.   

 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/CTDOT_ShopWorking_Drawing_Review_Tools.zip
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19. After all the documents have been stamped and the response letter has been approved, 

District Construction shall respond to the submittal.  To respond to the submittal, left 

click on one of the documents in the submittal, then in the Deliverables Management 

tab and click on the Subject as shown below.  This will open up the submittal envelop to 

respond to the submittal. 

 

Figure 132 - Responding to a Submittal 
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20. On the My response tab, select a document, select the appropriate response, and then 

delete the comments in the comment box that came over from the designer.  This 

comment automatically gets added when the Designer added their comments and 

should not be sent back to the contractor. 

 

 Figure 133 - District Response to a Working Drawing Submittal  
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21. Also delete any documents that were attached by the designer.  District Construction 

will attach the response letter they created and send it back to the contractor. 

 

Figure 134 - Deleting a Document from a Submittal 
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22. Next District Construction must attach the stamped drawings and the response letter 
back to the contractor.  This response letter must be stored in Projectwise and shall be 
stored in the same subfolder under the 120_Contractor Submittals folder that the 
submittal documents are stored in.  The figure below shows the stamped drawings and 
response letter attached.  Note:  The stamped calculations are attached to the 
calculations file. 

 

Figure 135 - Responding to the Contractor 
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23. Once all the drawings are attached, click send responses. 

 

Figure 136 - Sending a Response Back to Contractor 
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9.4.3 Working Drawings – District Construction 
Only Review 

1. District Construction shall stamp the drawings No Exceptions Noted, Exceptions As 

Noted, or Revise and Resubmit on all the documents in a Working drawings submittal.  

To do this go to the my response tab in the submittal and right click on one of the 

documents in the submittal and select Go to Folder for Review: 

 

Figure 137 - Reviewing Documents in a Submittal 
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2. The files will be uploaded into an item subfolder under the 120_Contractor Submittals 

folder in Projectwise.  The example shown below has 2 documents for the 36’ Steel Span 

Pole.  To review these documents: 

a. Check Out the document from Projectwise 

b. Then markup and stamp with the District Response stamp: No Exceptions 

Noted, Exceptions as Noted or Revise and Resubmit.  This stamp is included in 

the CTDOT Bluebeam profile.  If you do not have the Bluebeam profile, the 

following link is for this profile.  Download the file and then double click on it to 

import the settings into Bluebeam:  CTDOT Contractor Submittal Review Stamps 

c. Save the file in Bluebeam and check it back into Projectwise  

 

Figure 138 - Responses to Submittals 

 
 

3. Next District Construction shall create a response letter to send back to the contractor.  
This letter shall be created and processed using existing business processes.  After the 
letter is approved to send back to the contractor, upload it into the same subfolder 
under the 120_Contractor Submittals folder that the submittal documents are stored in.  
The response letter must be stored in Projectwise in order for it to be attached to the 
response back to the contractor.   

 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/CTDOT_ShopWorking_Drawing_Review_Tools.zip
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4. After all the documents have been stamped, District Construction shall respond to the 

submittal.  To respond to the submittal, left click on one of the documents in the 

submittal, then in the Deliverables Management tab and click on the Subject as shown 

below: 

 

Figure 139 - Responding to a Submittal 
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5. Next District Construction must attach the stamped drawings and the response letter 
back to the contractor.  This response letter must be stored in Projectwise and shall be 
stored in the same subfolder under the 120_Contractor Submittals folder that the 
submittal documents are stored in.  The figure below shows the stamped drawings and 
response letter attached.  Note:  The stamped calculations are attached to the 
calculations file. 

 

Figure 140 - Responding to the Contractor 
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6. Once all the drawings are attached, click send responses. 

 

Figure 141 - Sending a Response Back to Contractor 
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9.5 Forwarding a Submittal to an Additional Reviewer 
 

1. If a submittal requires an additional reviewer, the submittal shall be forwarded 

as shown below: 

To forward a submittal to a designer click on the My response tab, highlight all the 

documents, and then click Add Reviewers. 

 

Figure 142 - Forwarding Submittal to Designer 
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2. Select the name of the designer to forward the submittal to and click add selected. 

 

Figure 143 - Adding Designer 

3. Then set a due date, add a comment if necessary, and click Send Request. 

 

Figure 144 - Sending Submittal to Designer 
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9.6 RFIs 
PWDM has a separate module for processing RFIs that is similar to Shop and Working drawing 
procedure but there are a few differences.   
 

1. Make sure you are logged into the CONNECTION Client as detailed in the Introduction of 

this document.   

2. District Construction will receive and email from noreply@ct.gov when an RFI has been 

received.  The first step is to open the email.   

3. Then click on the Projectwise link in the email to view the RFI 

 

Figure 145 - Link to Projectwise 
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4. Then open up the RFI submittal in Projectwise and Acknowledge the RFI. 
 

 

Figure 146 - Acknowledge the RFI 
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5. Then go to the Response tab.  If you can respond to the RFI yourself, type a response in 
and attach any necessary documents.  Note:  Any document that is to be sent back to 
the contractor needs to be uploaded into Projectwise.  RFI responses documents shall 
be uploaded into the appropriate subfolder under the 120_Contractor Submittals folder 
in Projectwise.     

 

Figure 147 - RFI Response 
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6. If the RFI was sent to an additional reviewer once the additional reviewer responds to 
the RFI, district construction will be notified.  Then they can review the response before 
it gets sent back to the Contractor.  Once the response has been approved by district 
construction they can send the response back as shown below: 

 

Figure 148 - RFI Response 

Note:  After the response is sent the contractor can either accept or reject the response.  If the 
response is rejected a notification will be sent to district construction starting a new review 
cycle.  Also if a response was accepted a notification will be sent to district construction.   
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9.7 Sending a Transmittal 
1. Right Click on Outgoing and select New Transmittal: 

 

Figure 149 - New Transmittal 
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2. Next on the General Tab, type a subject, select a purpose, type in a comment if 

necessary, and select a classification. 

 

Figure 150 - General Tab 
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3. On the Recipients Tab, click add recipients, select the recipients and click OK. 

 

Figure 151 - Recipient Tab 
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4. On the Documents tab, click Add: 

 

Figure 152 - Documents Tab 
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5. Browse out to the correct folder and select the documents to attach.  If you need to 

attach documents from more than one folder you will need to repeat this process for 

each folder. 

 

Figure 153 - Adding Documents to a Transmittal 
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6. On the scheduling tab set an Acknowledgement due date and Response due date.   The 

Acknowledgement due date should be 2 days and the response due date depends on 

the type of transmittal.  Information only transmittals do not require a response, so a 

response due date is not required.   

 

Figure 154 - Scheduling Tab 
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7. To issue the Transmittal select Issue and then click Yes on the dialog box that pops up. 

Depending on how many documents are included in the transmittal, this may take a 

minute or two for the transmittal to be issued. 

 

Figure 155 - Issuing a Transmittal 

8. Then click Confirm on the Issue Dialog Box.  Again this may take a minute or two 

depending on how many documents are being transmitted. 

 

Figure 156 - Sending a Transmittal 
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9.  Once the transmittal is issued you will see it in the list as shown below: 

 

Figure 157 - Sending a Transmittal 
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 Digital Review and Commenting Section 10

This section details the digital review process using Bluebeam’s collaborative online review tool 
called “Studio”.  The procedures outlined below describe how to:  1) Create a review session, 2) 
Invite people to a session, 3) Join a session, 4)  Comment in a session, 5)  Close the session, and 
6) Respond to comments made in the session. Also, directions for locking the documents after 
the review process to create a read-only final record copy to be stored for future use are also 
provided. 
 
The following link in to a Bluebeam Resources website.  On this website are videos for the Digital 
Review process: Bluebeam Resources  These videos show an overview, but specific details are 
found in this document  

10.1 Introduction 
A digital review is when a document is reviewed in its native digital format or as a digital copy of 
the original paper document.  Any required markups are placed directly on the document using 
a computer with software designed for managing digital reviews.  The documents can also be 
printed from the review session and the paper copy marked up; however, those markups must 
get transferred back to the digital copy.   
Advantages of a Digital Review Compared to Conventional Paper Review 

1. Higher Transparency – Increased Collaboration. 
2. Digital markups are searchable and sortable, by comment, author, etc. 
3. Real time collaboration review process improves turnaround time and quality of the 

review. 
4. Real time feedback allows easier handling of large amounts of data. 
5. Reduces the time required to compile and resolve comments.  
6. Eliminates document mailing time.  
7. Reduces document printing. 
8. Eliminates shipping cost. 
9. Easily store a permanent digital record on the cloud. 
10. Overall reduction in review time. 

 
Types of Reviews: 
This manual may be used as a guide to perform a digital document review on any digital 
document. Below is a list of examples of the types of documents that may be reviewed: 

 Preliminary Design Plans 

 Structure Type Studies 

 Semi-Final Plans 

 Final Plans for Review 

 Special provisions 

 Engineering Reports 
Review Process: 
To help participants of a digital review more easily track the digital review process it has been 
split up into six Phases as listed below: 

 Phase 1 – Preparation of the Digital Documents  

 Phase 2 – Set Up Digital Review 

 Phase 3 – Invite Attendees to Review 

 Phase 4 – Digital Review 

 Phase 5 – Ending the Digital Review 

 Phase 6 – Resolve Comments 
Each phase and its required steps will be discussed later in detail. 

http://www.ct.gov/dot/cwp/view.asp?a=3194&Q=575834&PM=1
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Digital Comments: 
In this review process, all comments must be applied to the documents in the review session.  
Reviewers have the ability to print the digital review documents to paper and mark them up, 
however, when done, all must be transferred from paper to the digital documents, see Section 
10.7.3.  If a unit cannot print their own paper copies they should contact MaryAnn Cass by email 
MaryAnn.Cass@ct.gov.  In the email include the project number and list documents that need to 
be printed, and include the address of where they are to be mailed.  In the case of preliminary 
contract plan reviews, the original digital documents, with comments, will become the final 
record.   
 
All comments associated with a design submission should be applied to the digital documents.  
Telephone of email comments must be applied to the correct digital document by the staff 
member who received them.  Be sure to use engineering judgment to determine the most 
appropriate location for the comments in the document.  General project comments can be 
placed on the first sheet of the document using the note markup tool in Bluebeam. This process 
is detailed in Section 10.7.3.  If any outside entities (railroads or utilities) will not participate in 
the digital review, their comments with your responses should be attached to the final record 
copy in accordance with Section 10.7.3.  It is not necessary to transpose these comments 
individually as all comments can be attached at one time.    
 
FOI Requests 
Contract Document Digital Reviews - After a digital review session has been completed and all 
the comments have been resolved, a read-only copy of the review documents with the 
comments and resolutions will be stored in the 310_Milestone_Submissions folder under the 
project.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:MaryAnn.Cass@ct.gov
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10.2 Prerequisites 
1. CTDOT has standardized its digital review process using the document format PDF, and 

the software Bluebeam.   This software was chosen for the following reasons: 
a. Includes a collaborative live review feature (STUDIO) with real time feedback, 

enabling all reviewers to comment on the same document at the same time out 
on the cloud.     

b. A license for Bluebeam is more cost effective than competitive software like 
Adobe Acrobat.  Thus it is much less expensive to purchase and maintain.  

c. Only the Organizer of the review is required to have a licensed copy of 
Bluebeam. All other attendees can participate in the digital review using 
Bluebeam’s free version, Bluebeam VU. 

d. Bluebeam is integrated with ProjectWise. This simplifies the delivery of the 
original review documents as well as saves the final reviewed copies and their 
comments. 

2. The following table lists the software required to organize and/or participate in a CTDOT 
digital review.  Note:  It is recommended that the latest version of the software be used.  

Role Software 
Organizer – Manages review Bluebeam  Extreme or Revu Standard  and Projectwise Explorer 

Author – Produces documents Projectwise Explorer  

Reviewer – Reviews documents Bluebeam  Extreme or Revu Standard or Bluebeam VU* 
*Bluebeam VU is a free viewer that allows reviewers to participate in a digital review (NOT create/organize a review).  
When a staff or consultant is invited to a digital review and they do not have Bluebeam VU or a licensed copy of 
Bluebeam Revu Standard installed on their computer, a link to download Bluebeam VU will be included with the 
invitation.  Note:  An IT administrator may have to install this software on the computer.  

3. All CTDOT digital review participants are required to complete the steps provided in 
Appendix A prior to organizing or joining a review session.  Completing these steps will 
standardize the Bluebeam format across all CTDOT digital reviews.     
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10.3 Digital Review Workflow 

 

Figure 158 

All CTDOT digital review participants are required to complete the steps provided in Appendix 
A prior to organizing or joining a review session.  Completing these steps will standardize the 
Bluebeam format across all CTDOT digital reviews.     
 
Roles 
Organizer – The organizer sets up and coordinates the review session.  For in-house projects this 
would be the project lead and for consultant jobs this will be the Consultant Liaison.  
Author – Group that produces a document(s) for the review. 
Reviewer – Group that participates in the review session to review documents.   
 

Step Role Task Section  

Phase 1 – Preparation and Delivery of the Digital Documents 
1.1 Organizer Coordinate the organization and preparation of the review 

documents.  Request all Authors to upload their review 
documents into Projectwise. 

Section 10.4 

1.2 Author Prepare and upload review documents into Projectwise.  
Notify the Organizer that this step has been completed.   

Section 10.4 

1.3 Organizer Check that all review documents have been prepared and 
uploaded correctly into Projectwise. 

Section 10.4 

Phase 2 – Set up Digital Review 
2.1 Organizer Start a Bluebeam review session and then change the state 

of the review documents in Projectwise to “Reviewing”. 
Section 10.5 

Phase 3 – Invitation to Review  
3.1 Organizer Create a Digital Review memo, which includes a link to the 

digital review session, and send it to all Reviewers. 
Section 10.6 

Phase 4 – Digital Review 

4.1 Reviewer Join the review session by clicking on the link provided in the 
review memo.  Become familiar with the review session 
layout.   

Section 10.7.1 
and Section 
10.7.2 

4.2 Reviewer Set Status to “Reviewing” Section 10.7.3 

4.3 Reviewer  Review the documents in the Bluebeam review session and 
place comments on documents as necessary.   Documents 
can be printed, marked up, and then comments transferred 
the PDFs.  If the documents cannot be printed out, send a 
request to engineering records.  

Section 10.7.3 

4.4 Reviewer When finished reviewing, in Bluebeam, Set Status to 
“Finished”  

Section 10.7.3 

4.5 Reviewer Send a Review Comment Memo to the Review Organizer Section 10.7.3 
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Phase 5– Closing the Digital Review 

5.1 Organizer Close the Bluebeam review session and check the 
documents back into Projectwise. 

Section 10.8 

Phase 6 – Resolve Comments 
6.1 Organizer Notify the Authors that they can review the markups on 

their review documents in Projectwise.  Provide them with a 
link to the folder in Projectwise.  

Section 10.9.1 

6.2 Author Open the specific document(s) from Projectwise.   Section 10.9.2 

6.3 Author For each comment on your document, type a final 
resolution.   

Section 10.9.2 

6.4 Author After all resolutions are applied to comments, Notify the 
Organizer that you applied your resolutions.   

 

6.5 Organizer Change the state of the review documents to “Review 
Complete” to make all review documents read only after the 
resolutions have been applied.    

Section 10.10 

6.6 Organizer Send out a Completion of Review Session Memo to all the 
personnel associated with the review session that the all 
comments have been resolved on the documents located in 
Projectwise.   

Section 10.10 

10.4 Phase 1 – Digital Document Preparation 

10.4.1 Organization 

Below are the guidelines by which the review documents should be organized: 

Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 

1. Plans - Must be in discipline subsets.  The review Organizer is responsible for assigning 
each Author a subset number in accordance with Section 4.1 Note:  CTDOT Standard 
Subsets cannot be added to a review session because they are combined in a PDF 
Package (Portfolio).  

2. Special provisions – Each discipline shall combine all of their special provisions into one 
(1) PDF document.  Each discipline’s special provisions will remain separate throughout 
the review session; they will not be combined with the other discipline’s special 
provisions.      

3. Other Documents – Shall be individual PDF documents. 
4. All Authors must upload their documents into the 310_Milestone_Submissions folder 

under the project in Projectwise.  
Other Reviews 

1. The only requirement for the organization of other types of reviews is that the 
documents must be in PDF format.   

10.4.2 Preparation and Format 
Authors shall prepare their digital documents in accordance with the following guidelines: 
Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 

1. Plans: 
a. Must be in PDF format 
b. Plans must be in discipline subsets 
c. Plans must be sized 34” x 22” 
d. Do not need watermarks, sheet numbers or to be digitally signed. 

2. Special provisions: 
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a. Each discipline shall combine all of their special provisions for review into one 
(1) PDF document. 

b. Sized 8.5” x 11” 
3. Other Documents: 

a. Must be in PDF Format 

Other Reviews 

1. Documents: 
a. Must be in PDF Format 

10.4.3 Uploading Digital Documents 
Authors shall upload their digital documents into Projectwise in accordance with the following: 
For Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 

1. Launch Projectwise and log in. 
2. Browse out to the project this review is for and open up the 

310_Milestone_Submissions folder and the specific review folder:  If the three 
subfolders are not in the project contact Mathew.Calkins@ct.gov  

 

Figure 159 - Projectwise Project 

 
 
 
 
 
 
 
 
 
 

mailto:Mathew.Calkins@ct.gov
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3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a 
time into Projectwise as shown below:   

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface.  Then 
you will be able to select the correct Interface.  

 

Figure 160 - Uploading Documents into Projectwise 

4. Select Advanced Wizard 

 

Figure 161 - Advanced Wizard 
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5. Click next until the attributes screen appears as shown below.  Enter the correct 
attributes from Table 2 below, and then click next until the document uploads.   

 

Figure 162 - Attributing a Document 

The Label attribute must start out with 30%, 60%, 90%, or 100% where applicable.  This allows 
for the documents to be sorted together in Projectwise.  Below are some examples: 
 

 Document Attributes 

Document Disc. Main 
Category 

Sub 
Category 

Label Description 

Discipline 
Subsets 

CT CON PRE 
30% - 01-General, 30% - 03-Highways, etc. 
60% - 01-General, 60% - 03-Highways, etc. 
90% - 01-General, 90% - 03-Highways, etc 

01-General Semi Final Plans… 

Specification CT CON PRE 
30% - HWY- Specs, 30% - SB-Specs 
60% - HWY- Specs, 60% - SB-Specs 

Highway Semi Final Specs,  

PD Statement CT REPORT Reports  30% - PD Statement Preliminary Design Statement 

Cost Estimate CT CALCS Estimates 90% - Cost PD Cost Estimate 

Bike 
Assessment 

CT ANALYSIS Analysis 30% - Bike Assessment i.e.  PD Bike Assessment 

Calendar Day 
Est. 

CT CALCS Estimates 90% - Calendar Day i.e. SF Calendar Day Esitmate 

Table 2 - Projectwise Document Attributes 
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For Other Reviews 

1. Launch Projectwise and log in. 
2. Browse to the folder where the digital documents are to be stored. 
3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a 

time into Projectwise as shown below:   

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface.  Then 
you will be able to select the correct Interface.  

 

 

Figure 163 - Uploading Documents into Projectwise 

4. Select Advanced Wizard 

 

Figure 164 - Advanced Wizard 
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5. Click Next until the attribute screen appears shown below. Enter the correct attributes 
for the review documents and then click next until the document uploads.   Make sure a 
good label and description are entered.   

 

Figure 165 - Uploading Documents 

6. Notify the Organizer that the documents have been uploaded into Projectwise. 
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10.5 Phase 2 – Set Up Digital Review 
The Organizer shall set up the review session in accordance with the following:  Note: The 
example below is for initiating a Semi-Final review but can be followed for other types of 
reviews.     

1. Launch Projectwise Explorer from the shortcut on your desktop or the start menu.   
2. Browse out to the project’s 310_Milestone Submissions folder. (For other reviews 

browse out to the folder in Projectwise where the documents are located.  Note:  The 
document does not need to be in Projectwise to use Bluebeam’s Studio feature.)  

 

Figure 166 - Preliminary Design Documents Folder 
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3. Next select all the documents that are to be included in the studio session, right click, 
and select Start Studio Session: 

 

Figure 167 - Start Studio Session 
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4. Using the naming guidelines from the table below, type in the applicable review session 
name in the box entitled “Session Name”. 

Review Review Name 

Preliminary Design (30%) Project #XXXX-XXXX PD Review 

Structure Type Study Project #XXXX-XXXX Structure Type Study Review 

Semi-Final (60%) Project #XXXX-XXXX SF Review 

Final Plans for Review (90%) Project #XXXX-XXXX FPFR Review 

Other Include Project number if necessary and give a good description 
of the review 

 
Also, as shown in the figure below, make sure that all the options are checked.  Note:  Setting 
the Session Expires date is optional.  If set, this date can always be changed after the session is 
created.  
 

 
 

Figure 168 – Initiating a Review Session  
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5. In the next dialog box click copy invitation as shown below.  The invitation will be copied 
to the clipboard of the computer and then can be pasted into an email or memo.   

 

 

Figure 169 - Adding Email Address to Studio Session 

Next paste the invitation into a blank Word Document or email.  The following is an invitation 
that has been pasted into an email.  Note how the session URL appears in blue. Then you can 
copy the URL from the blank document or email into a formal memo.  

 

Figure 170 - Session URL 
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6. After the session has been created go back to Projectwise, Select all the documents that 
are included in the session. 

 

Figure 171 - Select Documents to be Included in Bluebeam Review Session 

7. Then change the state of the documents to “REVIEWING” as shown below: 

 

Figure 172 - Changing the State to Reviewing 

Then click OK next on the box that pops up.  The documents will now be in the 
Reviewing state. 

 

Figure 173 - State of Documents 
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10.6 Phase 3 – Invitation to Review Session 
The Organizer shall invite Reviewers to the review session in accordance with the following: 
For Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 
 
The invitation to the digital review will be a PDF version of a review memorandum that includes 
the following:   

1. A table of all documents that are in the review session.  
2. Links to relevant documents that are not included in the review session but still need to 

be referenced.  These documents shall be located in Projectwise and Projectwise links 
shall be included. (Not shown in the example below) 

3. A link to this manual (Digital Project Development Manual) 
4. A link to the Review session.  To do this, paste the invitation that was copied when you 

created the review session.     

The PDF of the review memorandum shall be emailed to all Reviewers; this should include the 
Principal, Supervisor and TE3 level of the reviewing unit where applicable.  It is the Organizer’s 
responsibility to compile a complete distribution list so the review invitation gets sent to the 
applicable personnel.   Below is an example of a memorandum for a preliminary design review: 
 

 

Figure 174 - Sample Review Memo 

The Organizer shall also send out a reminder notification to all the reviewers two weeks prior to 
the end of the review session.   
 
For Other Reviews 
Invitations for less formal reviews may not require a memo.  It is recommended that an email be 
sent which includes the links to this manual and the review session. 
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10.7 Phase 4 – Digital Review 

10.7.1 Joining a Review Session 
To join a review session, either click on the link provided in the review memorandum for a 
preliminary design review, or for less formal reviews, click on the link in the email.  Below is an 
example of an email for a preliminary design review (semi-final).  Remember the link to the 
review session is included in the memo that was emailed to all the reviewers.   

1. Open the email from the Organizer and open the review memorandum. 

 

Figure 175 - Review Memorandum 
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2. Click on the link to the Review Session. 

 

Figure 176 - Link to the Review Session 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 7/2017 178 Version 4.02 
     

3. Click Allow on the box that pops up in Internet Explorer.  Ignore the text written in the 
webpage as shown below:   

 

Figure 177 - Accessing the Review Session 

4. Bluebeam will now launch.  If this is the first time in a review session, a Studio Account 
must be created.  To do so click on Create Account and then enter in a State email 
address and a password.  In the Name box type in the First Initial then Last name and 
unit.  See below for an example.    

 

 

Figure 178 - Creating a Studio Account 

  

Figure 179 - Studio Session Account 
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If this is not the first time in a review session, enter the studio login information as shown 
below:  If you forgot your password click lost password and an email will be sent to you.   

 

Figure 180 - Review Session 

5. If this is your first time into a review session you must import the CTDOT Bluebeam 
Profile, See Appendix A  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 7/2017 180 Version 4.02 
     

10.7.2 Review Session Layout 
Below is the typical layout in the review session.  On the right tab, there are the tool chest for 
commenting, the attendees of the session, and the documents in the session.  On the bottom, 
there are the list of comments.   

 

Figure 181 - Review Session Layout 

All comments that are made get saved instantly to the Bluebeam review session; these do not 
need to be manually saved.  Each user can only delete their own comments and can leave and 
rejoin as many times as they want as long as the review session has not been closed.  The review 
session will be closed by the Organizer in accordance with the date on the review memo.  
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10.7.3 Reviewing 
This section shows the procedures for reviewing and commenting on documents in a digital 
review.  Reviewers may print digital review documents to paper by going to File>Print and mark 
them up; however, they must transfer these comments onto the digital review documents in 
accordance with this section.  If a unit cannot print their own paper copies they should contact 
MaryAnn Cass by email MaryAnn.Cass@ct.gov.  In the email include the project number and list 
documents that need to be printed, and included the address of where they are to be mailed.      
 
In the case of preliminary contract plan reviews, the original digital documents, with comments, 
will become the final record.   
 
All comments associated with a design submission should be applied to the digital documents, 
including any email or phone call comments.  These types of comments must be applied, by the 
staff member who received the email or phone call, to the correct digital document, use 
engineering judgment to determine the most appropriate location.   
 
General Project wide comments can be placed on the first sheet of the document using the note 
markup tool in Bluebeam as shown below:  Using the note tool you can copy and paste text 
from any source such as an email or a Word document.  This allows larger project wide 
comments to be applied to the plans.    

 

Figure 182 - Note Markup Tool 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:MaryAnn.Cass@ct.gov
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Note about Commenting in a Review Session and Supervisor Approvals  
In most cases, the unit that reviews a document has an internal approval process whereby the 
supervisor finalizes the comments from staff members.  The workflow described in this Chapter 
does not specify or dictate an approval process within each unit; rather, it outlines the review 
procedures once the review comments have been compiled from each unit.    Therefore, it is 
important that only the reviewing unit’s final comments be added to the review session.  Once 
the session ends, the comments made in a review session will be considered final.    
 
The following shows a few options for a supervisor approval procedure, but the digital review 
process is flexible for any procedure a reviewing unit develops.  The only restriction is the final 
comments must be placed on the digital documents located in the review session before the 
reviews session ends:   
 

1. A lower level employee can join the session and comment on the documents in the 
review session.  Then the supervisor can join the session and filter out their 
subordinates comments for their review.  If there is an issue with a comment the 
supervisor will have to direct the lower level employee to fix that comment. If there are 
not any issues with the lower level employee’s comments then nothing has to be fixed.  
After this supervisor review, a lower level employee will join the session and fix the 
applicable comments.  In section 10.1 of this manual there is a list of advantages to 
using this digital review process.  With this option, all of these advantages are realized.         
 

2. A lower level employee can join the review session and save a copy of the review 
documents to their computer.  Then they can markup the documents offline and have 
their supervisor approve those comments.  After the supervisor approves the 
comments, those comments can then be imported into the documents in the review 
session. In section 10.1 of this manual there are a number of advantages to this digital 
review process.  With this option, advantages 3 and 4 are eliminated due to the 
comments made offline.     
 

3. A lower level employee can join the session and print the documents in that review 
session.  Then they can markup the prints and have their supervisor approve the 
comments.  After the approval, a lower level employee can transfer the comments to 
the digital documents in the review session.  In section 10.1 of this manual there is a list 
of advantages to this digital review process.  With this option, advantages 3 and 4 are 
eliminated due to the comments made offline.     

 
Notes about Outside Entities that will not Participate in a Digital Review 
If an outside entity such as a railroad or utility company will not participate in a digital review it 
is still important to add their comments to the final record document in Projectwise.  It is 
encouraged to have these entities participate in the digital review and AEC Applications is 
available to provide support and technical assistance in these efforts.   
 
The following details how the comments from a non-participating entity and your responses to 
those comments shall be attached to the final record document in Projectwise: 

1. Create a PDF document that includes the non-participating outside entity’s comments 
and your responses to those comments.   

2. Then add the pages from that document to the end of the final record document in 
Projectwise in accordance with section 10.9.1.    
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Reviewer 

1. First set your review status to Reviewing by clicking on the drop down shown below: 

Note: If you leave the session and return your status will stay as Reviewing.   

  

Figure 183 - Set Status to Reviewing 

2. Next select a document to review from the studio session tab.  The document will open 
up and can be reviewed.  

 

Figure 184 - Selecting a Document to Comment On 
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3. Select a commenting tool from the tool chest and mark up the plans.  If you do not have 
the CTDOT Review Tools show below, follow Appendix A  to have them imported in the 
Bluebeam Profile. Below are the commenting tools a CTDOT user will have available to 
them in Bluebeam.   

 

Figure 185 - Bluebeam Commenting Tools 

Custom tools can also be created.  Contact DOT.AECApplications@ct.gov for custom tool 
development.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:DOT.AECApplications@ct.gov
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MUST READ BEFORE PLACING COMMENTS 
The following shows best practice for applying text notes in a review session.       
 
There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow, 
cloud, rectangle, etc.).  Each type can have a note attached to them.  The text tools already have 
a note when you type text, but the non-text tools can also have a note attached to them.  To 
attach a text note to a non-text tool place the comment and then double click on that markup.  
Then you can type in your note.  The text note box must be closed after the comment is made 
by clicking on the X in the top right corner of the note.  The example below shows a note being 
attached to the cloud tool the correct way:   

 

Figure 186 – Correct Way to Add Text to a Non Text Commenting Tool 

General Project wide comments can be placed on the first sheet of the document using the note 
markup tool located in the tool chest. Text can be copied and pasted into the note tool as 
necessary.  
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4. After you have completed your set your status to Finished. 

Note: You can still enter the session if your status is set to Finished.  You can also change your 
status back to Reviewing if necessary.  This status is for the Organizer so they know which 
Reviewers have completed their reviews.   

 

Figure 187 - Set Review Status 

5. Create a review comment report of your comments.  First filter out the comments so 
only your comments are displayed as shown below: 

 

Figure 188 - Filtering Comments 
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6. Now that the comments are filtered by your name create a comment report as shown 
below: 

 

Figure 189 - Creating a Comment Report 

Next type in a title for the comment report that includes Project No, What review it is plus the 
word “Comments”, and what document this comment report is for.  See below for an example: 
 

Project ####-#### Semi Final Review Comments 03-Highways 
 

Make sure all the settings are set as shown below and click OK: 

 

Figure 190 - Comment Report 
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7. The comment report will now be created and opened in Bluebeam, leave the comment 
report open in Bluebeam.  We will be copying this report into the comment report 
memo. 

8. Next save the following review comment memo to your computer: Review Comment 

Memo. 
9. Open the memo and fill in the correct information. 
10. Then copy all the pages from the comment report as shown below: 

 

Figure 191 - Copying the Comment Report Memo 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/review_comment_memo.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/review_comment_memo.pdf
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11. Then paste the pages into the memo as shown below: 

 

Figure 192 - Pasting the Comment Report Pages 

12. Save the memo and process this memo as your unit requires. 
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10.8 Phase 5 – Closing the Digital Review 
The Organizer will be responsible for closing the review.  The review session will be closed per 
the date on the review memorandum.   

1. Log into Projectwise and browse out to the review documents folder.   
2. Then select the documents that are in the session that is to be closed, right click on the 

documents, select Change State>Next:  If this step is not performed the session cannot 
be closed.  This will place the documents in the CLOSE REVIEW state.   

 

Figure 193 - CLOSE Review State 

3. Then open up Bluebeam and join your session. 
4. Then Click Finish to close a Bluebeam Review Session as shown below: 

 

Figure 194 - Terminating a Session 
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5. Make sure all the reviewers in the list below are selected (they will be by default) and 
the Save (Overwrite Existing) button is checked and click OK. 

 

Figure 195 - Terminating a Session 

6. Click OK in the figure below. 

 

 

Figure 196 - Overwriting Existing Documents 
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7. Close Bluebeam Revu and check in each document to Projectwise.  Note: A check in box 
will pop up for each document in the review session.   

 

Figure 197 - Checking a Document Into Projectwise 

8. Notify the Document Authors that the session has been closed so they can resolve the 
comments on their documents. 
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10.9 Phase 6 – Resolve Comments 
This section shows how the comments from the review session will be resolved by the 
Document Authors.  After the comments have been resolved in the PDF documents located in 
Projectwise the Document Author shall notify the Organizer that they have finished applying 
their resolutions to the documents.   
 
Note:  Comments cannot be resolved until the review session has been finished.  The Review 
Organizer will notify the Document Authors when the session has been finished.  If the 
document authors go into the documents located in Projectwise before the session is finished 
there will be no comments on the documents.   

10.9.1 Resolving Comments 
All comments on the review documents shall be resolved by the Document Author directly on 
the digital PDF review documents using Bluebeam.  The following shows the steps for resolving 
comments. 

1. Open your document(s) from Projectwise.   
2. Next select a comment in the comment list and right click.  The select Reply.   

 

Figure 198 - Comment Resolutions 
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3. In the box that pops up, type in a final resolution in the following format: 

Note: For plan sheets, include “Change Plans” or “No Change to Plans” where necessary.   

Resolution – Type in resolution...No Change to Plans 
 
The resolutions applied to the plans shall be the final resolution decided by the Document 
Author’s unit.  There shall only be one resolution for each comment.   
 
Below is an example of a resolution: 
 
 

 

Figure 199 - Typing in a Resolution 
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Below is an example of how the resolutions will look in the comment list. 

 

Figure 200 – Resolutions 

4. Next attach a PDF document that includes any non-participating entities comments with 
your responses to the review document.  This should be done by adding that PDF 
document to the end of the review document as shown below: 

 

Figure 201 - Attaching Comments 
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5. Browse out to the PDF document you want to add and then select to insert after the last 
page: 

 

Figure 202 - Adding Comments 

6. When all the resolutions have been applied, make sure to save the documents and 
check them back into Projectwise.  

7. Notify the Review Organizer that you have completed your resolutions.   
8. Send out Completion of Review Memo to all the personnel associated with the review 

session indicating that the review session is over and all comments have been resolved 
on the documents in Projectwise.  Link to: Completion of Design Review Memo 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/Completion_of_Design_Review_Memo.pdf
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10.10 Locking the Review Documents after the 
Review 

The Organizer shall change the state of the documents to make them document read-only after 
the resolutions have been applied to the review documents.   
 
To make the documents read-only, change the state of the documents in Projectwise to “Review 
Completed” as shown below: 

1. Select the document(s) and change the state of the documents to “Review Completed” 
as shown below: 

 

Figure 203 - Changing the State to Review 

 

 

Figure 204 - Review Complete State 
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2. Then right click on all the documents again and select Change State > Set Final Status.  

This will lock the documents.   

 

Figure 205 - Setting Final Status 
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 Design Phase Project Scheduling  Section 11

 
An Engineering working group evaluated several scheduling software options to support the 
mission statement. Microsoft Project 2010 was selected because it offers the following features 
and advantages: 

 Accommodates any number of milestones and tasks (i.e., easily scalable), 

 Graphically displays series and parallel tasks, 

 Provides baseline and tracking Gantt charts, 

 Displays the critical path, 

 Ability to link notes and documents, and 

 Interfaces with Outlook, Excel, SharePoint and other Microsoft products. 
 

Microsoft Project 2010 shall be used to develop design phase schedules meeting the following 
minimum requirements: 

1. Includes all the activities identified by the Minimum Requirement Schedule 
Template; more detailed templates and project-specific schedules are encouraged,   

2. Baseline schedule,   
3. Task Indicator columns are used to link applicable instructional and reference 

documents, 
4. Explanations for changes in task durations are added as task notes,  
5. Tracking View/Gantt chart functions are used, 
6. Task-level progress is tracked regularly,  
7. Files are stored in the ProjectWise project container as indicated by the Digital 

Project Development Manual, and 

8. Microsoft Project files are maintained and current, with projected schedules in 

accord with the obligation plan. 

Base templates were developed by a committee that included Engineering Management and 
Subject Matter Experts (SMEs) from each engineering discipline. The Office of Engineering SMEs 
are as follows: 

 Bridge Design – Kevin Blasi and David Gruttadauria 

 Consultant Bridge Design – Derick Lessard and Marc Byrnes 

 Highway Design – Scott Bushee, Jordan Pike, and Vitalij Staroverov 

 Consultant Design State Roads – Nilesh Patel and Meredith Andrews 

 Traffic Projects Design – Barry Schilling and Michael Chachakis  

 Traffic Studies & Safety – Erika Lindeberg,  Daniel Veronesi and Colin Baummer 

 Facilities Design – Eric Feldblum and Jesse Benson 
 
The SMEs are responsible for developing and maintaining division specific project templates and 
corresponding task libraries in ProjectWise. They shall be the first point of contact regarding 
discipline specific template and guidance document inquiries and maintenance.  
 
For questions, suggestions and issues pertaining to Microsoft Project and the Scheduling 
Directive, please contact Bruce Bourgoin (Bruce.Bourgoin@ct.gov) or Nick Langer 
(Nicholas.Langer@ct.gov).  
 
 
 
 
 

mailto:Bruce.Bourgoin@ct.gov
mailto:Nicholas.Langer@ct.gov
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The table below details the minimum tasks included in the template: 

Table 3 - List of Minimum Tasks 

Task Name  

Project XXXX-XXXX  

Project Initiation  

 Prepare and Submit PPI  

 Prepare and Approve RPM   

 Secure Funding/Authorization   

Preliminary Design  

 Survey   

 NEPA/CEPA  

 Develop PD through Design Approval  

 Design Approval  

Final Design  

 Prepare Semi-Final Design Submission  

 Prepare Final Design Submission  

ROW Coordination  

 Prepare and Submit Final Accepted Property Maps  

 Acquire Properties  

Permit Acquisition Process  

 Permit A  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

 Permit B  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

 Permit C  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

FDP  

DCD  

ADV 

 
The Minimum Requirement Schedule template is stored in ProjectWise and can be found here: 
AEC Scheduling Documents (Minimum Req) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

pw://ctdot.projectwiseonline.com:CTDOT/Documents/04.00%20-%20Engineering%20Libraries/Scheduling%20Directive/AEC%20Scheduling%20Documents%20(Minimum%20Req)/
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11.1 Microsoft Project File Set Up 
The following steps show how to set up a Microsoft Project file:  

1. Open ProjectWise Explorer by going to Start> All Programs> Bentley> ProjectWise 
V8i (SELECT series 4), and click on ProjectWise Explorer as shown below:  

 

Figure 206 – Launching Projectwise 

2. Then double Click on CTDOT and then sign into ProjectWise with your username and 
password.  If this is your first time logging into Projectwise, you will be asked to 
create a working directory, click Yes: 

 

Figure 207 – Logging Into Projectwise 
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3. Browse to Documents>04.00 Engineering Libraries>Scheduling Directive. Select the 
applicable division’s Scheduling Documents folder.  The below example presents 
where the Minimum Requirement Schedule Template is located: 
 

 

Figure 208 - Schedule Templates 

4. Right click on the most applicable template and select Copy  

 

Figure 209 - Copying a MS Project Schedule 

pw://ctdot.projectwiseonline.com:CTDOT/Documents/04.00%20-%20Engineering%20Libraries/Scheduling%20Directive/
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5. The next step is dependent upon if a project is in the Project Initiation Phase or has 
progressed to Preliminary Design Phase.  Project Initiation is typically complete 
when Funding and Authorization is received, and a ProjectWise project container is 
created.  If a ProjectWise container has not been created, contact Julie Annino in 
AEC Applications. 

 
Projects in Project Initiation Phase 
a.  If the project is in Project Initiation the MS Project schedule should be 

pasted to the respective discipline specific Initiation Phase Scheduling 
ProjectWise folder:  

 

 

Figure 210 - Discipline Specific Initiation Phase Scheduling folders 

  Projects in Preliminary Phase 
b. If the project is in preliminary design phase the schedule should be saved to 

the ProjectWise 140_Project Administration folder under the project. 

 

Figure 211 - Project 140_Project Administration Folder 
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6. To paste the project file, right click on the folder and select Paste and then Yes.  

 

Figure 212 - Save schedules to the 140 Project Administration Folder 

7. Then click Advanced Wizard and click OK. 
8. Then click next until you get to the attributes screen shown below, then assign the 

attributes as shown below: 

 

Figure 213 - ProjectWise Attributes 
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9. Then click next until the file uploads.   
10. Next open the project file. 
11. Then click on the File menu, select Info, select the Project Information dropdown 

and then Advanced Properties as shown below: 
 

 

Figure 214 - Setting Advanced Project Properties 

 
12. In the dialogue box that pops up, fill out the information as shown below: 

 

Figure 215 - Project Information 
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13. Next set the project start date by selecting the File menu > select Info, then select 
the date as shown below: 
 

 

Figure 216 - Setting the Start Date 

 

11.2 Basic MS Project Function 
This section presents the following schedule basic terminology and functions:  

 Scheduling Terminology  

 Task Relationships (Predecessors and Successors) 

 Adding , Renaming, Indenting and Deleting a Task 

 Adding/Adjusting Durations 

 Lead and Lag Times 

 Adding Hyperlinks 

 Combining Multiple Projects 
 

11.2.1 Scheduling Terminology 
The most common scheduling view is the Gantt chart view, which illustrates a project schedule 
using task names, durations, start and finish dates on the left, and bar charts presenting these 
dates and durations to the right.  
 

 

Figure 217 - Basic Terms 

Task Indicator Column - Present task Notes and Hyperlinks.  
Milestone - A major schedule date, such as an FDP. 
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Parent Task - Shown as a Grey Bar, signifies it is a Parent Task. Its duration is populated by the 
Child Tasks. 
Critical Path - Shown in Red, signifies the task relationships that control major milestone dates. 
Non-Critical Task - Shown in Blue, signifies sub-tasks that do not control major milestone dates. 
 

11.2.2 Task Relationships (Predecessor and 
Successors) 

Predecessor is a task which has a start or finish date that affects the start or finish of another 

task.  

Successor is a task which has a start or finish date that is affected by another task.  

There are different ways of defining task relationships, these are  

 Finish-to-Start: This is the default dependency in Microsoft Project in which the successor 

cannot begin until the predecessor is complete. A Finish-to Start task relation is denoted by 

FS, or simply, as the predecessor’s Task ID. A Task ID is found on the column to the far left.  

 

Figure 218 - Finish to Start relation 

 Start-to-Start: The successor cannot begin until the predecessor begins. The successor task 

can start at any time after predecessor begins. Start-to-Start relationship is designated by 

SS. 

 

Figure 219 - Finish to Finish relation 

 Finish-to-Finish: the successor cannot be completed until the predecessor is completed. 

The successor can be completed at any time after the predecessor is completed. Finish-to-

Finish task relation is denoted by FF. 

 

Figure 220 - Start to Finish relation 
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 Start-to-Finish: the successor cannot be completed until the predecessor begins. The 

successor can be completed at any time after the predecessor has started. The Start-to-

Finish task relation is denoted by SF. 

 

Figure 221 - Start to Finish relation 

The schedule should have a Predecessors column where task relationships can be defined. To 

define a task relation, enter the Task ID and the Task Relationship in the associated task’s 

Predecessor Cell. For example, in the Figure below the PPI is a predecessor and the RPM is a 

successor task. The PPI must Finish before the RPM can Start. This relationship is denoted in the 

RPM Process row’s Predecessors cell, as the number 2. The number 2 represents the 

Predecessor’s Task ID. The absence of a task relationship abbreviation means that the relation is 

a Finish-to-Start or FS. A FS is the standard task relationship and therefore the abbreviation is 

not presented, unless it is accompanied by a Lead or Lag time, as discussed in a later section.  

 
 

Figure 222 - Linking tasks 
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If the Predecessors column is not shown in the template, double click in the “Add New Column” 

cell and start typing “predecessor,” and from the short list click on Predecessors to add it to the 

current columns. If Add New Column is not shown right click on any column label and select 

Insert Column and then start typing in Predecessors, as presented below:  

 

Figure 223 - Add new column 

 

Figure 224 - Adding predecessor column 
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11.2.3 Adding, Renaming, Indenting and Deleting 
a Task 

Adding a Task  
To add a task, right click on the task which will follow the new task and select Insert Task.  For 

example, to add a new task between NEPA/CEPA and Survey, right click NEPA/CEPA and select 

Insert Task, as shown below: 

 

 

Figure 225 - Adding a Task 

Renaming a Task 
Tasks can be renamed by double clicking on the task to be edited.  In the pop up window under 
General tab you can edit the task name. (Do Not Rename the Base Template Tasks in Bold)      
  

 

Figure 226 - Renaming a task 
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Outdenting & Indenting 
Outdenting and Indenting provides schedule customization. Outdenting moves a task to the left 

of the task column and indenting moves a task to the right. Indenting a task makes it a ‘child’ of 

the preceding, outdented ‘Parent’ task. Parent task durations are populated by their 

accumulative child task durations, therefore, parent task durations should not be manually 

entered. To set your task as a child or “sub-task”, select the row you would like to modify and 

click the Indent Button in the main toolbar area shown: 

 

 

Figure 227 - Outdent and indent 

 

Deleting a Task 
A user may delete, enter zero, or enter any small duration for a task if it is irrelevant.  By 
entering zero for the duration the MS Project will view the task as a milestone, if a report is 
generated the report will present all zero duration tasks as milestones. This may confuse report 
reviewers.  A small duration may push back critical milestone dates. It is therefore 
recommended that project managers manually delete and revise predecessor and successor 
relations, as described below. To delete a task right click on it and select delete task. (Do Not 
Delete the Base Template Tasks in Bold) 

 

Figure 228 - Deleting a task 
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When a schedule is started the user should remove tasks that do not relate and estimate all 

other pertinent task durations. It is critical to note if the task being deleted is a predecessor. 

You can determine this by following the lines stemming from a task in the Gantt chart. If a task is 

erroneous and must be deleted, but is also a predecessor for other tasks that should not be 

deleted, the successor task must be corrected.  Failing to update a new predecessor will likely 

disrupt task connectivity.  

For example, if a project does not require a Preliminary Hydraulic Analysis, the step should be 

deleted. However, the Hydraulics Analysis is a predecessor for the ABC Analysis; therefore the 

ABC Analysis’ predecessor task should be updated. In this case the Utility Coordination will be 

the new predecessor. See the task relationship and Gantt chart prior to task deletion: 

 

Figure 229 – Before task deletion table 

 

 

Figure 230 – Before task deletion Gantt chart 

 
See Task relationship and Gantt chart after task deletion: 

 

Figure 231 – Post task deletion and predecessor update table 
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Figure 232 - Post task deletion and predecessor update Gantt chart 

 

After the Hydraulic Analysis has been deleted and the new predecessor has been assigned, MS 
Project automatically reconfigures the schedule to show the new critical path. The critical path is 
shown in red and highlights the task relationships that determine a projects finish date.    

11.2.4 Adding and Adjusting Durations 
All tasks require duration estimates that may vary as projects progress. To set a duration click 
the Duration Cell to the right of the task and enter the task’s estimated period and the 
applicable unit, as presented below:  

 Mons: for months 

 Wks :  for weeks 

 Days :  for days 

 Hrs:    for hours  

 Mins: for minutes   
 

 

Figure 233 - Adding durations 

 
If the duration unit is already entered, then the duration value may directly entered, without 
including the unit. Do not modify durations for parent tasks. Parent tasks are signified by 
having a gray bar in the Gantt chart area and a maximize/minimize arrow. Parent task durations 
are automatically calculated by their subtask durations.  
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If a parent duration is manually entered, select the parent task and re-select Auto Schedule. 
This will recalculate the appropriate parent duration, based on its child tasks. See below: 
 

 

Figure 234 - Auto Schedule 

11.2.5 Lead and Lag Times 
In defining a task relation, a task may have to be delayed or started early.    

 The Lead time will tend to push your duration and a plus sign is used. 

 The Lag time will tend to shorten your duration and a minus sign is used. 

To add a Lead or Lag time: type in the task relation type, then the predecessor task number, a 
plus or minus, and the amount of delay or early start. 
 

For example, Task 18: DCD, is 6 weeks after task 17: FDP, this can be described as 17FS+6wks 

 
Figure 235 - Task relation 
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This can also be set by right clicking on a task and selecting Information.  Then go to the 

Predecessors tab as shown below, and enter the predecessor ID or Task Name, the relationship 

type and then a positive duration for a lead time or a negative duration for a lag time in the Lag 

column.  

 

Figure 236 - Task relation in Project Information 

 

11.2.6 Adding Notes and Hyperlinks to a Task 

Adding Task Notes 

As stated in the Directive: “Explanations for changes in task durations are added as task notes.” 
Notes are reserved to clearly indicate when a specific Project Task duration is adjusted from the 
baseline. The note should be placed in the respective task’s indicator column. The note should 
state: 

 The date of the entry, 

 The person writing the note, 

 Justification for the task duration adjustment and 

 Recommended: Recipient Notification. 

The Recipient Notification list is left up to the Project Managers discretion. The purpose is to 
outline a step where project team members who may be interested or are directly impacted by 
a duration change, are notified. Once a note is drafted and the duration is adjusted, it is 
recommended that a notification email be sent to the relevant recipients and that the 
correspondence is saved to the subject project’s 140_Project Administration folder in 
ProjectWise. The recipients may typically include:  

 AEC’s Project Management Unit –Bruce.Bourgoin@ct.gov or Nicholas.Langer@ct.gov 

 Finance, such as the Office of Capitol Planning. 

 Design Engineers within the Project Manager’s division.  

 The group involved with the duration change or the group affected by the change, if 
applicable. For example, if the 6 month estimated duration for a project survey needs to 
be pushed back, the respective survey supervisor who is involved with the task should 
be included as a recipient in the notification email.  

mailto:Bruce.Bourgoin@ct.gov
mailto:Nicholas.Langer@ct.gov
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The purpose of the recipient list is to improve communication between units and to harvest 
project data. Meaning, AEC will collect a repository of duration change notes in order to 
continuously reevaluate and improve schedule templates.  
 
To add a note right click on a task and select Notes… as shown below: 
 

 
Figure 237 - Adding Notes 

Then type/insert your notes in the popup window.  

The other option to access the notes window is to double click on the task and in the Task 

Information window and click on the Notes tab. 

Adding Hyperlinks to a Task 

As stated in the Directive: “Task Indicator columns are used to link applicable instructional and 
reference documents.” For all templates, hyperlinks shall be used to link a task to a division 
specific Schedule Task Library folder located in the Scheduling Directive PW folder. Contact your 
SME or AEC Applications for ProjectWise folder and template document management.  
 
For example, a Permit Task should provide a link to a corresponding ProjectWise folder that 
contains the permit’s regulatory document, suggested points of contact or experts, pre-written 
memorandums, etc... These documents must be added, actively maintained and updated. 
Division SME’s and AEC shall be the active maintainers of the division library modifications. 
When a document is incorrect or has been superseded it is critical that users report this to a 
unit’s SME or to AEC so documents can be updated and maintained. It is suggested that users 
go through their SMEs to hyperlink documents, but the procedure is explained below.  
 

 

 

 

 

pw://ctdot.projectwiseonline.com:CTDOT/Documents/04.00%20-%20Engineering%20Libraries/Scheduling%20Directive/
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To add a Hyperlink, right click on the task that you want to add a link to and select Hyperlink  

 
Figure 238 - Adding Hyperlink 

 

Then in the following window, insert web address\navigate to a file.  

 
Figure 239 - Add link/browse to a file 

 

To remove a link right click on the link (Task)> Hyperlink> Edit hyperlink > Remove link  

 
Figure 240 - Removing a link 

 

To access a hyperlink hold the ctrl key and left click the hyperlink icon located in the Indicator 
column.  

11.2.7 Combining Multiple Projects 
It is critical that project managers can combine project schedules to better manage several 
schedules from the same file. MS Project provides this ability through the Subproject combine 
function. As outlined in Section 8, schedules must be stored in the project container: 
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140_Project Administration folder. However, to use the combine function, MS Project schedules 
must be exported from the ProjectWise folder to a local server drive, such as the X-Drive. 
Schedules located in a local network can then be combined using the subproject tool. Exporting 
is only recommended when a user wants to use the combine tool. 
 
The following steps show how to combine Microsoft Project files: 

1. Browse to the ProjectWise Project container’s 140_Project Administration folder.  
Right click the Project Schedule and select Export, as shown below: 
 

 

Figure 241 - Schedule Export 

 
2. Highlight Export and Click Next as shown below: 

 

 

Figure 242 - Export Option 
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3. Browse to the network folder where you will keep the schedule file image. This 
network file will likely be in the division specific X-Drive>all_data-folder. 

 

NOTE: DO NOT DELETE THE EXPORTED FILE 
 
The floppy disk means that the file has been exported so the schedule is now read only. A user 
can still access the Project file by double clicking it and opening the file as Read Only. 
 

 

 

Figure 243 - Exported File 

 
4. Create a new “Master” MS Project file that will be used as the container for the 

combined Subprojects. This Master Schedule file can be stored in the local network 
drive (such as the X-Dirve) or on ProjectWise. Browse to the local network schedule 
(the one stored in the X-Drive) and click Insert as shown below: 
 

 

Figure 244 - Subproject 

The schedule has been inserted into the Master Schedule, where it can be actively updated and 
maintained. Initially, sub-tasks will be hidden, but they can be shown by clicking the project’s 
outline symbol. 
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Figure 245 - Added Subprojects 

 
A user can view the most updated schedule via the ProjectWise file by right clicking the schedule 
file and selecting Update Server Copy as shown below: 

 

 

Figure 246 - Update server copy 

 
5. This step updates the ProjectWise schedule from the local network image file that is 

maintained by the user’s Master schedule. This allows any person to view the most-
up-to-date project schedule directly from ProjectWise.  

6. To Import a project schedule back into ProjectWise the user must right click on the 
ProjectWise schedule and click Import. As shown below: 
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Figure 247- Import 

 
7.  If you look back to the local server where the project image file had been saved, 

you will notice that it is no longer there, this is because the file has been imported 
back into ProjectWise.  Now the file can once again be managed directly from 
ProjectWise. If a user wishes to maintain their schedule continuously from their 
master schedule, they should avoid importing the schedule. Once a file is imported 
the user must re-export and re-add the schedule to their master schedule.   
 

11.3 Tracking the Project 

11.3.1 Baselining the Project 
Each project file must have a baseline set at the start of Preliminary Design.  The baseline is 
essentially a stamp of the schedule at the start of the Preliminary Design phase. The purpose of 
the baseline is to gage how much a schedule varies from the initial baseline. Projects shall not 
be re-baselined unless there is a major scope change.  Re-baselining requires Engineering 
Administrator approval.  
 

1. To set the baseline, under the Project tab select set baseline and select Set 

Baseline from the dropdown as shown below 

 

Figure 248 - Set Baseline Dropdown 
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2. In the dialog box that pops ups, keep the default values and click OK. 

 

Figure 249 - Setting a baseline 

 

Re-Baselining          
If Re-baselining is needed and is approved by the Engineering Administrator, the baseline will be 

set in accordance with the following: 

1. Go to Projects > Set Baseline > Set Baseline. 

2. Then select Set Interim plan, select Baseline from the copy drop down button, then 

select Baseline 10 for the Into dropdown list.  

 

Figure 250 - Re-Baselining 

3. Next, go to Project > Set Baseline> set Baseline. 

4. Then in the dialog box that pops up just click OK to save a new Baseline.  
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Figure 251 - Re-Baselining 

5. When a pop up window asks you if you want to overwrite click yes 

 

Figure 252 - Re-Baselining 

6. After the project has been re-baselined add a note to the top left Identifier cell 

located in the Project No. row. The note should include the details outlined in the 

Adding Notes and Hyperlinks to a Task section. The recipient list should include all 

parties affected by the base-line adjustment.  

 

Figure 253 - Re-Baselining Note 

 
After the project has been re-baselined change the view to a Tracking Gantt view.   
 

1. In the left dark grey bar shown below, right click and select Tracking Gantt.   
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Figure 254 - Changing to a Tracking Gantt 

Notice the Gantt shows two bars stacked over each other. The grey bar is the baseline and the 

one on top is the actual duration.   If there is a slip in a task schedule it will be shown as an 

offset. 

 

Figure 255 – Tracking Gantt view 

2. Next to change the table of tasks to the tracking mode, click on the left upper corner 

cell to select the entire schedule, then right click and select tracking. 
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Figure 256 - Changing to tracking table 

The table of tasks will now be in the tracking mode, 

3. Then click save. 

11.3.2 Recording Task Progress 
The project manager will be required to record the project progress by keeping an up to date 
record of the % complete for each task in the project.   This shall be recorded in 25% increments.   
 
The following shows how to record the progress of a task: 

1. Click on a task. 
2. Then in the task menu select the appropriate % complete as shown below: 

 

Figure 257 - task update tools 

Important Note:  When the task is completed, do not select 100% complete.  You will need 

to type in the actual finish date for that task.  If 100% complete is selected, Microsoft Project will 

calculate the actual finish date instead of recording the physical date the task was completed.  

In the tracking Gantt, the task will show the percent complete of the task as shown below:  
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Figure 258 - Updated task view 

 

Also when a task is not started and/or finished on time, it will show as a slipping bar as in the 

following figure. 

 

Figure 259 - Tracking View 
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11.4 Generating Reports and Summaries 
Microsoft Project provides different forms of reports and visual summaries.  MS Project has 
three reporting options: 

1. Standard Reports 

2. Custom Reports 

3. Visual Reports 

 

Standard Reports 
Standard Reports are reports predefined by Microsoft on; Overview, Current, Costs, 

assignments and workload.  

  Under Overview the following is reported: 

 Project Summary 

 Top-Level Tasks 

 Critical Tasks 

 Milestones  

 Working days 

Under Current the following is reported: 

 Un started Tasks 

 Tasks Starting Soon 

 Tasks In-Progress 

  Completed Tasks 

 Should have Started Tasks 

 Slipping Tasks 

              Under Cost the following is reported: 

 Cash Flow 

 Budget 

 Overbudget Tasks 

 Overbudget Resources 

 Earned Value 

            Under Assignments the following is reported: 

 Who does what 

 Who does what when 

 To-do List 

 Overallocated Resources  

  

        Under Workload the following is reported: 

 Task usage 

 Resource Usage 
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To access these report options go to Project > Reports  

 

Figure 260 - Report options 

Custom Reports 

A custom report has the ability to customize the report based on templates in the following 

categories: 

 Task 

 Resource  

 Monthly Calendar 

 Crosstab 

 To access custom report tool, go to Project > Reports > and double click on Custom 

 

Figure 261 - Custom Reports 
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Then the report to be edited is first selected from the list of available custom report.  Next, click 

the Edit button. The dialog will show the current report’s setting and all the available report 

settings. 

 

Figure 262 - Customizing a report template 

Other than the Definitions tab you may utilize details and sort tabs for further customization. 

Visual Reports 

Unlike the standard/customized reports which are text based, visual reports present the report 

graphically. Visual reports are pre-formatted excel pivot-tables and pivot-charts as well as Visio 

pivot-diagrams. 

To access go to Projects tab > Visual Reports 

 

Figure 263 - Visual Reports 
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 CTDOT Project Location – Under Section 12

Development 

This section details the required information/documents that need to be submitted to CTDOT to 
locate all of our projects on a GIS (Geographic Information System).   
 
The lead designer shall be responsible for providing the information/documents detailed in the 
following tables when filling out or updating the Project Asset Form located on the Projectwise 
Project Information Webpage at the following link: 
 

Projectwise Composite Data 
 
This information/document needs to be submitted or updated at the following project 
milestones: 

 RPM 

 Design Approval 

 Final Design 
 

The following tables detail what needs to be provided on the Project Asset Form for various 
project types.  If your project type is not listed, contact AEC applications for guidance: 
Mathew.calkins@ct.gov or John.Rinaldi@ct.gov    
 

Project Milestone - RPM 

Project Type Required 
Information/Document  

Instructions 

Highway Paving Routes and Mileage Section 8.1.1 

Guide Rail, Barrier, Safety Improvements Routes and Mileage Section 8.1.1 

All other highway projects Google Earth KML  

  

Bridge Bridge Preservation projects Route and Mileage Section 8.1.2 

Bridge Maintenance projects Route and Mileage Section 8.1.2 

Bridge Replacement or Superstructure 
Replacement 

Google Earth KML Section 8.1.3 

Retaining Wall Projects Google Earth KML Section 8.1.3 

Sign Support Projects List of sign supports in the 
project 

Section 8.1.2 

  

Traffic  Traffic Signals List of traffic signals in the 
project 

Section 8.1.2 

Signing Route and Mileage Section 8.1.1 

Pavement Markings Route and Mileage Section 8.1.1 

Rumble Strip Route and Mileage Section 8.1.1 

  

Facilities  New Facility or Rehab of Existing Facility Google Earth KML Section 8.1.3 

Rail Project Google Earth KML Section 8.1.3 

  

Rails Rail Project  Google Earth KML Section 8.1.3 

 

District Wide 
Projects 

   

http://dot-sdcdbs56v/PW_FederatedData/MainMenu.aspx?SessionExpired=True
mailto:Mathew.calkins@ct.gov
mailto:John.Rinaldi@ct.gov
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State wide 
Projects 

   

 

Project Milestone – Design Approval 

Project Type Required 
Information/Document  

Instructions 

Highway Paving Updated Routes and Mileage if 
necessary 

Section 8.1.1 

Guide Rail, Barrier, Safety 
Improvements 

Updated Routes and Mileage if 
necessary 

Section 8.1.1 

All other highway projects Microstation Project Polygon 
File 

Section 8.2.1 

  

Bridge Bridge Preservation projects Updated list of bridges in the 
project if necessary 

Section 8.1.2 

Bridge Maintenance projects Updated list of bridges in the 
project if necessary 

Section 8.1.2 

Bridge Replacement or 
Superstructure Replacement 

Microstation Project Polygon 
File 

Section 8.2.1 

Retaining Wall Projects Microstation Project Polygon 
File 

Section 8.2.1 

Sign Support Projects Updated list of sign supports in 
the project if necessary 

Section 8.1.2 

  

Traffic  Traffic Signals Updated list of traffic signals in 
the project if necessary 

Section 8.1.2 

Signing Updated Routes and Mileage if 
necessary 

Section 8.1.1 

Pavement Markings Updated Routes and Mileage if 
necessary 

Section 8.1.1 

Rumble Strip Updated Routes and Mileage if 
necessary 

Section 8.1.1 

  

Facilities  New Facility or Rehab of Existing 
Facility 

Microstation Project Polygon 
File 

Section 8.2.1 

Rail Project Microstation Project Polygon 
File 

Section 8.2.1 

  

Rails Rail Project  Microstation Project Polygon 
File 

Section 8.2.1 

 

District Wide 
Projects 

   

State Wide 
Projects 
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Project Milestone – Final Design and Construction 

Project Type Required 
Information/Document  

Instructions 

Highway Paving Updated Routes and 
Mileage if necessary 

Section 8.1.1 

Guide Rail, Barrier, Safety Improvements Updated Routes and 
Mileage if necessary 

Section 8.1.1 

All other highway projects Updated Microstation 
Project Polygon File 

Section 8.2.1 

  

Bridge Bridge Preservation projects Updated list of bridges in 
the project if necessary 

Section 8.1.2 

Bridge Maintenance projects Updated list of bridges in 
the project if necessary 

Section 8.1.2 

Bridge Replacement or Superstructure 
Replacement 

Updated Microstation 
Project Polygon File 

Section 8.2.1 

Retaining Wall Projects Updated Microstation 
Project Polygon File 

Section 8.2.1 

Sign Support Projects Updated list of sign 
supports in the project if 
necessary 

Section 8.1.2 

  

Traffic  Traffic Signals Updated list of traffic 
signals in the project if 
necessary 

Section 8.1.2 

Signing Updated Routes and 
Mileage if necessary 

Section 8.1.1 

Pavement Markings Updated Routes and 
Mileage if necessary 

Section 8.1.1 

Rumble Strip Updated Routes and 
Mileage if necessary 

Section 8.1.1 

  

Facilities  New Facility or Rehab of Existing Facility Updated Microstation 
Project Polygon File 

Section 8.2.1 

Rail Project Updated Microstation 
Project Polygon File 

Section 8.2.1 

  

Rails Rail Project  Updated Microstation 
Project Polygon File 

Section 8.2.1 

 

District Wide 
Projects 

   

State Wide 
Projects 
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12.1 Project Location - RPM 

12.1.1 Route and Mileage 
The lead designer shall provide all routes and mileages for project in accordance with the 
following:  
 

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data 
2. Click on the Project Asset Form. 

 

Figure 264 - Project Asset Form 

 
3. Select the project from the drop down or if it is a new project click “Add Project”. 

 

Figure 265 - Selecting Project 

4. To get the route and mileage for a project you will need to go to the ALIM system 
found here:     ALIM System 

5. Next add the route and mileages to the Project Asset Form. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://dot-sdcdbs56v/PW_FederatedData/MainMenu.aspx?SessionExpired=True
https://ctdot-geopub.projectwiseonline.com/ctdot2/Framework/default.aspx
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12.1.2 List of Assets for the Project 
 

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data 
2. Click on the Project Asset Form. 

 

Figure 266 - Project Asset Form 

 
3. Select the project from the drop down or if it is a new project click “Add Project”. 

 

Figure 267 - Selecting Project 

4. On the form add all of the assets in this project.  
 

http://dot-sdcdbs56v/PW_FederatedData/MainMenu.aspx?SessionExpired=True


 Connecticut Department of Transportation – Digital Project Development Manual

Issued 7/2017 235 Version 4.02 
     

 

Figure 268 - Adding Assets 

12.1.3 Project Polygon Creation and Submission 
The following shows how to create and submit a project polygon KML file for project location.  
The project polygon is created in Google Earth and attached to the Project Asset Form located 
on the Projectwise Project Information webpage.   
 

1. Open Google Earth. 
2. Zoom into the location of the project or use the search tool to locate the area of the 

project.  
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Figure 269 - Searching in Google Earth 

 
3. Next select the polygon tool to place a polygon around your project. 

 

Figure 270 - Polygon Tool 

 
 

4. Next Type the project number in the name field and a description in the description 
field as shown below: 
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Figure 271 - Polygon Settings 

5. Next adjust the style and color of the polygon to the settings shown below, do not 
click OK after you update the settings: 

 

Figure 272 - Polygon Style 
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6. Next draw the polygon for the project.  This polygon should encompasses the whole 
project and include all the roads that this project will affect.  Then click OK. 

 

Figure 273 - Drawing the Polygon 

If you are dissatisfied with the polygon, you can delete it by right clicking on the polygon located 
in the places area, which is in the left hand side of the screen, of Google Earth.  Then redraw the 
polygon by going back to step 3. 

 

Figure 274 - Deleting a Polygon 
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7. If the project has multiple sites, go back to step 3 and create another polygon(s).  
After you create all your polygons they will be listed in the places area in Google 
Earth.   

 

Figure 275 - All Sites for Project 

8. After all the sites are made they need to be added to the temporary places area in 
Google Earth so a combined KML file can be saved.  To add them to the temporary 
places simply drag and drop all the sites into that area as shown below: 
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Figure 276 - Drag all the Sites into the Temporary Places 

9. Next to save a KML file with all the polygons in it right click on Temporary Places and 
select Save Place As: 

 

Figure 277 - Saving the KML File 
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10. Next type in the project number for the file name and select KML for the file format.  
Then select the folder on your computer where you want to save the file too and click 
Save. 

 

Figure 278 - Saving the KML File 

 
11. Go to the Projectwise Project Information Webpage: Projectwise Project 

Information 
12. Click on the Project Asset Form. 

 

Figure 279 - Project Asset Form 

 
13. Select the project from the drop down or if it is a new project click “Add Project”. 

http://dot-sdcdbs56v/PW_FederatedData/MainMenu.aspx?SessionExpired=True
http://dot-sdcdbs56v/PW_FederatedData/MainMenu.aspx?SessionExpired=True
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Figure 280 - Selecting Project 
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14. Next attach the KML file to the Project Asset Form by clicking on Browse and then 
select the file: 

 

Figure 281 - Attaching the KML File 
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15. After you have selected the file click on attach file: 

 

Figure 282 - Attaching the KML File 
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12.2 Project Location - Design Approval through 
Construction 

The following shows how to create and upload a refined project polygon file at and after the 
Design Approval milestone of a project.  The file shall be created by the lead designer in 
accordance with this section and uploaded into the 140_GIS folder of the applicable project in 
ProjectWise.  For projects that were previously located using the assets or route and mileage 
this section does not apply.  If changes are made to projects found using assets or route and 
mileage update that project information in accordance with Section 8.1. 

12.2.1 Project Polygon 
The lead designer is responsible for creating the project polygon dgn and kml files using 
Microstation.  The following section details what needs to be included in the polygon and how 
to make the project polygon file for different project types.   
 
If your project type is not detailed below, contact AEC Applications. Mathew.calkins@ct.gov or 
John.Rinaldi@ct.gov  for guidance.  
 
If a project has more than one site, all the polygons for that project must be included in one 
project polygon file.  All the polygons for each intersection shall be in one file.   
 
Highway Projects that Touch Pavement  
The Project Polygon file shall encompass the entire project extents per site and include all slope 
lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected 
assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or 
temporary work area extends beyond that.  Below is an example of what to include: 
 

 

Figure 283 – Project Extents 

 
 
 
 
 
 
 

mailto:Mathew.calkins@ct.gov
mailto:John.Rinaldi@ct.gov
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The image below is an example of what a typical project polygon will look like after it is drawn in 
Microstation.  

 

 

Figure 284 – Project Polygon example 

Highway Projects that DO NOT Touch Pavement 
This type of project could involve, but not limited to the following: 

 Guard rail replacement 

 Barrier replacement 

 Noise barriers 

 Retaining walls 
 
The Project Polygon file shall encompass the entire project extents per site and include all slope 
lines, temporary work areas, portions of local affected roads, all affected assets, etc. The 
polygon should be drawn up to the right of way line unless the slope limits or temporary work 
area extends beyond that.  If there is only a ROW line on one side of the project, draw the 
polygon relatively close to the edge of the work area.  Below is an example of a noise barrier 
project and shows what to include: 
 
 

 

Figure 285 - Highway Project without Full Depth Reconstruction 
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Full Bridge Replacement or Superstructure Replacement that Touch the Roadway 
The Project Polygon file shall encompass the entire project extents per site and include all slope 
lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected 
assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or 
temporary work area extends beyond that.  Below is an example of what to include: 
 

 

Figure 286 - Bridge Polygon Example 

 
 
 
Full Bridge or Culvert Replacement or Rehabilitation that Do Not Touch the Roadway 
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Facilities Project  
The Project Polygon file shall be drawn on the ROW line or limits of construction for the parcel 
the facility is located on.  Any slope limits or work being done outside of this ROW line shall be 
included in the polygon.  Below is an example of what to include: 
 

Figure 287 - Facilities Project E

xample 
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12.2.2 Project Polygon File(s) Creation 
The following steps explain how to create and submit the Project Polygon file.  One polygon file 
shall be created for each project.  If the project consists of multiple “sites,” the file shall include 
multiple polygons. 

1. Note the datum and units (e.g. NAD 83 Survey Feet) of the Highway Design file to be 
referenced.  This can usually be found within the ground survey file title block.  If there 
is no survey for the project use the 2D Poly 83 FT seed file shown in the next step.   

2. In House CTDOT Users:  Create a new MicroStation design file using the 2D_Poly_83FT 
seed file located in the W: Drive.  See folder address below: 
 
W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\  
 

Note: If your project is NAD 27 FT still use the 83FT seed.   
 

 
Figure 288 – CTDOT CAD resource folders 

 
Consultant Users:  Download the seed files using this link: 2D_Poly_83FT Seed File 

 
3. Reference the Highway Design file into the newly created file using true scale off and 

1:1 

 

http://www.ct.gov/dot/lib/dot/documents/aec/2d_poly_83ft.zip
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Figure 289 – MicroStation reference file settings 
4. Verify that the tentative coordinates of this file match the referenced design (using 

stationing, grids, etc.).  If your project is in NAD 83FT the coordinates should match, if 
they do not check that the scale of the reference is 1:1.  If your project is NAD 27 FT we 
will move the reference file so the coordinates are correct.  To move the reference file 
do the following: 

a. Select Reference File. 
b. Select Move Reference: 

 

Figure 290 - Move Reference 

c. Next when it prompts you to “Enter point to move from”, in the Key-In Box   
key in XY=0,0 and click Enter. 

 

Figure 291 - Key In 
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d. Then when it prompts you to “Move Reference>Enter Point to move to”, in the 
Key-In Box key in DL=400124.9,500038.9. 

 

Figure 292 - Move to Key In 

Now the tentative coordinates of this file should match the referenced design (using stationing, 
grids, etc.).   
 

5. Set the MicroStation active level to “TOOL_Prelim_Proj_Polygon” for the Project 
Polygon (Note: if this level is not yet available, use “SV_PARCEL_DATA”) 

6. Then place a closed polygon(s) using the shape tool or the smart line tool.   
7. After the polygon has been placed, turn off all reference displays and fit the polygon to 

the view. 
8. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml 

file to Google Earth.   
Do this by choosing: File> Export> Google Earth.   

9. Google Earth should then automatically open and zoom to the Project Polygon(s) 
vicinity. 

12.2.3 Project Polygon File(s) Submission 
The Project Polygon files shall then be uploaded into ProjectWise in accordance with the 
following: 

1. Log into ProjectWise 
2. Browse to your project’s 140_GIS folder in ProjectWise Explorer 
3. Select the Interface, “CTDOT_Doc_Code.”  If the interface box is not shown, select: 

View>Toolbars and select interface 
4. Drag and drop the file into the 140_GIS folder using the Advanced Wizard 
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Figure 293 – ProjectWise project polygon folder example 

5. Continue to click Next in the Advance Wizard until you get to the Attributes screen and 
assign the attributes shown in Table 5 of Projectwise Attribute Table 

6. Click Next until the file uploads.  
7. When upload is complete, the Lead Designer shall send an email to the following 

people including links to the documents in Projectwise.  To do this, click on the 
document and then highlight and copy the address located in the Address Bar.  Then 
paste it in the email:        
 

John.Rinaldi@ct.gov (AEC), 
Mathew.calkins@ct.gov (AEC) 
Henok.Abdisssa@ct.gov (AEC) 

To submit a revision for the Project Polygon files, use the same steps above but add “Revised” to 
the label attribute.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
mailto:John.Rinaldi@ct.gov
mailto:Mathew.calkins@ct.gov
mailto:Henok.Abdisssa@ct.gov
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 Rights of Way (ROW) Files  Section 13

This section details the submission of the following Rights of Way (ROW) Files: 

 Property Maps Files (.dgn and PDF) 

 Parcel Polygon Files (.dgn and KML)   
 
These files shall be submitted at the Project Milestone – Design Approval and updated as 
necessary as the project moves through design and construction. 

13.1 Submission of the Property Maps Files 
The .dgn and PDF files for a Property Map shall be uploaded to CTDOT’s Projectwise site in 
accordance with the following: 

1. Log into Projectwise. 
2. Browse out to your project and upload the Property Map DGN and PDF into the 

05_Property_Maps folder and 310_Review folder respectively as shown below: 

 

Figure 294 - Uploading Property Maps 

3. Select the Interface,  “CTDOT_Doc_Code.”  If the interface box is not shown, select: 
View>Toolbars and select interface.   

4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder 
5. For each file, continue to click Next in the Advance Wizard until you get to the 

Attributes screen and assign the attributes shown in Table 5 of Projectwise Attribute 
Table 

6. Click Next until the file uploads. 
8. When the files are uploaded, the creator of the Property Map shall send an email to 

the following people including links to the documents in Projectwise.  To do this, click 
on the document and then highlight and copy the address located in the Address Bar.  
Then paste it in the email:         

 ROW Supervising Coordinator - Robert.Ike@ct.gov 

 ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov, 
Shandi.Wong@ct.gov 

 Bureau Records Center (BRC) - Bryan.Deprey@ct.gov, Janet.West@ct.gov 

 Appropriate Project Coordinator - Steven.Degen@ct.gov, 
Michael.Marzi@ct.gov, Douglas.Hummel@ct.gov, Derrick.Ireland@ct.gov  

http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
mailto:Robert.Ike@ct.gov
mailto:John.Durling@ct.gov
mailto:Shandi.Wong@ct.gov
mailto:Bryan.Deprey@ct.gov
mailto:Janet.West@ct.gov
mailto:Steven.Degen@ct.gov
mailto:Michael.Marzi@ct.gov
mailto:Douglas.Hummel@ct.gov
mailto:Derrick.Ireland@ct.gov
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To submit a revision to the property maps, use the same steps above but add “Revised” to the 
label attribute.  

13.2 Parcel Polygon File(s) 
The Parcel Polygon files shall be created by the creator of the property map and represents the 
area to be acquired by the State.  It should be accurately based on existing property lines and 
proposed Rights of Way lines.  These files shall be submitted at the Project Milestone – Design 
Approval and updated as necessary as the project moves through design and construction. 

13.2.1 Parcel Polygon File(s) Creation 
The following steps explain how to create and submit the Parcel Polygon CAD file(s).  One file 
shall be created for each parcel - only permanent land and easement acquisition areas.  
 
When submitting a Parcel Polygon file(s), a PDF of the Property Map and the CAD file of the 
Property Map shall also be submitted into ProjectWise in accordance with this manual, see 
section 9. 
 

 

Figure 295 – Property Map parcel area example 

1. Figure out which datum and units (e.g. NAD 83 Survey Feet) the existing Property Map 
is in.  This is usually found within the referenced ground survey file title block  

2. IN House CTDOT Staff – Then create a new MicroStation design file using the correct 
seed for the datum in the project located in the W: Drive.  See folder address below: 
W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\  
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Figure 296 - Seed File 

Consultant Staff: Download the seed files using this link:  Geospatial Seeds 
3. Reference the Property Map file into the newly created file using true scale off and 1:1 

 

Figure 297 - Reference File 

4. Verify that the tentative coordinates of the new file match the Property Map (using 
stationing, grids, etc.) 

5. Set the MicroStation active level to “SV_PARCEL_DATA” for Parcel Polygon(s).  
6. Then place a closed polygon using the shape tool or the smart line tool.   
7. CTDOT has a customized a MicroStation task, “CT Property Maps,” to aid in the 

creation of property maps.  The task contains “Shape for GIS” tools which can be used 
for polygon creation:  

http://www.ct.gov/dot/lib/dot/documents/aec/geospatial_seeds.zip
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Figure 298 – Custom MicroStation tasks 

8. After the polygon has been placed, turn off all reference displays and fit the polygon to 
the view. 

9. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml 
file to Google Earth by choosing: File> Export> Google Earth.   

10. Google Earth should then automatically open and zoom to the Project Polygon vicinity. 

13.2.2 Parcel Polygon File Submission 
The Parcel Polygon file(s) shall be uploaded into ProjectWise in accordance with the following.  
[Note that if the parcel geometry remains unchanged with subsequent Property Map revisions, 
it is not necessary to recreate and resubmit the Parcel Polygon and KML once initially submitted] 

1. Log into ProjectWise 
2. Using ProjectWise Explorer, browse to the 140_GIS folder of your project. 

 

Figure 299 – ProjectWise parcel polygon folders example 

3. Select the Interface, “CTDOT_Doc_Code.”  If the interface box is not shown, select: 
View>Toolbars and select interface.   

4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder 
5. For each file, continue to click Next in the Advance Wizard until you get to the 

Attributes screen and assign the attributes shown in Table 5 of Projectwise Attribute 
Table 

6. Click Next until the file uploads. 

http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_attribute_tables.pdf
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9. When the files are uploaded, the creator of the Property Map shall send an email to 
the following people including links to the documents in Projectwise.  To do this, click 
on the document and then highlight and copy the address located in the Address Bar.  
Then paste it in the email:        
 

 ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov, 
Shandi.Wong@ct.gov 

To submit a revision for the Parcel Polygon files, use the same steps above but add “Revised” to 
the label attribute.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:John.Durling@ct.gov
mailto:Shandi.Wong@ct.gov
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Appendix A - Initial Bluebeam Settings 

Initial Log into Bluebeam 
These steps only need to be completed the first time using Bluebeam or when the user logs into 
a new computer. 

1. Open Bluebeam by selecting the desktop icon:            

2. Then Open Bluebeam by double clicking on the shortcut. 

3. Click on the settings icon in the top right hand corner and click Preferences as shown 
below.  If you cannot find the settings icon in the top right, go to the Edit menu and 
select Preferences.    

 

Figure 300 - Bluebeam Preferences 
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4. Click on File Access and make sure the box is checked as shown below:  If ProjectWise is not 

listed click on Add

 

Figure 301 - Projectwise Integration 

5. Then click Load and enter in your Projectwise Username and password and select the 
Checkout on Open box, then click OK. 

 

Figure 302 - Integrating Projectwise 
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After you click Log in the status should read Logged In as shown below: 

 

Figure 303 - Projectwise Integration 

6. In the General section in the User area type in your name (First Initial and Last Name), 

title, and your office name.  An example for me would be M. Calkins TE 2 AEC 

Applications.  An example for a district construction user would be J. Smith TE 3 D2 

Construction.   

 

Figure 304 - General Preferences 
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7. Update the markups options to match the following:

 

Figure 305 - Markup Preferences 

8. Update the markups tab options to match the following: 

 

Figure 306 - Markup Preferences 
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9. Click on the Signature tab and set the algorithm to SHA-1. 

 

Figure 307 - Signature Settings 

10. Click on the Web Tab section and make sure the box for Open PDF hyperlinks in Web 

Tabs is unchecked.  This will open any hyperlink that is in a PDF document using Internet 

Explorer instead of Bluebeam.  This is the last preference you will need to update so you 

can click Ok at the bottom right now.   

 

Figure 308 - Webtab Preferences 
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Downloading the CTDOT Bluebeam Profile 
1. Download this file and save it to your desktop: CTDOT Bluebeam Profile 

2. Double click on the profile in the zipped folder on your desktop. 

 

Figure 309 - Importing the Bluebeam Tools 

Bluebeam Stamps 
The following steps are for CTDOT Engineering only.   
1. Select Markup>Stamp>Change  Stamp folder as shown below: 

 

Figure 310 - Changing the Stamp Folder 

 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/ctdot_bluebeam_user_profile.zip
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2. Next browse out to this folder on the X: Drive and select your discipline 
X:\V8_Admin\Bluebeam Resources 

 

Figure 311 - Changing the Stamp Folder 

3.  Now your unit’s stamps will be available for use when Markup>Stamps is selected: 

 

Figure 312 - Changing the Stamp Folder 
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Appendix B - Usability of PDF Documents 

Usability of PDF Documents  
This section contains information about viewing digital contract documents.   

Structure of Digital Plans  
Final Design Plans, Addendums, and Design Initiated Change Orders 
The contract plans are split up into discipline subsets, which are multiple sheet PDF documents 
digitally signed by the Designer.  Addendums and Change Orders are also submitted as discipline 
subset, with only the changed sheets.  For example, an Addendum that affects the 03-Bridge 
Subset will require the submission of a 03-Bridge_A1 subset.    
 
Digital Plans are located in the 100_Contract_Plans folder in Projectwise.  Below is an example 
of a project’s discipline subsets in Projectwise: 
 

 

Figure 313 - Discipline Subsets in Projectwise 

As-Built’s 
As-built’s will be placed directly on the PDF Subsets using Bluebeam. 

Functionality of PDF Digital Plans 
The PDF digital plans have the following functions when the digital contract plans are created in 
accordance with this manual: 
 Turn levels on and off  
 Search for all text on the documents.   
 PDF plans are measurable  
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Digital Plan Levels 
The plans have the ability to have their levels turned off and on.  This can allow for easier 
viewing of the contract sheets.   See below for turning levels on and off: 
 

 

Figure 314 - Turning Levels On and Off 
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 Searching Digital Plans 
The plans can be searched for any text located on them.  This can be useful if searching for a 
certain pay item.   
 
See below for searching the PDF Plans for text.   
 

 

Figure 315 - Searching for Text in PDF Plans 

 
 
 
 
 
 
 
 
 
 
 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 7/2017 268 Version 4.02 
     

Measuring on the Digital Plans 
The plans have the ability to be measured in PDF.  This is helpful because a paper set does not 
need to be created for on desk measuring.   
 
See below for measuring in PDF. 

 

Figure 316 - Measuring Tool 
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Digital Specification 
The FDP specification package will be one PDF document and located in the 
110_Contract_Special provisions folder.  This package includes all special provisions, Notice to 
Contractors, Wage information, etc.   
 
The Addendum special provisions prepared in the same way as the FDP specification package 
and will also be located in the 110_Contract Special provisions folder. 
 
The Design Initiated Change Order special provisions will be contained in one PDF document 
located in the 110_Contract Special provisions folder when they are released to the Contractor. 
 
Some useful features on the digital specification package are: 

 Search for any text in the document, see Searching Digital Plans 

 Bookmarks for each section in the specification package 
  

 

Figure 317 - Bookmarks in the Spec. Package 
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Document Compare Tools 
Bluebeam has the two tools for comparing documents:  (1) Compare Documents and (2) Overlay 
Pages.  Compare Documents will compare two documents and create a third document that 
clouds all the changes.  Overlay pages will create a third document where the pages of 
document A will become one color and the pages of document be will become another color.  
When the pages are overlaid you will be able to see the changes from the difference in these 
two colors.  Both of these tools can be used for single and multipage PDF documents.  The 
following shows how to perform a document compare and how to use the overlay page tool. 
 
Document Compare 

1. Open the Revised document first and then open the original document that you want to 
compare from Projectwise or your computer.   

2. Next go to Document>Comparison>Compare Documents as shown below: 

 

Figure 318 - Compare Documents 

3. In the window that pops up you will notice the two documents that were just opened.  
Click OK to run the document compare as shown below: 
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Figure 319 - document Compare 

Overlay Pages 

1. Open the Revised document first and then open the original document that you want to 
compare from Projectwise or your computer.  

2. Next go to Document>Comparison>Overlay pages as shown below: 

 

Figure 320 - Overlay Pages 

3. In the window that pops up you will need to select which pages of each document you 
want to overlay.  To do this double click on a file, then in the window that pops up type 
the pages you want to overlay.  The example below shows pages 1-28.  Once you select 
the pages you want to overlay click OK. 
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Figure 321 - Overlay Pages 

 

igure 322 - Overlay Pages 
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Appendix C - Using the Set File 

Opening the Set File 
Double click on the set file from Projectwise and open as shown below:  This may take a while 

please be patient.  Note: The first time opening a set file will take longer than any subsequent 

times.  

 

Figure 323 - Opening a Set File 

Viewing the Plans Sheets within a Set File 
All the plans sheets will be combined and shown on the left hand side of the screen in a 
thumbnail view.  To view a sheet, simply click on that sheet and it will open up. 

 

Figure 324 - Viewing a Plan Sheet from a Set File 
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Marking Up a Set File 
1. Open up the set file.  You will notice on the left hand side of the screen will be 

thumbnails of all the sheets in the set file.   

 

Figure 325 - Sheets in the Set File 
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2. To mark up a sheet scroll down to the sheet that needs to be marked up and click on it.  

You will notice that sheet opens up on the right: 

 

Figure 326 - Marking Up a Sheet 
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3. Next to markup the document we must unlock it (Check Out of Projectwise).  To do this, 

right click on the lock and select Check Out. 

 

Figure 327 - Checking Out a Document 

4. Notice the lock changes to a Check and you will be able to markup the document. 

 

Figure 328 - Checking Out a Document for Editing 
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5. To mark up the plans use the tools located in the tool chest shown below:  

 

Figure 329 - Marking up the Plan Sheets 
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6. When finished, click Save and then right click on the Check and select “Check In”. 

 

Figure 330 - Saving Markups and Checking Into Projectwise 
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Searching a Set File 
 
The Set feature in Bluebeam allows you to search across the entire set file.  The following shows 
how to search a set file: 

1. Click on the Search Set file icon and then type in what you want to search for as shown 

below: 

 

Figure 331 - Searching the Set File 
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Creating a Consolidated PDF of the Files in the Set File 
Bluebeam allows you to create a consolidated pdf of all the files in a set file.  The following 
shows how to create a consolidated pdf: 

1. Select the Publish Icon and select Combine: 

 

Figure 332 - Consolidating Files 

2. Next keep the default settings and click OK on the dialog box shown below: 

 

Figure 333 - Consolidating Files 
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3. Bluebeam will then create a consolidated file of all the PDF in the set file.  

 

Figure 334 - Consolidated File 
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Printing the Entire Set File 
Bluebeam allows you to print the entire Set file, only the latest revisions, or previous revisions.  
Printing the entire set will print all the sheets in the set file.  Printing the latest revisions will 
print the most up to date sheets and not print the previous revisions.  Printing the previous 
revisions will only print the sheets that were changed by a revision.   
The following shows how print a set file: 

1. Select the print set file icon and select the desired option: 

 

Figure 335 - Printing a Set File 
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Appendix D – Consultant Submittal Review 

Stamps 

Consultant Designers can import the Bluebeam User Profile using the following link.  This profile 
imports all the commenting tools in the correct format.   
Download the profile from this link: CTDOT Bluebeam User Profile.  Just double click on the file 
located in the zip file and the profile will be imported.   
After the profile is imported the following must be done. 

1. Delete the Submittal Review stamp that is in the tool chest as shown below: 

 

Figure 336 - Deleting the Stamp 

2. Next Consultant Designers will need to save the following stamp to their computer and 

edit it to add their company name and address.  The following will show how to do that: 

3. Save this stamp file to your computer in a folder somewhere called Blubeam Stamps.  

Note:  The stamp file will be a PDF- Consultant Submittal Review Stamp 

4. Open the stamp file using Bluebeam. 

 
 

 

 

http://www.ct.gov/dot/lib/dot/documents/aec/ctdot_bluebeam_user_profile.zip
http://www.ct.gov/dot/lib/dot/documents/aec/02-designer_submittal_review.zip
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5. Update the Company Name and Address as shown below: 

 

Figure 337 - Updating Stamp for Company Name and Address 

After the company name and address is updated it should look like this: 

 

Figure 338 - Updated Stamp 

6. After the stamp is updated click save.   
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7. Next go to Markup>Stamp> and Select Change Stamp Folder.   

 

Figure 339 - Changing the Stamp Folder 

8. Browse out to where the submittal review stamp has been saved and click OK: 

 

Figure 340 - Browsing to the Stamp 

9. Now when you click on Markup>Stamp it will be in the list. 
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10. Next go into the tool chest and open the “Recent tools” as shown below: 

 

Figure 341 - Bluebeam Recent Tools 

11. Now place the stamp on any PDF document by selecting it in Markup>Stamp as shown 

below: 

 

Figure 342 - Placing a Stamp in Bluebeam 
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12. After the stamp has been placed you will see the stamp in the recent tools.  Drag it from 

the recent tools into the CTDOT Shop/Working Drawing Review Tools as shown below: 

 

Figure 343 - Adding the Custom Stamp to the Tool Chest 

13. Then Save Profile so the stamp will always be in the Tool Chest. 

 

Figure 344 - Saving Bluebeam Profile 


	Table of Contents
	DEFINITIONS
	Section 1 Prerequisites and Policies
	Section 2 CTDOT Document Management System
	2.1 ProjectWise
	2.2 Projectwise Project Container for an Active Capital Project
	2.3 Projectwise Project Folder Structure and Required Documents for Capital Projects
	2.4 Asset Areas in Projectwise
	2.5 Setting Documents to Final Status in Projectwise

	Section 3 Digital Project Processes
	3.1 Processes by Project Phase
	3.2 Digital Project Process Maps
	3.2.1 PPI Form
	3.2.2 Digital Reviews
	3.2.3 FDP Contract Plan Processing
	3.2.4 Addenda Plans
	3.2.5 Design Initiated Change Order (DCO) Plans
	3.2.6 Contractor Submittals
	3.2.7 Paper Plan Order Form


	Section 4 Document Preparation and Format
	4.1 Contract Plan Grouping
	4.2 Contract Plan Format
	4.3   CTDOT For Information Only Sheets
	4.4 CTDOT Standard Plan Sheets
	4.5 Contract Special provisions
	4.6 Estimates and Quantity Calculations
	4.7 Environmental Permits
	4.8 Contractor Submittals
	4.9 Engineering Reports
	4.10 Project Administration and Project Correspondence Documents
	4.11 GIS Project Location Documents
	4.12 ROW (Rights of Way) Documents
	4.13 Design Calculations
	4.14 Contract Plan Drawing and Sheet Numbering
	4.14.1 Drawing Number
	4.14.2 Final Plan Page Labels and Sheet Numbers
	4.14.3 Addendum and Design Initiated Change Order Page Labeling and Sheet Numbers

	4.15 Consolidating Contract Plan Discipline Subsets
	4.15.1 When a Set File is Created and Updated
	4.15.2 Creating a Set File
	4.15.3 Updating a Set File
	4.15.3.1 Adding a File to the Set File
	4.15.3.2 Deleting a File from the Set



	Section 5 Digital Signatures for Contract and Other Engineering Documents
	5.1 Graphic Image of Signature
	5.1.1 Contract Plans
	5.1.2 Engineering Reports
	5.1.3 Working Drawings
	5.1.4 Other Documents

	5.2 Creating Graphic Image of Signature:
	5.2.1 In House CTDOT or Non-Professional Engineering Signature:
	5.2.2 For Consultant Staff PE Stamp:

	5.3 Setting Digital Signature Appearance Preferences:
	5.4 Watermarking Plans with Graphic Image of Signature
	5.5 Digital Signature Fields
	5.5.1 Bluebeam - Creating Digital Signature Form Fields

	5.6 Applying Digital Signatures
	5.6.1 Applying Digital Signatures to 01_General Subset (FDP and Addendum Subsets)
	5.6.2 Applying a Digital Signatures to 02_Revisions Subset
	5.6.3 All Other Discipline Subsets - Single Signature
	5.6.4 Standard Drawing Subsets – Single Signature
	5.6.5 All Other Discipline Subsets – Multi-Signatures
	5.6.6 Working Drawings
	5.6.7 Engineering Reports
	5.6.1 Bridge Load Ratings

	5.7 Applying Digital Signature Workflows

	Section 6 Submitting Documents to CTDOT
	6.1 FDP Submittal to Processing – Under Development
	6.2 Uploading Documents
	6.2.1  ProjectWise (Thin Client)
	6.2.2 Uploading Documents – Projectwise (Thick Client)

	6.3 PDF Checker – Contract Plans
	6.3.1 Installing the PDF Checker
	6.3.2 Typical Workflow for using the PDF Checker
	6.3.3 Using the PDF Checker


	Section 7 Contract Plan and Special Provision Revisions (Addenda and Design Initiated Change Order)
	7.1 Addenda
	7.1.1 Revised Plans - Addenda
	7.1.2 New Sheets - Addenda
	7.1.3 Adding New Subset – Addenda
	7.1.4 Voiding Sheets
	7.1.5 Addenda Special provisions
	7.1.6 Addendum CTDOT Standard Drawing Subsets

	7.2 Design Initiated Change Order (DCO)
	7.2.1 Revised Sheets – DCO
	7.2.2 New Sheets – DCO
	7.2.3 New Subset – DCO
	7.2.4 Voided Sheets
	7.2.5 DCO Special provisions
	7.2.6 DCO Memorandum from Designer to Construction
	7.2.7 DCO CTDOT Standard Sheet Subsets

	7.3 02-Revisions Subset
	7.3.1 02_Revisions Subset Workflow - Addenda
	7.3.2 02_Revisions Subset Workflow - DCO
	7.3.3 Adding a New Revisions Sheet to the 02_Revisions Subset
	7.3.4 Filling Out Revision Index Sheet

	7.4 Placing Stamps on Affected Sheets – Revised, or Deleted Sheets

	Section 8 As-Built Comments - Final Plans
	8.1 As-Built Revisions (Digital Comments) Workflow
	8.1.1 Post Construction As-Built

	8.2 As-Built Markup of Contract Plans
	8.3 Applying As-Built Comments to Contract Plans
	8.3.1 Before Using Bluebeam for As-Builts
	8.3.2 Opening the Contract Plans from Projectwise
	8.3.3 Applying Digital As-Built Stamps
	8.3.3.1 Construction Started & Completed Dates
	8.3.3.2 This Sheet Not Corrected Stamp
	8.3.3.3 This Sheet Corrected

	8.3.4 Applying Digital As-Built Notes
	8.3.4.1 Digital As-Built Stamps and Notes Using ADOBE

	8.3.5 Additional As-Built Information
	8.3.6 Setting Documents to Final Status in Projectwise

	8.4 Notifications
	8.4.1 Notifying Department Personnel


	Section 9 Contractor Submittals
	9.1 Introduction
	9.2 Project Setup and Management
	9.3 Shop Drawing Review
	9.4 Working Drawing Review
	Figure 121 - Email Notification
	9.4.1 Working Drawing – Designer Review
	9.4.2 Working Drawing – Processing a Designer Reviewed Submittal
	9.4.3 Working Drawings – District Construction Only Review

	9.5 Forwarding a Submittal to an Additional Reviewer
	9.6 RFIs
	9.7 Sending a Transmittal

	Section 10 Digital Review and Commenting
	10.1 Introduction
	10.2 Prerequisites
	10.3 Digital Review Workflow
	10.4 Phase 1 – Digital Document Preparation
	10.4.1 Organization
	10.4.2 Preparation and Format
	10.4.3 Uploading Digital Documents

	10.5 Phase 2 – Set Up Digital Review
	10.6 Phase 3 – Invitation to Review Session
	10.7 Phase 4 – Digital Review
	10.7.1 Joining a Review Session
	10.7.2 Review Session Layout
	10.7.3 Reviewing

	10.8 Phase 5 – Closing the Digital Review
	10.9 Phase 6 – Resolve Comments
	10.9.1 Resolving Comments

	10.10 Locking the Review Documents after the Review

	Section 11 Design Phase Project Scheduling
	11.1 Microsoft Project File Set Up
	11.2 Basic MS Project Function
	11.2.1 Scheduling Terminology
	11.2.2 Task Relationships (Predecessor and Successors)
	11.2.3 Adding, Renaming, Indenting and Deleting a Task
	11.2.4 Adding and Adjusting Durations
	11.2.5 Lead and Lag Times
	11.2.6 Adding Notes and Hyperlinks to a Task
	11.2.7 Combining Multiple Projects

	11.3 Tracking the Project
	11.3.1 Baselining the Project
	11.3.2 Recording Task Progress

	11.4 Generating Reports and Summaries

	Section 12 CTDOT Project Location – Under Development
	12.1 Project Location - RPM
	12.1.1 Route and Mileage
	12.1.2 List of Assets for the Project
	12.1.3 Project Polygon Creation and Submission

	12.2 Project Location - Design Approval through Construction
	12.2.1 Project Polygon
	12.2.2 Project Polygon File(s) Creation
	12.2.3 Project Polygon File(s) Submission


	Section 13 Rights of Way (ROW) Files
	13.1 Submission of the Property Maps Files
	13.2 Parcel Polygon File(s)
	13.2.1 Parcel Polygon File(s) Creation
	13.2.2 Parcel Polygon File Submission


	Appendix A - Initial Bluebeam Settings
	Initial Log into Bluebeam
	Downloading the CTDOT Bluebeam Profile
	Bluebeam Stamps

	Appendix B - Usability of PDF Documents
	Usability of PDF Documents
	Structure of Digital Plans
	Functionality of PDF Digital Plans
	Digital Plan Levels
	Searching Digital Plans

	Measuring on the Digital Plans
	Digital Specification
	Document Compare Tools

	Appendix C - Using the Set File
	Opening the Set File
	Viewing the Plans Sheets within a Set File
	Marking Up a Set File
	Searching a Set File
	Creating a Consolidated PDF of the Files in the Set File
	Printing the Entire Set File

	Appendix D – Consultant Submittal Review Stamps

